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About this Guide 

This guide contains a complete description of WinPos Signal Processing Package 

features, as well as more effective ways of working with this software. The Manual 

is intended for Windows users, therefore, it does not describe standard Windows 

interface elements. 

Structure of the Guide 

Section 1 contains a description of the capabilities, applications, and information 

about the software design history. In Section 2 we give the information necessary for 

software installation and upgrade, as well as PC requirements. Section 3 contains a 

general overview of the WinPOS operation principles. It also provides links to all 

interface elements descriptions, so this Section can be used as a handbook. Sections 

4 through 8 describes in detail the interface and ways of working with software. 

Parts 9 through 11 contains a description of the algorithms implemented in WinPOS 

and recommendations for their use. Appendix A describes the file formats. Appendix 

B lists the specific information that can help in case of failures and abnormal 

situations. At the end of Manual a small Glossary is provided. 

Conventions 

For ease of reading the text in the manual the following symbols are used. 

< > Angle brackets indicate function keys and their combinations, e.g., 

<Ctrl>. 

→ The → symbol is used for menu levels separation: e.g. the entry File 

→ Open… means that the item Open… shall be selected in the File 

menu. 

File Text in bold denotes the menu or dialog box items, which you can 

choose and activate using the mouse. 

Signal Text in Italic denotes the titles of the Manual sections, WinPOS 

Windows and terms, first appearing in the text (the explanation which 

is given in the Glossary).  

signal Monospace font denotes text or characters to be entered from the 

keyboard and configuration files lines.  

 Important information, caution or advice. 
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Section 1. Introduction 

About WinPOS 

WinPOS software is designed to process the measurement data using a standard 

mathematical and statistical algorithms. It also provides a graphical representation 

and documentation of data.  

WinPOS main features: 

 powerful graphic interface (2D & 3D),  

 working with signals of unlimited length, 

 more than 50 signals processing algorithms,  

 batch data processing,  

 supporting of scripts (VBScript) and plug-ins,  

 tools for working with charts 

 reporting, 

 dynamic processes and virations analysis, 

 dntegration with MR-300 and Recorder software packages,  

 detailed User‟s Manual and Programmer‟s Manual,  

 comprehensive help. 

WinPOS delivery options 

WinPOS is available in two delivery options: professional and expert. 

WinPOS professional is ideal for processing any measuring data, viewing and 

documentation. Secondary processing is carried out using a large set of built-in 

digital signal analysis algorithms. Open software interface allows you to create your 

own processing algorithms, to automate the analysis and create reports. 

WinPOS expert extends professional edition, allowing the analysis of 

nonstationary, dynamic processes, including vibrations (see Section 10 Vibration 

analysis). 
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WinPOS in measuring 
cycle 

Mera Ltd manufactures and 

supplies hardware and software 

solutions for automation of the 

data collection and processing. 

WinPOS is used as one of the 

final parts of the measurement 

cycle. 

Multi-channel portable systems, 

test benches and monitoring 

system are equipped with 

recording equipment (with 

Recorder and MR-300 software). 

Recorder performs the functions 

of a digital tape recorder and can 

perform specialized data 

processing and generate control 

actions. 

Further processing of the recorded 

information produced in WinPOS 

software. In order to switch to 

WinPOS click   button in 

Recorder. In conjunction with 

scripts and plugins WinPOS 

algorithms allow you to 

implement complex processimg. 

To successfully complete 

processing you can use a 

professional set of reporting 

options.  

WinPOS is perfectly complete 

data recording tools designed by 

Mera Ltd. Also it can be 

successfully used as a standalone 

tool or in combination with other 

research software. 

 

Object 

under test 

MIC-300 

Recorder 

MR-300 

WinPOS 

Test bench 

system 
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WinPOS design history 

The name WinPOS means the signal 

processing package (Пакет Обработки 

Сигналов (ПОС)) for Windows. 

In the early 90s of the last century Mera Ltd 

has developed a POS signal processing 

package. For its time it was a software with 

revolutionary features. It applied practically in 

all industries and was used by many R&D 

companies. 

In the middle 90s, the POS-M has developed, 

which allowed to implement the successful 

solutions of POS in monitoring and test bench 

systems. The companies of energy and aircraft 

engines industries, as well as sea-based space 

launch facility «Sea Launch» still operate 

POS-M. 

Limitations of MS-DOS operating system, and 

the growing demands for volumes of test data, 

ease of processing and representations did not 

allow to improve POS and POS-M in their 

original form. Therefore, MERA Ltd. has start 

to develop WinPOS.  

WinPOS has inherited the best from POS 

(powerful mathematical tools, simplicity, 

usability and flexibility) and raised them to a 

new modern level. 

WinPOS expert replaced the DAN and 

WDAN dynamic analyzers developed by 

MERA Ltd. 

In 2004 the Official Registration Certificate of 

“WinPOS Signal Processing Package” was 

ibtained. 
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PC requirements 

WinPOS can be installed at any PC running Microsoft Windows 2000, XP, Vista, 

Windows 7, 8 and 10.  

The PC one USB port must be free for the dongle installation. In network setup, the 

USB key connected to the server and the client workstations receive licenses across 

the network. 

The software requires approximately 70 MB of disk space, but it is desirable to 

ensure sufficient disc space for storing temporary files, sessions and calculations 

results.  

 

In the lower right corner of the WinPOS window shows free hard disk space available for 
savig temporary files and session files. If there is insufficient free disk space, take measures 
on clearing of the disk or choose another disk (the disk partition) to accommodate WinPOS 
working directory (see Section 4 Loading and saving signals, Sessions, Fig. 4.7). 

To ensure reasonable speed of calculations the CPU must be 1 GHz, and RAM at 

least 1 GB.  

Comfortable working with 3D graphics is provided by graphics card with OpenGL 

hardware acceleration and a mouse with a scrolling wheel. 
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Section 2. WinPOS installation 

Insert WinPOS installation CD in the PC CD-ROM drive. Installation will start 

automatically. If autorun is prohibited, run Setup.exe from the root directory of the 

CD. In the appeared window (Fig. 2.1) select «Install WinPOS». 

   

Fig. 2.1. WinPOS setup window and components for installation 

Follow the instructions of the setup wizard. To navigate between the wizard pages, 

use <Back and Next> buttons.  After setup is complete, click Install, click Finish. 

During installation you will be prompted to read the License agreement. Accept it by 

selecting «I accept the license agreement».  

The setup program allows: 

 to change the default installation path (C:\Program Files\MERA\WinPOS),                                  

 set the name of the folder in Start menu, select software content: select full or 

compact installation, or check the necessary items (see Fig. 2.1),  

 place shortcuts on the desktop and on quick launch bar for quick WinPOS run.  

After WinPOS installation You need to connect the USB dongle. The installation 

program displays detailed instructions for connection and operation of dongles. 

These instructions can also be found in the instruction file.pdf (Active subdirectory 

of the WinPOS installation directory.  

 

1. USB dongle should not be connected to your computer before installing 
WinPOS, otherwise Windows will start searching drivers for it. If this happens, you should 
not search driver with Windows wizard, click Cancel and disconnect the USB dongle from 
PC. 

2. You must have ADMINISTRATOR rights in the system. For users with the usual rights 
Windows prohibits of drivers installing, uninstalling, and configuring. 
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Starting WinPOS 

WinPOS starts up from the desktop, the quick launch panel and from the Windows 

Start. To open recorded signals click  the button in MR-300 or Recorder control 

panel or double click on the data file name (mera or, USML) in Windows Explorer. 

How to upgrade 

An updated WinPOS version can be downloaded from www.nppmera.ru (Technical 

support / Software Download / WinPOS). The name of the setup file depends on the 

delivery option and WinPOS version. For example, the name might look like this: 

winpos-3.2.8.10-expert-eng-setup.exe 

where 3.2.8.10 – version number, expert - delivery option (see WinPOS delivery 

options in Section 1), eng - language.  

Your delivery option can be found on the dongle sticker. The dongle with the Expert 

designation also allows you to start WinPOS Professional. 

List of changes and fixes can be found in the WhatsNew.txt file located in 

installation directory.  

In order to reduce the size of the setup it does not contain electronic versions of the 

User's Guide (WPUsersGuide.pdf) and Programmer's Guide 

(WPProgrammersGuide.pdf). The latest versions of these documents can be 

downloaded from the same webpage. If you save them in the same directory with the 

installer, they will installed the same way as from CD-ROM. You can also manually 

copy these files into the WinPOS installation directory. 

http://www.nppmera.ru/
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Section 3. Getting started 

WinPOS features 

While developing WinPOS special attention was paid to user interface optimization 

with the aim to to simplify routine operations without losing flexibility and 

customizability. 

For example, to plot all the parameters of opened file you need only one mouse 

movement, the processing range can be set in one action. Sympy select the algorithm 

in the drop down menu, configure if you want, click Execute, and you can view the 

results in graphs. 

This model of user interface is based on few principles. 

1. What I See – Is What I Process. By default, any action 

refers to the signal(s) currently displayed in the chart. If 

only a fragment of the signal displayed – the processing will 

be carried out within the selected interval. 

2. All WinPOS objects stored in a hierarchical structure 

called global tree. This tree performs in WinPOS the same 

function as the Windows registry or file system. Any signal, 

graph, or algorithm has its own name and place in this tree. 

Therefore, even if the signal is not displayed in the chart, it 

can be accessed through the tree. 

3. Batch processing. The operation with folder of the tree 

enables processing of all objects of this folder. Hence, all 

signals of the folder, graph or page can be processed as one 

signal. 

Next a brief description of the WinPOS interface is given. This description 

(especially the Figs. 3.1-3.3) can be used as a reference when studying the rest of the 

Guide and in further work with WinPOS. 

WinPOS interface. Main window 

The program is controlled using the GUI familiar for Windows. WinPOS main 

window is shown in Figure 3.1. 
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Fig. 3.1. WinPOS. General view 

 

 Page 

 

 Folder/file 

 

 Graph 

 

 Line 

 
 Signal 

 

Fig. 3.2. Context menu of the main WinPOS objects 
 

Main menu 

Toolbars 

Legend 

Graph 

Graphs tree 

contains all graphs 

Signals tree stores 
all the signals of 
session 

Line – signal in 

graph 

Page – single or multiple graphs 

Selected signal 

Folder or file with 
signals  

Signal – data of one physical 
channel or raw signal 
processing result  
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File 

 

Vibroanalysis 

 

View 

 

Script 

 

Algorithms 

 

Window 

 

Tools 

 

Help 

 

 
Fig 3.3. Main menu  



WinPOS. User’s Guide 

 
20 

A major part of the window is the workspace, which contains pages with graphs. 

Tree bar is usually placed on the left to the workspace. Signals tree is placed in the 

lower part of the workspace, and Graphs tree in the upper part. 
 

Signals tree 

All signals opened in WinPOS are placed to the global tree to 

the Signals folder. The contents of this folder is displayed in 

the Signal tree. 

Each signal corresponds to one element, „the leaf‟ of the tree. 

The signals are grouped into folders. So all the calculation 

results are placed into the Results folder. Files in MERA and USML when the 

opening are placed in the tree as a folder with signals.  

The "+" sign to the left of the folder name allows you to expand the content of the 

folder "-" sign – to collapse content. Double-clicking on a folder creates a page with 

graphs of the signals in this folder. Clicking on a signal opens the Add lines dialog 

window (Fig. 5.7). 
 

Graph tree 

The top level of the Signals tree consists of pages associated with the graphs, and the 

lines which plot a signal are associated with graphs.  

Double-clicking on the page, graphics or line names make this 

item active. In the workspace on the right the selected page is 

displayed on top of other pages, the chart is marked with the 

icon "a" and the line is redrawn at the top of other curves and 

highlighted out in the legend in bold. See Section 6 Signals Viewing. 
 

Main menu 

The general view of the main menu is shown in Figure 3.3. A full description of 

commands is given in the relevant parts of this Manual (in parentheses). 

File: open and save files, save and load settings, exit program. The lower part of the 

menu contains the list of recently open files. (see Section 4 Signals loading and 

saving). 

Algorithms: a list of signals processing algorithms (see Section 9 Signals 

processing), saving and loading of algorithms settings. The checkbox to the left of 

the name shows that this algorithm is selected as the default algorithm. (see also 

Quick call of algorithm). 
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Vibration analysis (WinPOS expert only): list of vibration analysis algorithms (see 

Section 10 Vibration analysis), saving and loading of algorithms settings. 

View – change WinPOS windows layout, enabling and disabling toolbars, and 

auxiliary windows (see below WinPOS auxiliary windows). Enabled element is 

marked with a check mark to the left. 

Scripts (WinPOS professional and expert): built-in editor, runnig scripts (see 

Section 11 WinPOS scripts). The lower part of the menu contains the list of recently 

running scripts. 

Tools: commands of the graph control panel, calling settings dialog of the active 

graph and default settings (see Section 6 Signals Viewing), reporting commands 

(duplicated on the main toolbar, see Section 8 Reporting and printing) 

Window: commands for creating of new pages (See Section 5. Graph creation), the 

standard Windows MDI command for the pages layout in the workspace (usually all 

workspace is occupied by the current page). At the bottom of the menu there is a list 

of the created pages. The active page is marked with a tick. 

Help - access the WinPOS help system (Contents...), package information, 

company, contact information. 
 

Context menu 

WinPOS objects can be managed through a context menu accessed with the right 

mouse button on the selected object (Fig. 3.2).  

To open the context menu of page right click on the page name in the graphs tree.  

Graph menu – on the graph name in the Graphs tree or in graph field. The graph 

menu includes the page menu items.  

Line menu – on the line name in the Graphs tree or on the signal name in legend. 

Folder and signal menu – on the signals tree. 

 

Toolbars 

The toolbar contain the most important WinPOS commands. Enabling and disabling 

the panels in the Layout menu, you can choose the best set of tools for every task. In 

parentheses are the number of parts of the manual that describe these tools. You can 

select the most convenient location of panels by moving them with the mouse 

("cath" the strip on the left side panel with the mouse pointer).  
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Main toolbar Additional toolbar 

 Create a new page (5)  
Display labels, regimes, setpoints, breaks 

and statuses 

 Create a new 3D page (5)  Set, rename, delete label or regime  

 Open… (4)  Select display mode with pauses  

 Save as… (4)  
Synchronization of signals and additional 
date and time scale 

 Group signals by origin Edit toolbar 

 Add into the graph  Edit values 

 Open Signal Manager (7)  Change signal values 

 Print graph/table  Signals concatenation 

 Save page screenshot in file  Shift the selected signal on the X-axis 

 Copy screenshot in clipboard (8)  Copy to a new signal 

Graph toolbar  Copy a signal fragment 

 Scrolling graph  Paste into selected graph/page 

 Scaling graph  Paste into new graph 

 Show cursor  Delete a signal fragment 

 Normalize graph  Undo signal editing 

 Return to previous range  Folder editing (7) 

 Grid Scroll toolbar 

 Vertical lines from signal points (8)  Decrease 

 3D plotting style  Scroll left 

 Display mode  Stop 

 Move and rotate graph  Scroll right 

 Add a label  Increase 

 Add a comment  Playback of the current signal 

 Synchronize cursors (6)  Playback an audio track 

 Settings (5)  Volume control (6) 

Table toolbar MSOffice toolbar (plugin) 

 New table  Report 
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 Save changes  Table in Excel format 

 Save table as… 
 

Copy current value to Excel 

 Undo changes 
 

Copy legend to Excel 

 Redo last changes (6) Min/max search (plug-in) 

Signal generator (plug-in)  Set the cursor on a maximum 

 Trigonometric functions generator  Set the cursor on a minimum 

 White noise generator  Set the label on a maximum 

   Set the label on a minimum 

WinPOS auxiliary windows 

Algorithm settings dialog window 

 
Fig. 3.4. Algorithm settings. Auto spectrum 

Most signal processing algorithms require additional configuration. It is made after 

the choice of processing option in the Algorithms submenu of the main or context 

menu. The right part of the window settings is the same for all algorithms. It is 
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intended for specifying the data sources and the names of the results. The left part of 

the window contains the specific settings of the algorithm. For more detailed 

information - see - Section 9. Signals processing. 
 

Signals selection 

 
Fig. 3.5. Signals selection 

The Select button in algorithm settings window and in saving signals window opens 

the Signal selection dialogue (Fig. 3.5). In the left part of the window you can select 

the signal from Signals tree or from Graphs tree (switch between tabs at the bottom 

of the tree window). On the right is a window with short information about the 

selected signals. 

 

To select the processing interval move the left and right cursors in the preview 

window (when selecting the entire signal the cursors are coincide with the 

boundaries of the graph) or set the exact value in the X or Index fields. The 

checkboxes to the right of these fields sets the selection mode of the range for batch 

processing of signals from same folder (Max means the entire signal selection). See 

also Section 4 Saving signals and Section 9 Signals processing. 

 When the signal selected from the Graphs tree the range of signals values displayed on 
the selected chart defined by default.  
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Signals manager 

 
Fig. 3.6. Signals manager 

Signals manager is used to view and modify information about files, signals, 

calibration characteristics, as well as view the values of the signals in a tabular form. 

It gives the possibility of copying, renaming, cataloging, reading and writing of 

signals. To open the Signals manager click   button or select Layout→ Signals 

manager command. See also Section 7. Signals editing. 

Signals manager window (Fig. 3.6) is consist of two information panels and toolbar. 

Each of the information panels can be displayed as a "tree" or "list". In the right 

panel may displayed information about the selected object in the "properties pages". 

To switch between panel appearances use  buttons: a simple click  of a 

button causes a change state of the panel, click the arrow to the right of the button to 

select the desired view. 

The buttons of the Signals Manager toolbar. 

 
F4 Show as graph 

 
F3 Open file. Duplicates the File→Open `. 

 
F2 Save as…. Duplicates the File→Save as… command 

 
F5 Copy. Opens a dialog in which you can specify the new location of the 

signals and the range of values to copy. The originals delete option 

allows to replace the copying signals with a move operation.  

 
F6 Rename selected option. 

 
F7 Create new folder in Signals tree. 

 
 Create new signal.  
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F8 Delete selected object. 

 
Alt+F1 Switch (set) the left panel layout 

 
Alt+F2 Switch (set) the right panel layout 

 
 Show all WinPOS resources: displays the signals, charts and algorithms 

directories.  
 

Scripts editor 

WinPOS expert and professional delivery options allows you to create your own 

signal processing algorithms, and to automate the process of processing from the 

select input file to reporting. WinPOS includes a convenient environment for 

editing, executing and debugging scripts in VBScript (Fig. 11.1).  

For more detailed information - see Section 11. WinPOS scripts and Programmer’s 

Guide. 
 

Log 

 
Fig. 3.7. Log window 

The Log (Fig. 3.7) automatically records the operator actions (opening and saving 

files, execution of algorithms, etc.). The log can also be used as a notebook, making 

it a convenient tool to systematize the data processing. Each line of the log contains 

the time, event description, and the string of additional parameters (e.g., settings of 

the performed algorithm). The log window shows the history of the current session. 

The full history is stored in the winpos.log file in WinPOS working directory. 

To work with the log select Layout→Log command. To add notes – enter text in 

the input field and click Add. For transferring text to the clipboard – select the rows 

and click Copy. 
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Graphs preferences window 

 
Fig. 3.8. Default settings 

The arrangement of graphics on a page, diagram format, legend, format and color of 

signals can be selected using the tabs of the Graphs preferences window. Graph 

default settings window (Fig. 3.8) is intended to change of new graphs paremeters. 

The format of already created graphs can be changed using the Graph settings 

window (Fig. 5.9-5.19). For more detailed information - see Section For more 

detailed information - see Section 5. Graph creation, Graphs settings chapter. 
 

Vibration calculator 

WinPOS allows to use the vibration parameters calculation window (Fig. 3.9). By 

setting the frequency and a single parameter (acceleration, velocity or displacement), 

you can calculate the other two parameters of vibration. To open the Vibration 

calculator select Layuot→ Vibration calculator command. 

 
Fig. 3.9. Vibration calculator 
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Help window 

 
Fig. 3.10. Help window 

WinPOS help system contains a description of the user interface, algorithms, 

methods of writing scripts, and links to electronic versions of the User's Guide and 

Programmer's Guide. 

Access the help system is carried out by pressing <F1> key. You can also select 

Help→Content… command or click  Help button in algorithms settings. WinPOS 

Help is designed as standard Windows help file and in addition to the list of articles 

contains an alphabetical index and keyword search (Fig. 3.10). 
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Section 4. Loading and saving signals 

Files formats 

MERA and USML files formats are designed for batch 

storage of signals. The binary data of each parameter 

are accompanied by a description of the signal, 

calibration characteristics, information about the test 

and the registration process. 

MERA file format – a common format for storing the 

measuring data, is designed for use in recorders and in 

WinPOS. 

The main characteristics of MERA file format: 

 
 

   Fig 4.1. Types of files  

 no restrictions on the number and length of signals, 

 openness, ease of operations and flexibility, 

 separate storage of each signal binary data and descriptions provides  

 increased reliability, 

 quick access to parameters options, including editing, adding and deleting 

signals. 

UMSL file format created in the times of wide using tape recorders does not meet 

modern requirements due to the number of restrictions, and is implemented in 

WinPOS for compatibility reasons (including a compatibility with POS).  

 

You can easily convert file in USML format to the MERA format using Save as... menu 
item. It should be remembered that during the reverse conversion (from MERA to USML) 
there are a number of restrictions leading to loss of some recorded information 
(comments, labels, regimes, etc.).  

MERA and USML files formats are described in Appendix A. Files formats. 

In addition to working with specialized formats the import and export data in a 

variety of binary and text formats is also supported. 

With the help of plug-ins you can work with DSPCon DATX (.datx, .datx_index), 

ETEP D.T.MUX (.eti), WAVE (.wav) and Universal File Format (.uff, .unv): 58 & 

58b (binary). , This allows you to communicate with LabVIEW, LMS Test.Lab, etc. 
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Signals loading 

 
Fig. 4.2. File open 

Select File→Open… menu item or 

click   button of main toolbar. You 

can also press <F3> key.  

File open window (Fig. 4.2) is a 

standard Windows dialog, in the lower 

part of which is the preview panel with 

the contents of the file. 

Choose the data format from the list of 

files types (Fig. 4.1).  

Locate the file and click Open. A new 

signal or signal folder appears in the 

Signals tree.  
 

 
MERA and USML files can be opened 
from Windows Explorer by double-
clicking on the file name. 

The name of the signal is obtained from a MERA file, from the text file header or 

matches the name of the binary file. The name, units, and other signal characteristics 

can be modified on the signal propertis pages or in Signal manager (See Section 7 

Signals editing). 

     
   Fig. 4.3. Parameters 

File in MERA format contains a complete description of 

the signals. For proper creation of signals from binary or 

text files you need to specify at least the sampling 

frequency. The opening and saving files wizards helps to 

works with text files (see below). 

When you open a binary file you can specify the discretization of a signal 

(frequency or step) and time of recording in Parameters dialog window (Fig. 4.3).  

Saving signals 

To save the signals select Save as... command in the page, graph, line, signal or 

folder context menu. Data from Signals tree can also be saved using the File 

submenu of the main menu or by click  button. 
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Save as window (Fig. 4.4) is a standard 

Windows dialog, in the lower part of 

which is the preview panel with the 

contents of the file. 

Choose the data format from the list of 

files types (Fig. 4.1). 

If you save data from the Signals then 

full ranges of signals values will be 

saved. When you call the dialog 

window from the context menu of a 

page, graph or line only visible range 

will be saved.  

To change the range for saving and the 

list of signals, click Select... to open the 

signals selection window (Fig. 3.5).   
Fig. 4.4. Saving file 

Text (ASCII) files 

When you open the text file the Text files opening wizard appears (Fig. 4.5). A Text 

files saving wizard (Fig. 4.6) helps to create text files with columns of signal values.  

To navigate between the wizard pages, use the <Back and Next> buttons, after the 

setup is complete, click Finish on the last page.  

Opening wizard 

On the first page, configure the general format of text file. The second page allows 

you to split data into columns. On the third page columns are associated with the 

signals. If the file contains columns of time, you must specify the order of columns. 

Otherwise, set the discretization (x0 – initial value of time, dx - time step, f - 

frequency). In the list you can also change the signal names to default.  

 Opening a large text file and storing large signals in text files can take a long time. Press 
<Esc> to cancel the operation. 
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Fig. 4.5. ASCII files opening wizard  
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Saving wizard 

 

 
Fig. 4.6. ASCII files saving wizard. Step 2 

On the first page displaed a list of selected signals and order of values columns and 

times. You can set the columns delimeter, enable automating creation of table 

header: enable signals names (the name of time column is given separate) and units 

In first and second lines of table. . If you choose the Separate signal files option, the 

folder will be created with the name which is displayed in the File name field in the 

Save as… window (Fig. 4.4). The separate files which contain measurments of only 

one signal will be put into this folder and the file name will matches the signal name. 

The text included into the Title field is placed over the table in the first lines of the 

file. On the second page you can adjust the column width and the number of 

significant digits after the decimal point separately for the signal values and the time 

columns, in accordance with the table preview.  



WinPOS. User’s Guide 

 
34 

Sessions 

The results and graphs obtained during data processing can be saved to disk as the 

session. After loading the session you can return to unfinished processing. 

Automatic saving and restoring of the session 

The session can be automatically saved on exit from program or periodically with 

the given intervals. A periodical saving of a session helps to restore the processing 

after a software or hardware failure.  

To enable automatical saving of a session, choose this option on General tab (Fig. 

4.7) of Default settings window (Tools menu, Default settings… command).  

 
Fig. 4.7. WinPOS general settings 

For periodical saving set the saving interval (in seconds) below on the same tab. You 

can load the last automatically saved session immediately after sterting WinPOS. To 

obtain this capabilities check the Session automatically loading. 

Additional, you can load the last automatically saved session using the command 

File → Restore last session ( Fig. 3.3). 

 

WinPOS working directory 

The signals that you creating during data processing are temporary stored in the 

WinPOS working directory on the PC hard drive. The automatically saved session is 

placed in the same directory. You can change path to the working directory on the 
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General tab of Default settings window (Fig. 4.7). Click Browse… and select new 

location for works files. Be careful that the disk has free space. 

 

Manual saving and restoring of sessions 

If you want to interrupt working or choose another WinPos task, but then to return to 

the interrupted process, you can save and load the session manually.  

Select Save session as… in File menu (Fig. 3.3) and choose a directory to save the 

session data. To clear the session select File → New session command. If you want 

return to saved session select File → Resore session command and choose a 

directory to save the session data. 

The session can be copied to another PC or archived, and then you can restore it 

using the same commands. Note, that the sessions do not contain raw data files 

(Instead of them the links to files are saved).  

Therefore when you transfer the session, you need also to copy the raw data files. 

The list of these “external” files is put into the log when they are copied (Fig. 3.7), 

and the proposal to open the log is displayed. If you want to transfer the session, 

copy the files from this list. Put these "external" files to the directories with the same 

names before restoring the session on other PC. Otherwise during loading the 

program will propose to locate the missing files manually, using the Open files 

dialog window. 

 

Tests data base 

Tests data bases (not included in WinPOS delivery) helps to organize measurement 

results and to automate of recorded data (using queries, sampling, etc.). Description 

of work with Tests data base is provided in Tests data base User’s manual. 

To open recorded data from Tests data base select File → Open from MDB …, 

then choose required recording in MDB browser and click  Select. Using MDB you 

can also open in WinPOS queries results, create samples, etc.  

To save selected WinPOS folder in tests data base select File → Save to MDB …, 

choose the test in database browser and click  Select. It will create a new record with 

the current folder signals. 
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Section 5. Graph creation 

At the WinPOS start a page with empty graph is created. New pages with graphs 

also created automatically for the signals processing results and after dragging-and-

dropping the signal or folder to the Graph tree. 

The most convenient and simple way of plot the signal graph in WinPOS is to drag 

the signal from the Signals tree to the graph area or to the Graphs tree using the 

mouse (Press the left mouse button at the signal name, move the cursor to the graph 

area, then release the button). 

The commands for working with graphs are in Toolbars, Tools menu (Fig. 3.3) and 

context menu. 

Graph types 

WinPOS allows to create 2D graphs (Fig. 5.1) and  3D graphs (Fig. 5.2). 

You can place several signals into one graph (Fig. 5.3) or create several graphs on 

one page (Fig. 5.4). 

 

 

Fig. 5.1. 
 

Fig. 5.2. 

Fig. 5.3. Fig. 5.3. 
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A separate Y axis can be created for each signal. The axis can be displayed 

separately (Fig. 5.5), or using several scales along common axis (Fig. 5.6). 

 
Fig. 5.4. 

 
Fig. 5.5. 

New page creation 

Click the  button of the Main toolbar or select Window → New page command. 

It will create a new page with an empty page of 2D graph. The 3D graph page is 

created by click ing the  button of the 3D graph toolbar. 

The page can be created using a template by clicking the Window→New page by 

template command, see Page templates below.  

The Window→Instant spectrum page command creates a page with two graphs: 

the source signal and the spectrum calculated at the cursor position or for visible 

signal range - see Part 9 Signals processing. Instant spectrum. 

Creating pages using template 

The page templates allows to avoid repeated customization of the graphs, storing the 

signals view ranges, placement and format of the legend and comments. The 

templates are very useful tool for preparation of the reports with series of the graphs 

of pre-set format, for viewing the characteristic signal intervals.  

To create a new template use Save as template… command from page context 

menu. The page layout will be saved as template file (.tpl), then this template will be 

set as current. 

To change current template use Window → Select template… and choose new 

template file (.tpl) in standard window.  

Window → New page by template command creates a new page using the current 

template. If the template is not selected, then tis command acts as New window. 
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Adding graph 

Select the Add graph item of the context menu of graph or page.  

Adding axis 

Click Add in on Y axis tab of Graph setting (Fig. 5.14). Adjust the axis parameters 

and click Apply. 

Adding signal (line) 

with a a new graph or page creating 

 
Fig. 5.6. Adding lines 

Option 1. Using mouse drag signal from the Signals tree to the page (marked as 
) in Graphs tree (press the left mouse button on the name of the signal, move the 

cursor to the Graphs tree field and release the button over the page name) – the new 

page will be created. 

Option 2. Double click the selected signal and open the Add lines dialog window, 

then select the required page (Fig. 5.7), or choose To new page. Click Ok. 
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To selected graph 

 
Fig. 5.7. Adding lines 

Option 1. Using the mouse drag signal from the Signals tree to the Graphs tree, 

releas the left mouse button over the name of the graph (graphs marked as ). 

Option 2. Double click on the required graph in the Graphs tree to activate it. Drag 

the signal using mouse. 

Option 3. Double click on the selected signal to open the Add lines dialog window 

and select required graph (Fig. 5.8) or select To the new graph. Click Ok.  

To the selected coordinate axis 

Option 1. Click the name of the axis or the maximum value of the graph scaling to 

make it the current (will be highlighted in bold). Drag the signal from the Signals 

tree to the graph. 

Option 2. Double click on the selected signal to open the Add lines dialog window 

and select required graph. Select required axis in the Y Axis field or create new axis 

(New axis checkmark). Click Ok. 

 The color of coordinate axis (scaling and names) is selected the same as the color of the 
first line of this axis.  

 

Adding the several signals, folder 

To the one page (Fig. 5.4). Using the mouse copy the folder from the Signals tree to 

the Graphs tree (click the left mouse button on the folder name, move the cursor to 
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Vertical Horizontal Tabular 

the Signals tree field and release the button). You can simple double-click on the 

folder.. 

To the one graph (Fig. 5.3). Drag and drop the folder from the Signals tree to the 

Graphs tree, while hold down the <Ctrl> key (Press the <Ctrl> key on the keyboard, 

click left mouse button on the folder name, move the cursor to the box Graphs tree, 

release the button).  

Deleting page, graph, line axis 

You can delete graph and page using the context menu commands. The axis can be 

deleted from the graph settings window (Y Axis tab). The line can be deleted using 

the context menu that can be invoked with the right mouse button click in the 

Graphs tree charts or in the legend window.  

Customizing graphs 

The graphs can be changed using the Graphs settings window (Fig. 5.10). To open 

this window click , or press <Ctrl+O> keys or select Settings… in page, graph or 

line menu, as well as in Tools submenu of the maim menu. In the left part of the 

settings window is a Graphs tree, to the right – tabs with parameters. 

Using Default settings… (see below) of Tools menu you can set the parameters for 

all new graphs. The parameters of already created graphs will not affected. 

The tab Page (Fig. 5.10) allows to synchronize the axis: Common X axis, Common 

Y axis (the scaling of all graphs on the page will be made at the same time), and set 

arrangement of graphs (Fig. 5.9). 

 

 

 

 

 

Fig. 5.8. Arrangement of graphs 

    The settings are appled to the selected object and its child objects . 
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Fig. 5.9. Graph settings window. Page tab 

If the tabular arrangement is selected you can specify the dimension of table (in the 

Number of graphs field). If the page has more graphs than you specify the the 

invisible graphs will be marked with shaded icon in the Graphs tree. To move to 

such graph, double-click on its name in the tree or use the scroll bar on the right.  

 
Fig. 5.10. Graph settings window. Graph tab 

 

In the Graph tab (Fig. 5.11) you can set location and size of graph fields (Borders 

size, Auto – select borders automatically), alignment of the legend and additional 

settings: 

Graph name – show graph name; 

10% offset (Y) – the scale of Y axis is 10% more than signal magnitude; 
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Values on grid – place the signal values at the intersection points of lines with the 

grid on the graphs field; 

Lines numbers – the numbers of lines in the graph field;  

Autonormalize. – the scale of the Y-axis is automatically selected according to the 

maximum range of the signal; 

Polar – polar graph. 

Location of the graph axes can be set in the Separate Y-axis: To the left of the 

graph – each line of the graph with its own vertical axis; One above the other – 

vertical division of the graph by the number of axes. 

 

 
Fig. 5.11. Graph settings window. Line tab 

Line tab (Fig. 5.12): Name – Line (signal) name; 

Y Axis – the Y-axis, associated with the line. Select from the list, which contains all 

existing axis; 

Connect points – the data points are connected by lines; 

Type – the type of line that connects points on the graph. The line can be solid, 

dotted, dashed and dash-dotted; 

Line color - can be selected from a list or from the standard Color dialog that 

appears when you clicks >>; 

Line width – line width in pixels; 

Draw points – each value on the graph is displayed using symbols that you can 

select from the Type drop down list. 

 

Points color – specifies the color of the point. If you select Auto, the points will be 

displayed the same color as the line; 

Points size – size of points (symbols); 

Histogram style – the graph is displayed as a histogram. This style used e.g. to 

display octave spectra; 
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Transparent diagram – the histogram is displayed in contour. It is convenient 

when on the same graph the several histograms displayed simultaneously; 

Zero order interpolation – values in points between measurement results are not 

interpolated; 

Vertical lines – vertical lines from points of signal measured values respective to 

the X axis; 

Parametric signal – the signal is considered as a dependence of Y from the index. 

X values are used only for X-axis scaling.  

 

 
Fig. 5.12. Graph settings window. X-axis tab 

On the Axis X tab (Fig. 5.13), you can rename the axis, set its boundaries, and set 

the following parameters: 

Format - determines the scaling type. In the drop-down list you can select the 

appropriate format (Auto – automatic format selection) or set your own format. The 

# denotes a single digit (the number of # determines the accuracy), 0 – indicates a 

need to add the rows with zeros, e – engineering format, T=%H:%M:%S – displays 

astronomical time; 

Date and Time - below the axis placed the second set of values indicating the date 

and(or) time; 

Logarithm – logarithmic scaling. 
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Fig. 5.13. Graph settings window. Y-axis tab 

Y-axis tab (Fig. 5.14). In the drop-down list of the axes you can select one of the 

axes or Add a new one. The Delete button lets you delete all the axis except the last 

one. For the selected axis, you can set the scaling and color.  

Format - determines the scaling type (see X-axis).  

Name and Units – renaming of axes and units. Usually derived by a comma: "speed, 

m/s". Click ">>" to open the window with a list of previously entered names. 

Logarithm – logarithmic scaling. 
 

 
Fig. 5.14. Graph settings window. Legend 

 

The Legend tab (Fig. 5.15) specifies the format and font of the legend. In the list of 

legend columns you can enable the charachteristic display and set the number of 

decimal places (double-click left mouse button on the field) for each of the 

characteristics. Description of parameters is given in chapter Legend of Section 8 
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Formatting the graphs and reporting. In this page also defined the size of simple 

format legend. 

The special set of fonts for specific page can be defined in Fonts tab (Fig. 3.8) ы. 

 
Fig. 5.15. Graph settings window. Color tab 

The colors of selected page or graph can be defined in the Colors tab (Fig. 5.16). 

Click on the rectangle of current color to show the color selection dialog window. 

The left rectangle represents the color of the element on the screen, and the right one 

is color for print. 

The Other tab contain some additional options as a grid values format, logarithmic 

axes scaling, etc. 

The Cursor tab (Fig. 6.7) is shown in cursor mode (see Section 6). 

 

3D graphs 

To customize the 3D graphs use another set of tab in the right pert of Graph 

settings window.  

In the Graph tab (Fig. 5.17) you can set location and size of graph fields (Borders 

size), select filling mode (lines of X; Y; X and Y or plane (surface)), hide the 

invisible lines (Hide invisible lines). 

The user can make the graph name visible, place the scaling on the right (Labels 

on right) and invert the Z axis direction (Invert Z axis). The data interpretation 

along Y axis can be changed (Auto normalize and Color by max Y). (see also 

Default settings). The context menu of Color scale field is allows to change, add, 

remove filling colors and and then save these settings. 
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Fig. 5.16. 3D-graph settings window. Graph tab. Color scale context menu 

The Line tab (Fig. 5.18) is used for renaming lines, adjusting of line width and color 

(similarly as for 2D-graph), and setting of two-colors painting brightness.  

In order to accelerate the representation the user can enable preview mode by setting 

the resampling threshold level. The number of grid lines at each axis is then reduced 

in (Axis scale/threshold) times. 

 
Fig. 5.17. 3D-graph settings window. Line tab 

 

The Axis tab (Fig. 5.19) is allows to change the name and scaling for each of three 

axis. Click >> to open the window with a list of previously entered names. 
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Fig. 5.18. 3D-graph settings window. Axis tab 

 

Default settings 

Graphs default settings are saved in configuration file and used for new pages. The 

Page, Graph, Legend, and Color pages are the same as in the Graph settings 

window (see above).  

 
Fig. 5.19. 3D-graph settings window. Lines tab 

Lines (Fig. 5.20): Line colors list – new line added to graph with the color from this 

list. To change the color click >> under the list and select new color in the dialog 

window ; 

Connect points – the data points are connected by lines; 

Spectrum as histogram – graphs of any spectrum will be displayed as a histogram 

(otherwise – only octave spectra); 

Preview (3D) – used for 3D-graphs: On. Automatically – graph will be displayed 

in preview mode (with resampling), if the number of points along one of the axes 

exceeds the number specified in the Threshold field. 
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Use signal’s color – recording software can save signal‟s color properties in 

“*.mera” files. If this option was checked, signals will be drawn using saved colors 

instead of defaults ones (color still can be changed manually). 
 

Axis tab (Fig. 5.21): Name – axis names by default. Click >> to select from set 

previously entered names; Format – axis scaling format; 

 
Fig. 5.20. Default settings. Axis tab 

Font – fonts for scale labels and axis names. Additional font is used for selection of 

the active axis. Click >> to the right of the appropriate field to select the font. You 

can also change the font on the Fonts tab  (Fig. 3.8). The format of the time axis 

determines the scalingof the secondary axis. 

 
Fig. 5.21. Default settings. 3D-graph 

 

3D-graph tab (Fig. 5.22):  

View mode – the initial appearance of the main graph; 

Filling – displaying of graph: lines along the X-axis, lines along the Y-axis, in both 

axes or as a surface (Hide invisible lines – removal of hidden lines mode); 

Scale digits on right - Y and Z scales labels are in the right graph part.; 

Invert Z axis – the Z axis is flipped so that the minimum value was at the far end of 

the axis and a maximum in the close end; 
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Auto normalize – the scale of the Y-axis is automatically selected; 

Color by max Y – color: 100% corresponds to the maximum signal value, 0% to the 

minimum; 

Views - specifies the types of data representation on the page (isometric, top view, 

cross section)  
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Section 6. Signals Viewing 

During the signal viewing many actions are applied to the selected (current, active) 

graph, line or axis, rather than to the whole page. The current page is the page 

visible at the moment, or the top page if the pages are cascade arranged. The active 

graph is marked by the symbol a in the top left corner of the graph. The current line 

is marked by bold in the legend and is displayed above all other lines. The name of 

the current axis is also shown by bold. See Fig. 6.1. 

  
Fig. 6.1. Active graph and maximized active graph 

To make the graph active click in the graph field, to activate line click the signal 

name in the legend, to activate axis click the axis name. 

Double click at the object in the Graphs tree makes this object current. If the 

selected object was hidden, the required page will be activated, the graphwill be 

marked as active.  

Double-click in the graph field allows you to expand the graph to the whole page. 

Such a graph is marked by the a m symbol (active maximized). See the right graph 

of the Fig. 6.1. The previous graph size can be restored by another double click. 

 

3D graph viewing features 

The 3D graphs are used for viewing the 3D signals opened from the MERA format 

file or obtained by the spectrum calculation with the 3D option enabled. To display a 

signal in 3D graph drag it from the Signals tree to the Graphs tree window or to the 

already existing 3D graph field. Click  in the toolbar to create an empty graph. 

The page may contain only one 3D graph with one signal. 

Active axis of 
non-active 

graph 

current line 

Active graph Active graph maximized 
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 The figure on the left shows the axes directions. As applied to 

3D spectrum, the frequency is put along the X axis, the portion 

start time along the Z axis, and spectrum amplitude values 

along the Y axis.   

Usually 3D graph page is divided into four parts: 3D graph area and three 

projections of the graph into coordinate planes - see Fig. 6.2 

 

Fig. 6.2. 3D graph page 

Unnecessary views can be disabled via Projection 

submenu of the page context menu. The main view 

and the top view cannot be disabled together, and 

the cross-sections of Z and X are disabled 

simultaneously. The views to be represented for a 

new page can be set in the default settings.  

The main view and the top view can be filled by 

three ways using the Line coloring context menu. 

With two-color or multi-color filling the graph 

contains a color scale bar displaying the corres-

pondence of colors and values by Y (Fig. 6.3). 
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Fig. 6.3. Filling options: one-color two-color, multi-color 

The color scale bar can be disabled and its orientation (vertical or horizontal) can be 

changed using the same menu or in the settings dialog window opened by the double 

mouse click. 

Lines multi-color filling can be enabled only for the line graphs plotting by X or Y. 

For the top view, click  in the toolbar and the position of graph is automatically 

changed so that it does not overlap the scale. The scale must be placed quite near to 

the graph edge. 

 
Fig. 6.4. 4 Graph with standard and inverted scale 

If necessary, the axis Z can be inverted (Invert Z axis of the graph context menu). If 

this option is applied graph is visible from the opposite side, without turning the 

graph and without changing directions of other axis (see Fig. 6.4).` 

The graph can be displayed in one of two modes - "fixed view" and "free view" (Fig. 

6.5). In the first mode the Х and Y axes directions are not changed, in the second 

mode the graph can be rotated arbitrary. Click  in the control toolbar to restore 

the graph to the initial view. Clicking the arrow on the right to the button displays 

the menu window which switches the graph viewing mode (fixed to free). 
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Fig. 6.5. Fixed and free view of 3D graph 

The  button allows to rotate the graph, change the axis length and origin 

position. To move the graph press and hold the <Shift> key and drag the graph by 

the mouse left button; the graph size is changed using the mouse scrolling wheel (do 

not press the left mouse button for that). 

To change of axes length press and hold the <Alt> key. Movement the mouse cursor 

horizontally (with the left button pressed) to changes the length of X, vertically - the 

length of Y; and the length of Z is changed by the mouse scrolling wheel.  

To rotate the graph press and hold the button <Ctrl>, move the mouse cursor 

horizontally (with the left button pressed) to turns the graph around the imaginary 

vertical axis, vertically - around the imaginary axis perpendicular to the screen 

plane.  

The  button changes the graph filling mode. Clicking the button change 

"invisible" lines to visible or hidden ones. Clicking the arrow on the right of the 

button displays the menu which allows to select the line plotting by X, Y, X and Y 

or by filled surface place. 

Cursor. Viewing the current values 

In the cursor mode the signal values can be viewed at the selected time point or, on 

the contrary, the time instance when the signal amplitude was, for example, 

maximal, can be identified.  

The cursor mode is enabled by the  button of graph toolbar, as well as by 

Tools→Cursor menu item and by <Ctrl+3> shortcut.  

 

 
Displaying of the huge signals may take tens of seconds .  Such signals are more 
appropriately viewed in the decimated form which is enabled in the line context menu 
(Preview).  
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2D graph 

 
Fig. 6.6. Cursor mode for 2D graph 

In the 2D graph the cursor is represented by black vertical line (see Fig. 6.6). The 

crossing point of the cursor with the signal line is marked by the horizontal line of 

the same color as the signal line. By clicking  arrow on the right of the  

button, the horizontal line mode is set: By all lines, or By one line (the crossing with 

the active line only is marked). 

The signal current values are displayed in the legend: Xcur, Ycur., IndCur (current 

index). 

The cursor is moved by the mouse (hold the vertical line by pressing and holding the 

left mouse button and set the cursor to a new position). Press <←>, <→> keys or 

hold the <Ctrl> key while moving the cursor by mouse to move the cursor exactly 

by the signal discrete values (without interpolation). Press <Tab> key (or select Set 

cursor from the pull-down menu) to set the cursor position by entering the number 

from the keyboard.  

In the cursor mode the tab Cursor is appears in the settings dialog window (see Fig. 

6.7). This tab allows to change the cursor color and thickness, to turn on and 

configure cursor label in the Cursor label field. 
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Fig. 6.7. 2D graph cursor settings  

Cursors synchronization 

If one page contains several graphs the cursors in each graph are moved 

independently. The Cursor synchronization ( ) button combines the cursors of all 

page graphs and allows movement of all cursors as one.  

3D-graph 

In 3D graph the cursor is represented by two signal projections to the XY and YZ 

planes (see Fig. 6.7). In the projection windows the cursors of current values are also 

displayed: in the window Top view – as crossing, in the cross-section windows the 

cursors are shown as in 2D graphs, with the horizontal representation of the signal 

current level. 

The current values are represented in the legend by the axes: X, Y, and Z.  

The cursor is moved using the mouse (close to cursor lines when the mouse pointer 

has  or  shape; press the left mouse button and move the cursor) or using 

keyboard (press <←> and <→> to move the cursor along X axis, press <↓> and <↑> 

to move the cursor along Z axis) in any window. The cursor movements are 

synchronized in 3D graph window and in the projection windows. 
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Fig. 6.8. Cursor mode for 3D graph  

Special cursors 

To switch between cursors types for 2D graphs click  to the 

right of  button.  

Double cursor used to select processing range an for signals 

editing. It can be used to calculate some additional 

parameters: the difference (Delta) in X and Y between 

selected points, definite integral (area under curve), RMS. 

These parameters are displayed in the comment window in 

the graph field. 

To display the calculated parameters, click Advanced button on the cursor settings 

tab (Fig. 6.7). Mark Additional information and select what information should be 

displayed (Fig. 6.9). 
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Fig. 6.9. Delta cursor. Additional settings 

Vibration cursor (Fig. 6.10) is designed to identify harmonically related 

components of the calculated spectral characteristics of the signal. On the Cursor tab 

of settings window you can specify the number of additional cursors, the thickness 

and color of cursor lines and the label appearance. Symmetrical vibration cursor 

(Symmetr. field) helps in identifying the groups of side bands in the frequency 

domain. 

 

Fig.6.10. Vibration cursor and its settings 

Select the component with the main frequency by moving the main cursor. Move 

additional cursors by mouse to superimpose their lines with the corresponding 

harmonics. For more contrast you can change the color of cursor line, superimposed 

on the spectrum (Cursors color of the cursor settings tab).  
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Graphs zooming and scrolling 

Usually when you create a graph signal the entire range of the signal values is 

displayed. (this behavior is configured by setting Autonorm. checkmark on the 

Graph tab of the graphs settings dialog window, see Fig. 5.11). In order to study in 

detail the signals on the short time interval use instruments of the group of zooming 

and scrolling.  

Zooming and scrolling is switched on using  and  buttons of toolbar, via the 

Tools menu, the context menu (Mode command) or using the mouse in combination 

with keyboard controls.. 

2D graph 

 Zooming 

Press and hold the <Ctrl> key. Set the mouse cursor in the graph field on the 

beginning of the signal interval to zoom. Press the left mouse button and without 

releasing the button, select on the graph zoom area (marked with a rectangle), 

release the button and <Ctrl> key. The selected area is the entire field of graph. 

Select the area within the graph to zoom in both axes or over an axis to scale only 

along that axis.  

 

You can also switch to zoom mode using  button of toolbar, <Ctrl+2> keys or 

using Tools menu: 

 Graph zooming  Tools→Zooming by X and Y, <Ctrl>+ mouse  

 Graph zooming by X Tools→Zooming by X, <Ctrl>+ mouse at X 

 Graph zooming by Y Tools→Zooming by Y, <Ctrl>+mouse at Y 

 Scrolling 

The viewing area can be scrolled in respect to the initial graph. Select scrolling 

mode: 

 
Scroll graph Tools→Scrolling by X and Y, <Shift>+ mouse  

 Scroll graph by X Tools→Scrolling by X, <Shift>+ mouse at X 

 Scroll graph by Y Tools→Scrolling by Y, <Shift>+ mouse at Y 
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Scrolling can also be enabled by pressing <Ctrl+1>. 

Click left mouse button in the graph field and move the graph using the mouse 

without releasing the button, then release the mouse button. 

 Scroll bars  

 Scroll bars located at the right and 

bottom borders of the graph, are also used to zoom and pan signal graph. The 

relative size and position of the slider corresponds to the size and position of the 

displayed fragment. 

The  button increases scale,  – reduce scale,  – normalization of given axis. 

, , ,  buttons shifts the viewport. Holding slider by mouse you can also scroll 

the graph. 

 Restore the initial zooming 

The  button restores previous zooming or viewing area. Each click of this button 

cancels the last operation of change the viewing range. 

The second way. When you move the mouse with pressed left button the cursor 

takes the form . After releasing the button the graph is returns to the previous 

scale. If the displacement is large enough, the cursor changes ( ), and the graph it 

will return to the original zoom. 

 Automated scrolling 

The buttons for automatic scrolling along the X axis control the chart, are grouped 

with signal playback buttons  (see below Signal playback):  - scroll 

left,  - scroll right,  – decrease,  - increase the scrolling speed,  - stop 

scrolling. 

3D graph 

 Zooming 

Press and hold <Ctrl> key, select an area for zooming: press the left button and 

release after the area selection. In the selection process on the graph the red frame is 

displayed, outlining the zoom area. 

 

 
Scrolling mode is  enabled automatically by pressing and holding down the <Shift> key in 
the process of shifting the graph in both axes (in the graph area), and on a separate axis - 
on the given axis field.  
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Fig. 6.11. Zooming of 3D graph (before and after pressing <Enter> key) 

The zooming is also enabled using  of toolbar. In this case, the frame borders are 

moved using mouse (over the lines of the frame, the mouse pointer takes the form of 

,  or ), press the left mouse button and change the frame size, press 

<Enter>). Figure 6.11 shows the graph before and after pressing <Enter>. 

The frame can be moved using <←>/<→> and <↑>/<↓> keys. To move right or 

upper bound hold down <Shift> key. The change of scale happens when you press 

<Enter>. The scale on the Y-axis changes automatically. In zoom mode the legend 

fields Xmin, Xmax, Zmin, Zmax shows the current border. 

To zoom and scroll you can also use the projections of the signal. 

 Scrolling 

Scrolling is performed in the cursor mode. With the <←>/<→> keys, move the 

cursor outside of the visible part of the graph. 

 Restoring of the initial zoom 

The graph is normalized by clicking the  button. The normalization sets the 

maximum ranges for the axis to make the whole graph visible. 

Signal playback 

MR-300 allows you to supplement the data frame (.MERA file) with audio track (for 

recording to MIC-300 the microphone is connected). When you view these frames in 

the graph you can click  («Play audio track»). For the displayed interval of the 

record the audio will be replayed ("audio" parameter). In this case the cursor of the 

current values will shift synchronously on all graphs of this frame (from left to right 

from the current position or the beginning of the displayed section of the signal).  

 Scrolling mode is automatically enabled when you move the mouse in the graph and press 
<Shift> and then press the left mouse button. 
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The  ("Play current signal") button allows you to play the current (not 

necessarily audible) signal, the signal frequency will be converted to 

22050 Hz, and the amplitude normalized.  

The  button allows you to change the playback volume or mute it 

entirely (extreme bottom position of the slider). To close the window of 

volume adjustment click the same button.                                                           . 
 

The additional signal information and parameter status 
 

 
Fig.6.12. Regimes, marker, breaks 

WinPOS allows you to view information about the signal recording process. Modes 

("Start", "Run up", etc.) of tests are displayed by named shaded areas, and value 

labels – by green triangles. See Fig. 6.12. 

To turn on and off displaying the labels, 

regimes, pauses, setpoints and statuses, you 

can click the button on the secondary 

toolbar. Pressing the button toggles the 

display of all items, clicking the arrow to the 

right of the button displays a menu with 

which you can toggle the display for 

individual items. If you select Save as default, a switch will be saved in the default 

settings.  

The information on markers and signal recording modes can be modified in the 

cursor mode.  
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The label is set using the secondary toolbar button the or by selection Add marker 

menu item to (on the arrow to the right of this button). The regime is set using the 

Add mode button. If you select the For all signals option the mode or a label will 

be set on all the lines to the active graph. Otherwise it 

would be set only in the active line. 

To delete or rename a label or regime select it by 

moving the cursor to the label or the beginning of the 

regime. In this case the label will change color to red 

and the mode is highlighted by a horizontal line 

above the box graphics. Then select the action in the 

same menu. You can select a desired marker or mode in the marker list as well (one 

of the legend view modes). 

If in the recording process were the blanks (caused by hardware 

failures or pressed "Pause"), the place of "gluing" in WinPOS is 

marked by a dotted line with the signed real timeline.  

The signal with blanks can be represented in three ways:  

 simple – the time scale is depicted as if the signal was 

without breaks, the signal is displayed together 

(Fig.6.14); 

 reduced – the time scale is uneven, the signal is displayed together 

(Fig.6.13); 

 detailed – the time scale is uniform, the signal is displayed fragmented with 

gaps (Fig.6.13). 
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Fig. 6.13. Reduced and detailed presentation of signal with blanks  

On the graph WinPOS can show the setpoint regions above or below the setpoint 

value with defined color.  

Changes of signal status (excesses, failures, etc.) are marked by vertical labels on the 

upper border of the graph. When you move the cursor, information about the current 

signal status appears in the status bar. 

 
Fig. 6.14. Setpounts, change status labels with description 

Figure 6.14 shows a graph of the signal with applied supporting information. 

Enabled the displaying the labels, modes, gaps, settings and labels of change the 

signal status. 

Unified Time Scale  

If the data contain UTS (Unified Time System) information, it will be automatically 

used and signals from different recorders displaying synchronous. The time on the x-

axis is displayed in seconds from the start of recording (first measured values) (when 

IRIG-B format of UTS used), or as the time from switching on the UTS system. In 
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the second case, it may take a lot of time prior to registration, and large values of the 

seconds will be hard to recognise. In this case, select all the files relating to the same 

recording session in the tree and click Reset UTS in the context menu of a MERA 

file. Information about UTS data channel is available in the signal properties page 

(Fig. 7.1). To decouple the signal from the UTS scale set an empty string instead of 

the channel name in the Correction using UTS (not recommended).  

If signals do not contain UTF data and was recorded at different times, they will be 

automatically shifted relative to each other by time difference. This function can be 

turned off by unchecking option “Time 

synchronization” in menu which appearing by 

pressing down arrow to the right of  button 

in toolbar. “For all graphs” option applies 

changes to all graphs in active page, “Save as 

default” set new values as default. 

The data can be also combined in manual 

mode. For this you need to find a couple of 

characteristic signals, which have features corresponding to the same physical 

process (ideally, this command parameters). Put them in one graph, click  in the 

edit panel. Click the left mouse button over the field of the graph and, while holding 

down button move the mouse to left and right to combine the signals so that the 

characteristic points coincided. Release the mouse button. If necessary, repeat these 

steps. Click  the button to exit the alignment mode. Please note that the 

amendment refers to the active line. To adjust the time of the entire measurement 

(MERA file), click the "Edit directory" before correction. 

In order to see the date and time in the days, hours and minutes format, select “Show 

time axis” from synchronization menu (additional axis will appear) or check the 

boxes "Date" and "Time"on the Axis X tab (Fig. 5.13) or adjust the format.  

Tabular representation of signals 

The table allows you to view the signals as columns of values tied to a common time 

scale (Fig. 6.15). 

Click  (New table) on the table control panel. Adding a signal in the table is the 

same as in fraph – drag and drop signal (or folder) to the page of table.  

To remove a signal from a table use the column context menu (Fig. 6.15, Delete 

column), which is invoked by pressing the right mouse button on the header of the 

column.  

Also from the context menu of column and row the standard editing functions (copy, 

paste, etc.) as well as adding a blank row or column are available. 

 

Fig. 6.15. Synchronization menu 
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Signal values in the table cells can be changed. The active cell is marked with a 

frame. Changed values appear in red. Use the  and   buttons to cancel changes 

or to re-enter. Save changes using the  button.  

To print the selected fragment of the table click . 

The button  (Save table as...) allows you to export the table data into a CSV file 

(Common Separated Values). After saving the file the system trying to open it in MS 

Excel. Note that the dimension of the CSV file (number of columns and rows) can 

exceed the maximum value of the table size of MS Excel. 

 
Fig. 6.16. Tabular representation of signals 
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Keyboard shortcuts for viewing 
 

<F5> Switching between the windows of the graph tree /signal tree 

/workspace (page) 

<Ctrl+Tab> Switching between the pages 

<Сtrl+1> Switch on and switch off the graph scrolling mode (both axis) 

<Сtrl+2> Switch on and switch off the graph zoom mode 

<Сtrl+3> Switch on and switch off the graph cursor mode 

<Сtrl+[~]> Back to the previous scale, position 

<Сtrl+G> Switching the graph grid mode 

<Сtrl+L> Display/hide vertical lines from signal values  

<Сtrl+F> Set label at the cursor position 

<Сtrl+O> Open the settings window 

<Сtrl+P> Print the active page 

The following keys are valid only if the page is active. If when you press the keys 

nothing happens, probably the Signals tree or graph selected, press <F5> one or two 

times or click the mouse on the page. 

 

<G> Activate the next graph 

<Y> Activate the next Y axis 

<L> Activate the next line 

<+>, <-> Zoom out/in by X axis of the active graph 

<Shift+"+","-"> Zoom out/in by Y axis of the active graph 

<>, <>  Graph scrolling by X axis  

In the cursor mode - movement of the cursor by Х axis 

<Shift+,> In the cursor mode - movement of the cursor by Х axis 

<Tab> Set cursor to the preset position. 

<>, <> Graph scrolling by active Y axis 

Other hotkeys (use not only when viewing a graph): 

<Esc> Interruption of a current operation (calculation, displaying, etc.) 

<F1> Open help system 

<F3> Open file dialog window 

<Spacebar> In the Signals tree : excludes a signal from processing 
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Section 7. Editing of signals and files 

This part of the User‟s Guide describes how to use WinPOS program for: 

 correcting signals and measurement files,  

 deleting signals or signal fragments containing no meaningful data,  

 creating new signals and measurement files. 

WinPOS creates new signals automatically after executing of algorithms (see 

Section 9 “Signals Processing”). Besides that you can: 

 create a new signal by copying the source signal or its fragment, 

 combine several signals or fragments to a new signal, 

 create a signal presenting one parameter as a function of another,  

 generate an artificial signal using program. 
 

 
Fig. 7.1.  Signals manager. Properties widow 
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You can activate editing functions in the main window using Edit toolbar and 

arrange files with measurement results in the Signals tree.  

The Signal Manager (see Fig.7.1) helps to modify signal properties and work with 

the tabular presentation of signal. The Signal Manager control elements are 

described in Part 3 of the WinPOS Secondary Windows (Part 3). Select Properties… 

item in context menu to change signal characteristics. 

Files editing 

The measurement file information fields can be modified on the Signal Manager 

pages (see Fig.3.6). The procedure of adding signals to a file is described in the 

Signal Copying section below. To delete a signal from file select Delete menu item 

in the signal context menu in the Signals tree, or click  in the Signal Manager.  

Actually the file will be modified on the disk only after the Save or Save as 

operation (for a new file) is executed. See Section 4 “Signal Loading and Saving” 

for details. 

Modifying Signal’s X Axis 

To modify properties of signal‟s X axis open signal in graph and press  button 

on toolbar. 

 

Fig. 7.2. Modify X Axis 

Top half of dialog shows properties of source and result signals. Use controls in 

“Edit” section to change signal as required. 
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Set Start X – changes start value of X. 

Shift X values – shifts X values by specified value. If initial start X equals zero 

result is a same as changing start X. 

Multiply by coeff. – multiplies steps between individual X values by specified 

value, leaves start X unchanged. 

Convert to percents – recalculates X values in procents relative to specified value. 

If “Max” option selected, maximum value is taken as 100%. 

Signal Copying 

Using the Signals tree  

To copy a signal using the Signals tree is as simple as to put a signal in a graph. 

Press left mouse button on the signal name in the Signals tree and holding down the 

button move the mouse cursor to the destination folder. Release the mouse button 

when mouse cursor is above the folder name. The signal is copied. 

Using the Signal Manager 

 Click  buttons in Signal 

manager window to display the 

Signals tree in in the left and right 

panels.  

 Select a destination folder in one of 

these panels and select a signal to be 

copied in the other panel.  

 Click .  

 
Fig. 7.3.  Signal manager. Signal copying 

In the Copy dialog window (Fig.7.3) check the paths in the “From” and “To” fields 

click OK. The signal will be copied to the destination folder. If Remove Source is 

checked the signal will be moved to the chosen folder. 

Signal Fragment Copying 

Using the graph editing panel 

 Enable the double cursor  (see Fig. 7.4, 1). 

 Select required fragment of signal and click Copy  in the Edit toolbar 

(Fig.7.4, 2). The information about selected fragment will be saved in the 

clipboard. 

 Click  in the Edit toolbar (Fig. 7.4, 3). A new signal will be created and 

shown in the graph (Fig. 7.4, 4). 

 



Section 7. Editing of signals and files 

 
71 

  

 

  
Fig.7.4. Signal Fragment Copying 

The copied data are not physically doubled until the signal not saved to disk. Instead 

the resulting signal is supplemented with a reference to the source. That is, the 

signals from which the data was copied cannot be deleted till the resulting signals 

are removed. The source signal modification may bring resulting signal changes as 

well. 

Using the Signal Manager 

 
Fig. 7.5. Creation of a new signal 
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Perform the operations you executed for copying an entire signal but set a new index 

range in the Copy range fields of the Copy dialog window (Fig.7.3), . 

Or create a new signal having set the old one as a source.. 

 Click  in the Signal Manager toolbar.  

 Mark Y from other signal in the Y frame of the window shown in Fig.7.5, click 

Browse… and select the source signal or its fragment in the signal selection 

window (Fig. 3.5).  

 Mark X from other signal in the X frame, click Browse… and select the same 

signal as for Y axis. 

 Type the new signal name and click OK. The new signal will be placed in the 

New Signals folder of the Signals tree. 

Concatenation of the signals 

Using the graph editing panel 

You can add copied signal or fragment to another signal.  

 Copy a signal in the way described above.  

 Select a graph with a signal to be concatenated with a fragment, then click .  

If the current values cursor is enabled the source fragment will be inserted at the 

cursor position. Otherwise, it will be inserted at the signal end. The arrow on the 

right of   button enables to forced set the insertion mode: at the cursor position 

(prohibited when the cursor is disabled), at the signal start or at end. 

It is necessary to have the same data type and calibration characteristics of the two 

signals.  

Automatic concatenation of the signals 

This function may be useful when splicing the fragments of a signal data distributed 

among different measurement frames. 

 Put the signals to be concatenated in a single graph. 

 Click  in the editing toolbar.  

The active graph signals will be combined in a single signal according to the 

sequence of the graph legend. The resulting signal gets all properties (frequency, 

start time, calibration curve, etc) of the first signal. The connection points are 

marked with names of concatenated signals. The result signal is put in the New 

Signals folder of the WinPOS Signals tree. 

 
When a fragment of one signal is copied in the start of another signal the latter signal start 
time (the initial value along the X-axis) is made equal to the start time of the copied 
fragment. 
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Parametric and Polar Signals 

Using the Parametric Graph algorithm 

In Section 9 described the settings for Parametric Graph algorithm, designed to 

create parametric or polar signals. If you want to build parametric graphs often, you 

can speed up the calling of the algorithm:  

 Set the “Parametric Graph” as default algorithm (in the algorithm setting 

window).  

 Choose Select signal in the context menu of the signal to be used as a function 

parameter.  

 Holding down <Alt> key drag and drop the signal to the graph by the mouse in 

the way you create an ordinary graph.  

The default algorithm will be performed and the result (the parametric graph) will be 

created instead of simple graph. 

Using the Create New Signal dialog window in the Signal Manager 

 Click  on the toolbar of Signal manager window. 

 Mark Y of the other signal in the Y frame (see Fig.7.5), click Browse… and 

select the source signal or its fragment in the signal selection window (Fig.3.5).  

 Mark Y of the other signal in the X frame, click Browse… and select the signal 

with the values corresponding to the new X-axis.  

 Type the new signal name and click OK. The new signal will be put in the New 

Signals folder of the Signals tree.  

Signals from software generatior  

You can call the signal generation plugin (  panel ), to use one of the examples 

supplied, or to write your own script, program, or plug-in almost any programming 

language that supports OLE technology. See Section 11 and Programmer’s Manual. 

Signal Fragment Deletion 

Removing parts of the signal containing no useful information, significantly reduces 

the amount of data and processing time. However, it should be remembered that this 

may distort the data reference to the timeline. 

Using the graph editing panel 

 Enable the double cursor and select a fragment to be removed (Fig.7.6, 1).  

 When a new signal is created using other two signals the new signal length will be equal to 
the length of the shortest of the source signals. 
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 Click  button on the Edit toolbar (Fig.7.6, 2). Confirm the operation. The 

selected fragment of the signal is removed, and in its place a break mark will be 

set (Fig.7.6, 3).  

When you remove a portion of the signal the data is not physically deleted as long as 

the signal is not saved to disk (Fig.7.6, 4). 

 
 

  

Fig. 7.6. Signal fragment deletion steps 
 

Using the Signal Manager 

 
Fig. 7.7.  Changing the signal length 
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 Choose the signal in the Signal manager window.  

 In the Prorties tab (Fig. 7.1) click Change signal length… next to Length, 

values field. 

 In the Change Signal Length (Fig. 7.7) select the fragment of signal using 

cursors (on window opening the cursors are set at the signal start) or type exact 

values in the corresponding fields.  

 Select an operation in the drop-down list: 

 cut (leave the selected interval), 

 delete selected interval, 

 Insert the given number of values.  

 Click OK. 

Changing the length of the signal occurs immediately after confirmation and cannot 

be undone. 

Cancel edit 

Pended edit operations (copy, paste, and delete using the edit panel) can be 

cancelled. 

Select the graph with the changed signal and click  in the edit panel. Confirm the 

action. From the signal will be removed all information about editing and it will be 

restored to original appearance. If the signal is entirely composed of copied 

segments of other signals, then when canceling editing it will be removed. 

Folder (file) handling 
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Fig. 7.8. Folder editing 

Editing operations (copy, paste, and delete using the edit panel) can be performed, 

on one signal or on all signals in folder (file) simultaneously.  

 Open one of signals in the graph and click (Fig. 7.8, 1-2). 

 Perform all necessary operations on the selected signal. Similar operations will 

be automatically performed on the other signals in a folder (Fig. 7.8, 3-4). 

 Click  again to exit the working with folder mode. 

 

Signal Characteristics Modification 

Main Properties of Signal  

Choose Properties… in the signal context menu or open the Signal manager 

window (Layout→Signal manager or click ) and select the signal. On the 

General tab (Fig. 7.1) you can change the unit of measure, type of chracteristics, add 

description, change the sample rate, set start time. 

To set the start time for all signals of the folder, use a Synchronous start button. 

The minimum and maximum values are calculated automatically when plotting. The 

"unknown" in the appropriate fields shows that the values are not calculated. Run 

the calculation using Calculate the min/max button.  

The signal characteristics are changed after you click Apply.  

 The choice of a particular signal does not affect the result. In the process of editing the 
folder for the next operation you can select a signal other than the first one. 
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Modification of Measurement Units 

 

Fig. 7.9. Signal manager. Measurement units 

In measurement units dialog (Fig. 7.9) you can change signal‟s function and units 

for X/Y/Z axes. Function indicates type of signal, for example, direct record from 

sensor (time response), or output of algorithm (spectrum, frequency response). 

Depending on selected function, units set can be limited, for example, units on X 

axis for time response function can olny be time, and for spectrum – frequency. 

Physical quantity (time, frequency, velocity etc) and units are specified for each 

axis, list of units depends on selected physical quantity. 

If only units are changed while physical quantity stays the same (e.g. “Hz” changed 

to “kHz”), you can select “Recalc” option to recalculate values accordingly (for 

previous example, range 10-100 Hz will be changed to 0.01-0.1 kHz). If “Replace” 

option was selected, only units will be changed. 
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Modification of Calibration Curve  

 
Fig. 7.10. Signal manager. Calibration characteristic 

Select the signal in the Signal manager window. The Calibration tab (Fig. 7.10) 

displays the calibration characteristics of the signal as a tree with the coefficients. At 

the bottom of the tab you can add, remove and edit the coefficients. When you add a 

new scale, you can specify its type in the Add the Scale dialog window (Fig. 7.11).  

 
Fig. 7.11.  Add the scale 

If required, for example, to convert values from codes to volts, and volts to kg/cm
2
, 

select a Transformations Sequence and add two scales. 

On the View tab in the column y (file) the signal values in the codes (before use CC) 

are shown, and the fourth column - in the units of the signal (after the CC 

application). See Fig. 7.12. 

Signal Value Editing 

Tabular Values Editing 

Signal values in a tabular form are displayed on the View page of the signal 

properties window (Fig. 7.12). In y(file) column shown the values before applying 

the calibration characteristics (values of the data file). For three-dimensional signal z 

and z-index columns are added. 

For convenience, a table has three additional work modes. Click the desired mode, 

enter the new data in a table cell, hit the Enter key. To return to the view mode click 

the same button.  
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Jump. To navigate to the desired value along the X-axis, enter a value in any cell of 

column x. To jump to the index enter a value in the cell of index column.  

Change. Enter a new value in y, y (file) or x cell. Editing the values in the column x 

is not available for signals with a constant step. Changed values are highlighted in 

red. The data will change only after you click Apply.  

Precision. Enter the desired number of decimal places in fields x, y. Changing the 

precision affect the entire table column. 

 
Fig. 7.12.  Signal manager. Preview 

Single Value Modification 

To change the value at the selected point, switch to cursor mode, position the cursor 

on the desired point and click Values edit ( ). 

 
Fig. 7.13. Edit data 

Enter the new signal value at a given 

point in the Edit data dialog window 

(Fig. 7.13). Click Change. Use “<” and 

“>” buttons to select previous or next 

value for editing. 
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Graph Interval Editing 

To change signal values at several points click 

the  icon to the right of the Replacing 

signal the values ( ) button. 

In the submenu, select the mode of signal 

values replacement. Draw the region for the 

values cutoff (Click the left mouse button and 

without releasing the button, move the mouse 

pointer, release the button). The values of the 

signal which fall under the replacement will 

appear lighter. 

The cutoff line (drawn in red) means the 

following: 

in the Draw lines mode - replace the values 

of the signal to values of this line (Fig.7.14), 

in the Erase higher mode - values above the 

line will replaced with points of a line, below 

the line –not change (Fig.7.15), in the Erase 

below mode - delete values below the cutoff, 

replacing them with the values of the line 

(Fig.7.16). 

 

 
Fig. 7.14.  Draw lines 

 
Fig. 7.15. Erase higher 

 
Fig. 7.16. Erase below 

 

 Changing the values of the signal cannot be canceled. At the entrance to  
the values replacement modes a warning issued. 
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Section 8. Formatting the graphs and reporting 

Formatting the graphs 

To enhance the information content and clarity of results presentation WinPOS 

contains the elements of graphs formatting. These include a multifunctional legend, 

lines numbering, printing values on the grid, captions, labels, labels, regimes and 

comments (See Fig. 8.1). 

 
Fig. 8.1. Enhancing the information content of graph 

In the graph settings dialog window on the Graph tab (Fig. 5.11) you can turned on 

and off the display of the graph name (Graph name), line numbers (Lines 

numbering), the values on the grid (Val. on the grid), select the location of the 

legend, and change other settings. 

Legend 

 One of the main elements of the chart is the legend. The legend may be presented in 

one of three ways - simple, complete, and as the list of labels.  

The simplest form of the legend displays only the names of the lines. If the cursor 

mode is enabled, the current cursor position and values of each line at this point are 

also shown.  

The complete form of the legend is a table in which for 

each signal displayed the several parameters: the sampling 

rate, the values of X and Y at the point of the cursor, etc. A 

Legend 

line numbers 

values on the 
grid 

graph name 
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full list of available parameters is given in Table 8.1. In the Legend tab Graph 

settings window (Fig. 5.15) you can specify which of these columns will be shown 

in the legend. You can show or hide the legend on the same tab page or using the 

graph context menu (Show legend). The size of the legend fields can be changed by 

capturing the field with the mouse cursor and sliding it in the desired direction.  

 

 
Name Name of the line(signal), the color and number of the line is displayed 

near 

Fs Sampling rate of the signal 

dX Step on the X axis, dx = 1/Fs 

Cur X Current lines cursor 

Cur Y Signal value in the cursor point  

Cur idx Index of the value in the cursor point 

L ind Index of the first value on the graph 

R idx Index of the last value on the graph 

Xbeg-Xfin Current range on X 

Ymin-Ymax minimum and maximum values of the signal on a current range on X 

Y range Difference of the maximal and minimal values on a current range 

Ymin (X) The minimum value of the signal over the entire range, in brackets shown 
the value of X at which it is achieved 

Ymax (X) The maximum value of the signal over the entire range, in brackets shown 
the value of X at which it is achieved 

Min Y Minimum signal value over the entire range 

Max Y Maximum signal value over the entire range 

Mean Mathematical expectation of the signal on a current range on X 

RMS RMS of the signal on a current range on X 

SD Standard deviation of the signal on a current range on X 

Segm. length The number of values in the displayed section of the signal 

Length Number of the signal values 

Table 8.1 The list of available columns in the complete legend 

n the legend you can display a list of all the labels, labels, and modes presented on 

the graph. 

 
 

Line numbers 

The change in each parameter on the graph containing multiple lines can be tracked 

using color highlighting of each signal. However, when a large number of lines and 

when printing graphics on a black and white printer the color highlight is not 

enough. The numbers of lines are put down in the rectangle on the corresponding 
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line and in the legend next to the name of the signal. To activate the numbers of 

lines use Graph tab of settings window. 

Hidden lines 

If the graph has many lines, and they're blocking each other, some lines can be 

temporarily hidden without removing them from the graph. To do this, in the context 

menu of the line (called from the legend and tree graphs) you can choose to Hide 

the line or press <space> on the selected line in the Graphs tree. The hidden line is 

marked in the legend as , and in the Graphs tree of is a special sign on 

the icon. 

The active line is always drawn on top of other lines. 

 

Coordinate grid 

 
Fig. 8.2. Coordinate grid types 

The type of a grid changeв using the  button (sequential clicks or selecting from 

the menu on the arrow next to it) or via the Tools menu. The following settings can 

be made: Grid by X and Y, Grid by X, Grid by Y (see Fig. 8.2) and Hide grid. 
 

Grid values 

The values of the signals on the grid make it easy to see changes of signals on paper, 

replacing partly the cursor on the printed graph. The numbers in the column follows 

in the same order as the signals in the legend and displays the same color of the line. 

The values of the hidden line (see above) are displayed, in order not to violate the 

order of the numbers. To activate mode use Graph tab of settings window. 
 

Line style 

Typically, the signal looks on the graph as a solid line, the signal lines are connected 

(first order interpolation). This mode allows you to evaluate the form and change the 

of the signal, but you can't see the individual measurements (dots). 

Vertical lines from points of the signal displaying mode (See The second graph in 

Fig. 8.3) not only solves this problem. It can be useful for a more precise reference 

to the time axis and when comparing signals with different sampling. To activate 

 Hidden line and hidden signal (see Section 9 Signals Processing),  are excluded from 
processing when you call the algorithms. 
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this mode check Vertical lines in the Line tab of Graphs settings window (Fig. 5.12) 

or click  button on the graph toolbar. 

In some cases (for example, when you view the telemetry data) may be a useful 

mode, in which the signal is depicted as individual points (measurements) (third 

graph in Fig. 8.3). Such mode is enabled by ticking No point connection on the 

Line tab in the graph settings window (Fig. 5.12). 

 

Fig. 8.3. Lines displaying options 
 

  

Fig. 8.4. Line selection 

If several slowly varying parameters in the same graph are hardly distinguishable by 

color (for example, when monochrome printing) you can change the shading of a 

line or mark the value of the signal by markers as shown in Fig. 8.4. To do this use 

options Line type and Point type on the Line tab in the graph settings window (Fig. 

5.12). 
 

Display spectrum as histogram 

 
Fig. 8.5. Histograms 
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Typically, the spectra are represented using curves with vertical lines (See. Fig.8.5), 

but you can set the spectrum display in the form of histogram on the Lines tab in the 

Tools→Default Settings... (Spectrum as histogram option). This mode is 

automatically set to octave spectra. 

Labels 

 
Fig. 8.6.  The labels 

The labels allows you to add the exact 

values of the signals at selected points 

or to comment fragments of the signals 

(Fig. 8.6). 

Switch to cursor mode clicking  in 

the toolbar. Set the cursor at the 

desired value. Click to Add a label 

(flag) (or press <Ctrl+F>). 

 

Click the left mouse button to specify the position of the label. The label is set to 

nearest to the cursor point of the signal. The icon  to the right of the button allows 

you to select the type of label: On one line, On all lines or Text. 

To edit or delete the label, double click in its field. 

To move the label, click and hold the left mouse button in label field and drag the 

rectangle to a new position, then release the button. The size of the rectangle is 

automatically selected and cannot be changed. 

 

     
Fig. 8.7. Labels settings 

In the configuration dialog windows of the label (Fig. 8.7) you can enable a 

transparent background. For labels with values – replace abbreviations lines 

(Y1,Y2,Y3,...) with signals names and set the Format for output values: use the 

dropdown list to choose the appropriate format (auto – automatic choice of format) 
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or set your own in the edit field. The # sign denotes a single digit, 0 – indicates a 

need to add the rows with zeros, e – enables the engineering format for numbers. 

The text of label can be edited in the Text field (Fig. 8.7). The >> button opens the 

"history" with previously entered text strings. 

Comments 

Click  (Add comment). Using the mouse draw a rectangle for the text comment 

(Click the left mouse button in graph, then, without releasing the mouse button, 

move the cursor, outlining the rectangle of the future comment). To change the size 

of the region grasp the frame (the mouse pointer over the frame is replaced with 

arrows indicating the direction of movement: press the left mouse button and move 

the frame). To edit or delete the comment, double click in the comment box, this 

will open the edit dialog window(Fig. 8.8).  

You can change the text in the Text field of the comment. The History button opens 

the history window. To delete comment click Delete comment.  

In the same dialog window you can change the alignment and text display style. The 

Move comment field allows to align the comment along one of the sides of the 

graph. To move the comment, click and hold the left mouse button in the text box, 

move the rectangle to a new position, release the button. 

The Advanced>> button expands the comment window. In the right part of the 

window displays a list of the signal properties (if signals in the chart a few – select 

from the drop down list Signal). To copy the property strings in the comment field, 

click the arrow . 

You can copy as the value of the property, and template. In this case, instead of the 

expression in brackets the comment will be filled with the corresponding value 

properties of the selected line or the signal number specified in the template after the 

# sign. In Fig. 8.8 shows an example of a template and its application for naming of 

the signal. 



Section 8. Formatting the graphs and reporting 

 
87 

 

Fig. 8.8. Customizing comment 

Graph printing and saving 

Page printing 

Printing of the active page is performed from a preview window (Fig. 8.9), which is 

opened by clicking  on the main toolbar or via Tools→Print... menu  

The Page... button in the preview window allows you to set margins, and select the 

size and orientation of paper in the standard Windows dialog. The Save button 

creates a graphic file (in BMP format) with the page image. The Load button allows 

you to find and print a previously saved page. 

The Print button opens the standard dialog of the printer setup and printing.  

The Comment... button of preview window (See. Fig. 8.9) allows you to the 

accompanying text at the bottom of the page. 
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Fig. 8.9. Preview. Comment 

Roll printing, emulation 

 
Fig. 8.10. Roll printing setup 

Roll printing window is opened through the Tools →Roll printing... menu. Printing 

on the scroll printer (see Fig. 8.10) allows you to get more convenient for further 

study graphs in more detail on the time axis. If the printer does not support roll 

paper, the emulation of roll printing on separate sheets of paper is performed, so the 

graph with a high time resolution can be obtained by bonding of such sheets. In the 

roll printing settings window you can select the printer (Change button...), set the 

Scale (resolution fields dX...=...mm are associated with a Length of paper field) 
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and set the Boundaries. The Range for X is customized according to on the current 

graph. 

Saving images 

The current graph page can be saved in a graphic file (BMP format) by clicking  

in the main toolbar or via the Tools →Save image menu (opens a standard file 

selection dialog window). 
 

Graph copying via the clipboard 

You can insert WinPOS graphs directly in the text of the document (see Fig. 8.11). 

Click  or select Tools→ Save image in the clipboard. 

Move the cursor to the desired location in the document and click Paste in your text 

processor or press <Ctrl+V>. 

 
Fig. 8.11. Paste graph in the document 
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Section 9. Signals processing. Standard 
algorithms 

WinPOS allows to perform digital processing of the recorded data using a large 

number of built-in standard algorithms. Expert edition contains additional tools for 

working with dynamic processes and vibration analysis. This will be discussed in the 

next section. WinPOS scripts (see Section 11) allows to create unique integrated 

processing programs with the use of WinPOS algorithms. 

The correct application of processing algorithms assumes familiarity with the basics 

of higher mathematics, knowledge of the physical processes occurring during 

testing, and measurement procedures. In the description of algorithms presents the 

basic formulas and comments on their implementation in WinPOS. Provided 

recommendations that will help to set algorithms in the best way to produce results 

that best meets the set objectives. More detailed information on the methods of 

digital signal analysis can be obtained in the sources listed at the end of the section.  

Operations Sequence 

 The sequence of signal processing can be 

represented by a diagram of the five steps. 

The algorithm can be applied to the 

signal, to the folder with multiple signals, 

to all signals, or graphs or to the one line. 

When you select a page, graph or line, the 

algorithm will be applied to the displayed 

range of values according to the principle: 

what you see is what you process. If 

processing selected the folder with the signals or graph with multiple lines, pressing 

<space> on the signal, lines in the Graphs tree or hide the line (See Formatting the 

graphs in Section 8) Excluded signal is marked in the Graphs tree with a special 

icon before the name: . 

Step 1-2  Select signals – Select algorithm 

1. Select the object (signal, folder, page, graph, line) to which the algorithm be 

applied.  

2. Open the context menu of the object to be processed (See Context menu in 

Section 3 and Fig. 3.2), select Algorithm submenu and choose algorithm. 

Step 1-2  Select algorithm – Select signals 

1. Choose the algorithm in the Algoriths submenu of the main (see Fig. 3.3).  

 Select signals    Select algorithm 
 

Select algorithm   Select signals 
 

Customize algorithm 
 

Execute algorithm 
 

Create new resulting graphs 
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2. In the algorithm settings dialog window (Fig. 9.1) click Select next to the Sources 

field, select the object and set the processing range using the Signals selection dialog 

window (Fig. 3.5).  

By default the algorithm is applied to the current line of the active graph.  

 
Fig. 9.1. Customization of algorithms. Auto spectrum 

Step 3  Customize algorithm 

The choice of any algorithm (except the Probabilistic characteristics) leads to 

opening the algorithm settings dialog window (Fig. 9.1).  

The settings window consists of the right part which is the same for all algorithms 

where you set the data sources and the names of the results, and the left part in 

which you can set parameters for a specific algorithm.  

Most of the algorithms takes as input one source signal, and produces a single result 

signal, but, for example, for Cross-spectrum, you need to specify two sources, the 

calculation of the Real and Imag characteristics of the autospectra produces two 

result signals. 

Selected to processing signal range of values and indexes is displayed under Sources 

field. To change the processed range of values or a repeated signal selection use the 

Select button and the Signals selection dialog window (Fig. 3.5). The Apply button 

allows to save the settings without executing the algorithm. The Help button 

displays help about the algorithm.  
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 Step 4  Execute algorithm 

The button Execute starts the calculation process, the progress of which can be 

monitored by the indicators at the bottom of the main WinPOS window. To the right 

shows the general state of the computation, to the left - the name of the processed 

signal and the calculations. To interrupt the calculation press <Esc>.  

The calculated signals are placed in the Results folder, to the signal names added the 

suffix which is an abbreviation of the algorithm. Processed folder has a 

corresponding folder in the Results. 

Step 5  Create graphs of the results 

At the end of the computation the page with graph of the results is automatically 

created and becomes the current. see fig. 9.2. 

Processing of one signal creates a page with two graphs: the source (on the selected 

range) and resultant signals. If the algorithm includes two sources or two results, 

then one graph shall be created for each signal (up to four graphs). At the batch 

signal processing the result page is created and the source signals are not included 

into this page. 

   
Fig. 9.2. Results of Spectrum calculation of the single signal and of all the signals in the folder 

 

To set the preferred viewing range of the resulting 

signals set the Display the interval and define the 

x-axis values range for the result graph.  

Algorithms settings are automatically saved when you close WinPOS and when you 

save the session (see Section 4). To save several sets of settings, for example, for 

various processing programs, you can use Algorithms→Save settings and 

Algorithms→Load settings commands.  

To facilitate access to the most relevant tasks the submenu Recent algorithms 

(Algorithms menu) maintains a list of previously executed operations ordered by 

the time of their call.  
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A quick call of the algorithm 

1. If you frequently calls the same algorithm you can significantly accelerate the 

work: 

 check the Default algorithm mark (see Fig. 9.1), 

 hold down <Alt>, drag signal with the mouse from the Signals tree to the 

graph, as when creating graph (Section 5. Creation of graphs). 

The default algorithm will be performed and the graph of the original signal anв 

instead of graph of the original signal you will see on the graph with result.  

2. If you use algorithms working with two sources, you can specify a second 

source. Click Highlight signal in the context menu of the signal. The signal is 

marked in the tree, with the  icon.  

To make a quick call to the algorithm the most convenient for you, click Advanced 

settings (Fig. 9.1).  

In the Advanced settings window check: 

  

Always open the settings dialog - to configure the default algorithm with a quick 

call (otherwise the algorithm invoked with the current settings), 

Open result in new window – to put the results in a new page (otherwise the result 

will fall where it moved with the mouse), 

Show source signals - to create pages with the original signals (otherwise, only the 

graphs of the resulting signals will be displayed). 

Multithreading 

If whole folder was selected, algorithm can be executed in multithreading mode, 

with every signal processed its own thread simultaneously (“Multithreading” option 
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in advanced settings must be checked, see above). Progress is shown in separate 

dialog. 

 

 

Introduction. Analysis of signals using FFT algorithm 

One of the most important methods in the analysis of signals is the algorithm of fast 

Fourier transform (FFT), which is the fastest method of computing the discrete 

Fourier transform (DFT). FFT gives the possibility of determining the number of 

variables and functions related to signal analysis, multichannel measurements and 

characterization systems, e.g., correlation functions, coherence functions, frequency 

characteristics, etc. One of the main advantages of FFT analysis is to preserve the 

phase information and, consequently, the possibility of simple direct and inverse 

transformations from time domain into frequency and vice versa. 

The defining expressions for the Fourier transform of the input sequence 

{x(n),n=0,...N-1} are: 
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The computational procedure for the discrete Fourier transform (DFT) is the 

algorithm of fast Fourier transform (FFT). Below we consider a specific algorithm 

that is incorporated in the WinPOS package. 

In most cases in practice, the value of x(n) are real and the FFT algorithm is 

designed for complex values. To resolve this redundancy and load imaginary part of 

the input data, the input stream is divided into two sequences as follows: one 

samples with odd sequence numbers, other sequence - even-numbered. Accordingly, 

one of these sequences will be real, and the other the imaginary part of the input 

array for the FFT algorithm. 

Thus, if {x(n)}, n=0,..,N-1 - the input sequence, and 
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Further formed input array: Z(k) =f(k) + ih(k), where k=0,1,..., N/2-1, to which 

applied the FFT decimation algorithm in time with the replacement of the base 2 

with binary-inverse order at the input. 

Using partitioning formulas to the Fourier transformation {Z(k)}, we obtain two 

transformations {F(k)} and {H(k)} 

 Re(F(k))=0.5(ReZ(k) + ReZ(N/2-k)) 

 Im(F(k))=0.5(ImZ(k) - ImZ(N/2-k)) 

 Re(H(k))=0.5(ImZ(k) + ImZ(N/2-k)) 

 Im(H(k))=0.5(ReZ(k) - ReZ(N/2-k)), where k=1,..., N/2-1. 

The transformation {G(N/2-k)} calculated according to the formulas: 

 ReG(0)=ReZ(0)+ImZ(0)  

 ImG(0)=0 

 ReG(N/2)=ReZ(0)-ImZ(0)  

 ImF(N/2)=0 

 

The limitations of the method 

Limitations are mostly determined by the finite and discrete nature of the DFT 

algorithm. The nature of these restrictions will become clearer if we consider the 
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DFT as a result of passing the signal through a set of matching bandpass filters with 

central frequencies: 

 fi=i(fs/N) , where fs – sampling rate, N - number of FFT points. 

Component of the analyzed signal, with the frequency fa which does not coincide 

with the frequency of a spectral line (bin) of DFT, will appear on neighboring 

spectral lines and the amplitude values are determined with some errors (See. Fig. 

9.3). 

 
Fig. 9.3. DFT as a set of matching bandpass filters 

The effect of aliasing 

The first operation of the digital analysis is the discretization of the time signal. 

Formulated by the Shannon theorem on discrete representation establishes that the 

time function in the discrete representation should not contain components with 

frequencies above half the sampling frequency (the Nyquist frequency). Otherwise, 

the components of the original signal g(t) spectrum G(f), frequencies which exceed 

the Nyquist frequency, misinterpreted as the components with lower frequencies 

("aliasing"). 

 
Recommendations. In the analysis of stationary and other signals in the frequency range 
with precisely defined limits the problem of the overlaping are usually resolved by the use 
of analog low pass filters 

Note: In "Bruel&Kjaer" equipment the problem is solved by the use of low-pass filters with sharp cutoff 

at a frequency equal to 80% of the Nyquist frequency. For the effective exclusion of FRF components in 
excessed of the limit of the working frequency range the slope of the low pass filter is taken equal to 

120dB/Oct. The display unit and the external equipment displays only the results that are generally not 

affected by the presence of the filter. For example, in the conversion process with account of 1024 
discrete values in the time domain, in the frequency domain are calculated values of 512 components, but 

the display unit and the external equipment displays the values of only 400 frequency components. 

The effect of weighting 

The next step in analysis is the limitation of the signal in the time domain (finite 

realization). This operation is equivalent to multiplying by a rectangular weighting 
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function (time window). The result of applying the weight function is only relatively 

little noticeable in the case of spectra without obvious peaks. However, if the spectra 

contain discrete components, application of weight function is accompanied by the 

replacement of these components with spectrum of used weight function. The 

weight window acts as a filter (with the corresponding characteristics of the ENB 

and KKG see table. 9.1), the power of the signal at the output of which is proportional 

to the power of the harmonics of the input signal in the band of his bandwidth. This 

effect is known as "weighting effect", "the effect of framing", "formation of side 

bands" and "leakage" (inherent in discrete component power by leakage appears in 

the adjacent bands). 

 

Recommendations. A rectangular weighting function (or lack of weight function) is not 
optimal in the analysis of stationary signals, in particular of signals containing discrete 
components, due to the potential discontinuity at the connected ends of the processed 
implementation. 

The weight function optimal for analysis of stationary signals, must have zero values 

at both ends, and smoothly changing values within a given length analyzed signal 

realization. On the selection of weighting functions, see the relevant Section. 

Fence effect 

The fence effect is associated with the discrete representation of the continuous 

frequency spectra (see explanation to Fig. 9.3). This effect is found not only in the 

analysis based on the FFT, but in those situations where the discrete (not tunable) 

bandpass filters are used, for example, in octave or third octave analysis. In practice 

this effect is the following: while the frequency of a certain component of the 

analyzed signal do not coincide with the frequency corresponding to the spectral 

lines inherent in this component the values of amplitude and frequency will be 

determined with some systematic errors (the frequency value will correspond to the 

frequency nearby in the direction to higher frequencies of the spectral lines). 

Compensation of these errors is possible if the considered component is isolated, 

stable frequency component. 

The use of weighting windows in harmonic analysis 

The finiteness of the observed time interval and the choice of the orthogonal 

trigonometric basis (continuous or discrete) in this interval leads to the adverse 

effects of erosion or leakage of the spectral components. To reduce the erosion of 

spectral components the window (weight function) are used. Impact of windows to 

the data array is in decreasing order of gap on border of the periodic extension due 

to the smoothing effect. The window acts as a filter, the signal level at the output of 

which is proportional to the power of the harmonics of the input signal in-band its 

bandwidth (see Fig. 9.4). Windows affect to many of harmonic analysis indicators, 

including detectability, resolution, dynamic range, reliability and ease of 
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computational operations implementation. To be able to make the right choice of 

weight function, consider the most significant parameters. 

Equivalent noise bandwidth (ENB) 

Due to the presence of broadband noise falling within the bandwidth of the window, 

the estimation of the amplitude spectrum at a given frequency is shifted. To 

minimize the accumulated noise use the narrowband windows. A convenient 

measure of the window bandwidth is the equivalent noise bandwidth (ENB - 

bandwidth of a rectangular filter with the same maximum power gain that 

accumulates the same power as this window - see Fig. 9.4). 

 
Fig. 9.4. Window equivalent noise bandwidth 

The values of ENB for implemented windows in WinPOS are given in table. 9.1. 

The formula for calculating ENB has the form: 

2

2

( )

[ ( )]




n

n

w nT

ЭШП
w nT

 
 

, where w(nT) - discrete values of the weighting 

function. 

Note: ENB is normalized by the N0 /T value, where N0 is the noise power in unit bandwidth, T is the time 

interval of observation. 

Conversion gain (CG) 

In the case of using weighting windows for a constant signal in the absence of the 

noise the spectral component will be proportional to the input amplitude. A similar 

statement holds for the mathematical expectation of this component in the presence 

of noise. For a rectangular window this coefficient is maximum. Reducing the 

coefficient of proportionality for one or the other window relative to a rectangular 

window characterizes the error (bias) of the spectral components amplitudes 

estimation. Table. 9.1 shows the values of coherent gain (the proportionality factor), 

normalized relative to the maximum possible value of N (the number of samples in 

the window). Conversion gain is defined as the quotient of the relationship 

signal/noise at the output and at the input and is the reciprocal of the normalized 

F(w)2 

0 

Equivalent noise 

band 

Maximum gain,  

 noise band = F(0)2 
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ENB window. And thus, the increase in ENB of the window leads to a reduction of 

CG.  

Correlation of overlapping intervals 

Consider the case of dividing the input sequence into multiple sequences of shorter 

length. The number of counts N of the sequence is chosen to provide the required 

spectral resolution, which is determined by the formula 

   Sff
N

  

 

, where fs – sampling rate; 

 - the coefficient characterizing the increase in bandwidth for the 

selected window (usually set equal to the ENB of the window in 

the bins table. 9.1). 

To avoid data loss near the borders of the interval (in the case when the FFT 

operates on the weighted data), the transformation is usually subjected to 

overlapping sections of the sequence. In most cases the degree of overlap selected 

50 or 75%. This raises questions about the correlation degree of the random 

components of the signal in the transformation of two neighboring sequence and, as 

a consequence, about the reduction of variance when averaging correlated 

measurements. The values of correlation coefficient (with a relatively flat noise 

spectrum within the bandwidth of the window) for each of the windows 

implemented in WinPOS with 50 - 75% overlap are shown in table. 9.1.  

Now, with regard to dispersion. When averaging of K independent measurements of 

ergodic random variables the variance of averaged value associated with the average 

of individual measurements by the following relationship:  

2

.

2

.

1


средн

измер K




 

For averaging ofcorrelated measurements: 

 50%-overlap: 

2

. 2 2

2 2

.

1 2
[1 2 (0,5)] [ (0,5)]    

средн

измер

c c
K K




 

 75%-overlap: 

2

. 2 2 2 2 2 2

2 2

.

1 2
[1 2 (0,75) 2 (0,5) 2 (0,25)] [ (0,75) 2 (0,5) 3 (0, 25)]        

средн

измер

c c c c c c
K K





where c2(0.75), c2(0.5) and c2(0.25) – correlation coefficients for 75%-, 50%- and 

25%-overlap. The negative components are describes the edge effects of averaging 
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and when K>10 they may can not taking into account. For good windows 

c2(0.25)<<1, it can also be omitted. 

Maximum conversion loss 

Maximum conversion loss consist of maximum losses due to spurious amplitude 

modulation of the spectrum (fence effect) for given window (in dB) and conversion 

losses due to the shape of the window. The maximum loss is always between 3.0 and 

4.3 dB (the window with the index > 3.8 dB are unsatisfactory). 

Detection of two close tones 

The leakage of the spectral components leads to biased estimation of the amplitudes 

and locations of the harmonic components of signal. This effect is most unpleasant 

for detection of weak signals in the presence of strong interference of close 

frequencies. To reduce the undesirable effects the amplitude of the side bands away 

from the main of window should be small, and the transition from the central to the 

low-amplitude side bands very fast. The maximum level of the side bands (relative 

to the main band) and the asymptotic decreasing rate of the lateral bands are shown 

in table. 9.1. 

Weighting windows 

The windows (functions) can be useв ещ reduce unwanted effects due to the finite 

legth of observation intervals: 

 rectangular weighting function (no weighting function); 

 Hanning window : 
W(n)=0.5(1-cos(2n/N)),  n=0,...,N-1; 

 Blackmann-Harris window: 
W(n)=A

0
-A

1
cos(2n/N)+A

2
cos(22n/N)-A

3
cos(32n/N), n=0,...,N-1, 

where N is the number of discrete samples of the weighed process, 
A

0
=0.35873; A

1
=0.48829; A

2
 =0.14128; A

3
=0.01168; 

 triangular window: 

2 , 0,1,..., ;
2

( )
( ), 1,..., 1

2

n Nfor n
N

W n
NW N n for n N

  
 

   

 

 Flat Top: 
W(n)=1-A0cos(2n/N)+A1cos(22n/N)-A2cos(32n/N)+A3cos(42n/N),  

n=0,...,N-1, А
0
=1.93; A

1
=1.29; A

2
 =0.388; A

3
=0.0322; 

The type of used window is critical for detection of tones in the presence of other 

closely located tones. In order to have maximal dynamic range for detectable signals 

the window conversion should have a narrow main band and a very low level of side 

bands.  
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Fig. 9.5. illustrates the spectra of cos-function, weighted in the time domain, using 

respectively, the rectangular function, Hanning function, Blackman-Harris and Flat 

Top function The frequency of the cos-function is in the interval between two 

adjacent spectral lines (X=0.125, f=15.0625). 

 

 Flat Top Hanning Blackman-Harris Rectang. 

Y (dB) -0.016 -1.424 -0.856 -3.937 
X 15.000 15.000 15.000 15.000 

Fig. 9.5. cos-function spectra 

From Fig. 9.5. it is clearly seen that the narrowest main band (bandwidth) has a 

rectangular window. At the same time, this window has the highest level of the side 

bands, which leads to additional conversion losses - increases power spurious 

(outside the passband) signals, the impact of "leakage" of the spectral components is 

stronger. Blackman-Harris window has the lowest level of the side bands, but a wide 

bandwidth. Among the above windows, the Hanning window is optimal and has the 

minimum conversion loss, which allows to recommend it for use in virtual devices. 

Flat Top function, which has most wide bandwidth, contributes to a significant 

reduction of the fence effect and applied for calibrating the analyzing instrument 

using the reference tone signal with a frequency in the interval between adjacent 

spectral lines. 

  

Rectagular 

Blackman-Harris 

Hanning 
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Table 9.1 Main parameters of winwow functions 

Normalization of the weighting window described above, maintains the amplitude of 

the signal: 

 

 
∑     ( )  

   

   

 

To preserve signal energy (in accordance with Parseval theorem), used the windows 

normalized in accordance with the condition:  

√
 

 
∑     ( )

   

   

   

 

In the setting dialog windows these windows provided whith "(RMS)"mark. 

Example: "Hanning (RMS)". 

Spectral analysis 

Spectral analysis is used to assess the following characteristics: 

 amplitude spectrum, power spectrum, power spectral density, spectral 

energy density, complex spectrum; 

 cross-spectrum; 

 coherence function, coherent output power, non-coherent output power, the 

signal-to-noise ratio; 

 transfer functions. 

The main frequency range of analysis extends from 0 Hz to the Nyquist frequency 

and does not depend on the number of discrete values in analyzed signal realization. 

The Nyquist frequency f
N
 is related with a sampling frequency f

S
 as f

N
= f

S 
 / 2.  

The actual frequency range is bounded from above by the cutoff frequency of used 

low pass filter. 

Weighting 

window 

ENB 

(bins) 

ratio of 

coherent gain 

maximum level 
of sideband 

(dB) 

maximum 
amplitude 

error (dB) 

peed of 

decay of 
the side 

lobes 

(dB/oct) 

correlation of 

overlapping 
intervals (%) 

75 50 

Rectangular 1.0 1 -13 3.92 -6 75.0 50.0 

Blackman-Harris 2.0 0.36 -92 0.83 -6 46.0 3.8 

Hanning 1.5 0.5 -32 1.42 -18 65.9 16.7 

flat top  3.77   -93 0.01    0   

Triangle  1.33 0.5  -27 1.82 -12 71.9 25.0 
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The number of spectral lines of analysis in the main frequency range is related to 

the number of discrete values of N and is usually equal to N/2 in the range with the 

upper limit established by the Nyquist frequency. 

Frequency corresponding to the i-th spectral component (harmonic): 

fi=i(fs/N) , where  fs – sampling frequency 

The frequency resolution (f) or the interval between adjacent spectral lines for 

analysis is determined by the following equations: 

 f=1/T=1/(Nt)=fs/N , where T – length of converted realization of the 

analyzed signal; 

 N - number of input discrete values (conversion size); 

 t – time sampling; 

 fs  - sampling frequency. 

The width of the frequency band (B) for analysis usually is more than frequency 

resolution and depends on the time-domain weighting function: 

 B=fKENB , where K
ENB

 - coefficient associated with the selected weighting 

function. 

Auto spectrum 

Based on the discrete Fourier transform F(k) the 6 characteristics are defined. 

   
Fig. 9.6. Auto spectrum 
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Amplitude spectrum 

Ampl. Is determined through the power spectrum and has a dimension of (units): 

( ) ( )A PSG k G k . For single-sided amplitude spectrum and in the case of the 

application of weighting windows: ' '( ) ( )A PSG k G k . 

Power spectrum 

PS. Characteristic is determined by averaging over M realizations and has a 

dimension of (units
2
): 

22
'

2
0 0 0

1 1 1 1
( ) ( ) ( ) ( )

M M M

PS PSj j j

j j j

G k G k F k F k
M M M N  

        
,where: 

'1
( ) ( ) j jF k F k

N . 

In the case of calculation of single-sided power spectrum (it is calculated in the 

WinPOS) and using the weighting windows it is necessary to introduce correction 

factors: 

G'PS(k)= 2KnGPS(k)/Kcpgf, where  2 - indicates that we calculate single-sided 

power spectrum, 

 Kn = 1 for effective values, Kn = 2 for peak values, 

 Kcpgf - the coefficient of coherent gain of power (equal to the square of the 

coefficient of coherent gain), depends on the choice of weighting function (see table 

above). 

Power spectrum density 

PSD. Characteristic is determined by averaging over M realizations and has a 

dimension of (units
2
/Hz): 1

( ) ( )PSD PSG k G k
f

 


 

For single-sided amplitude spectrum and in the case of the application of weighting 

windows: 

 
'

' ( )
( ) PS

PSD

G k
G k

f 

 

 where   - ENB: correction factor associated with the use 

of weight functions is taken into account automatically, f - sampling 

frequency. 

Energy spectrum density 

ESD. Characteristic is determined by averaging over M realizations and has a 

dimension of (units
2
 s/Hz): 

 
0 0

1 1
( ) ( ) ( ) ( )

M M

ESD ESDj PSDj PSD

j j

G k G k G k T G k T
M M 

       
 

For single-sided amplitude spectrum and in the case of the application of weighting 

windows: 
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' '( ) ( )ESD PSDG k G k T  . Herein and after Т - observation interval. 

Complex spectrum, the module and phase 

Spectrum, calculated as the complex value can be represented in one of two forms: 

 of real and imaginary parts (Real and Imag): 

 '

0 0

1 1 1
Re ( ) Re ( ) Re ( )

 

     
M M

j j

j j

F k F k F k
M M N

 

 '

0 0

1 1 1
Im ( ) Im ( ) Im ( )

 

     
M M

j j

j j

F k F k F k
M M N

 

 module (amplitude) and phase (Mod. and Phase): 

 2 2Mod ( ) ( ) (Re ( )) (Im ( ))  F k F k F k F k  

 Im ( )
Fas ( ) ( )

Re ( )


F k
F k arctg

F k

.  

Here, the phase – phase difference with the cosine function. 

Method: Fast (FFT) or Discrete Fourier Transform (DFT). 

Points – number of points (size of portion) by which the spectrum is calculated: 32, 

64, 128, 256, 512, 1024, 2048, 4096, 8192, 16384, 32768, 65536, 131072,  262144. 

Arbitrary for DFT. 

Number of FFT portions - the number of portions for averaging. The maximum 

possible number of portions is set by default, depending on the selected number of 

FFT points, portions shifts and the data file size. 

Portion shift - shift of the next portion start after calculation by the previous 

portion: 1, ¼N, ½N, ¾N, N, where N - number of FFT points. 

Weighting window: rectangular, triangular, Hanning, Hanning (RMS), Blackman, 

Blackman (RMS), FLAT-TOP, FLAT-TOP (RMS). 

Values: effective (RMS), amplitude: (Peak, Peak-Peak). The values are averaged, 

unless Max.values option is used.  

Centering – removing the constant component of the signal.  

Logarithm – The “Taking the logarithm” algorithm will be applied to the result (see 

below Fig. 9.16). Click >> button on the right of the logarithm parameter field to 

modify the factor (10 or 20) and to enter a reference value. 

Transformation – The “Spectrum Transformation” algorithm will be applied to the 

result (see below Fig. 9.17). Click the >> button on the right of the transformation 

parameter field to modify the parameters.  

Zero filling – Allowance for calculation of the signals with the length smaller than 

the number of FFT points. It can help to eliminate the uncertainties conditioned by 

the presence of signal narrow band components. 
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Time on X axis - is accessible, if a three-dimensional spectrum is calculated (the 

option 3D is chosen). If this option is switched, then time will be put along the X 

axis of the resultant three-dimensional spectrum, and on Z axis – a frequency. 

3D – the spectrums calculated by portions are not averaged but put along the Z axis. 

The number of FFT portions is the resulting „depth‟ by Z axis. See the 3D spectrum 

section below. The Z axis is digitized in seconds, showing the start time of another 

portion. Here the number of FFT portions determines the dimension of the result 

along the Z. For a number of signals the three-dimensional spectrum gives a more 

complete and clear pattern of the processes. 

In the cursor mode (see Section 6. Signals viewing) the projection of the three-

dimensional spectrum allows to analyze in detail the parts of the spectrum.  Section 

Z is a conventional two-dimensional spectrum for the portions with an offset equal 

to Z (listed at the top of the graph). Section X shows the amplitude dependence on 

time for a fixed frequency (see line “X=...“ at the top of the graph). 

 
Fig. 9.7. The three-dimensional amplitude spectrum calculation result  

Octave spectrum 

For calculation of the octave, third-octave, 1/12 - and 1/24-octave spectrum, select 

the characteristics, as well as one of the two methods of calculation.  

Band-pass filters. The method is based on the use of recursive filtering, and is 

implemented by the classical scheme: bandpass filter - quadratic detector – 

integrator. The basis of the scheme is the mathematical definition of the power 
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spectrum. In this scheme, a bandpass filter selects the spectral components lying in 

the required band, then the filtered signal is squared and averaged. To obtain a 

normalized spectrum, the result is divided by the bandwidth of the current octaves or 

fractions of octaves. 

  
Fig. 9.8. Octave spectrum 

Thus, for example, the third-octave power spectrum is calculated according to the 

formula: 

 0

0

(1 6)

2 2

1 3 0

(1 6)

1 1
( ) ( ( )) d ( )d





    
oct

oct

f

f

A f L X t t A f t
T T



 

 where:  T - period of analysis; 

  X(t) – input signal; 

  L(X(t)) - band-pass recursive filter operator. 

The recursive filtering algorithms are applied here due to the fact that they are the 

most adequate procedures of the analysis with the same relative width of the 

elementary band. For the third-octave analysis the ratio of the left and right 

elementary band boundaries is 2
1/3

. 

The frequency response of the filter and the deviation of effective bandwidth from 

the nominal should correspond to GOST 17186-82. Filters used in WinPOS meet the 

first class of accuracy according to GOST 17186-82 (filters for accurate laboratory 

or field measurements). 
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Fig. 9.9. Frequency responses for octave and third octave filters in WinPOS and for first class 

filters  

Figure 9.9 shows the frequency response for octave and third octave filters in 

WinPOS and first class filters according to GOST 17168-82 (see table 9.2). 

Octave filter, 1st accuracy class Third octave filter, 1st accuracy class 

Relative frequency, f / 
fm 

Decay, dB Relative frequency, f / 
fm 

Decay, dB 

0.125 < -65 0.2 < -75.0 

0.25 < -50 0.25 < -68.0 

0.5 < -23 0.5 < -45.0 

0.7071 -6.0 .. 0.5 0.7937 < -14.0 

0.8409 -1.0 .. 0.5 0.8909 -6.0 .. 0.5 

1.0000 -1.0 .. 0.5 0.9439 -1.0 .. 0.5 

1.1892 -1.0 .. 0.5 1.0000 -0.5 .. 0.5 

1.4142 -6.0 .. 0.5 1.0595 -1.0 .. 0.5 

2 < -23 1.1225 -6.0 .. 0.5 

4 < -50 1.2599 < -14.0 

8 < -65 2 < -45.0 

  4 < -68.0 

  5 < -75.0 

Table 9.2 First accuracy class filters parameters according to GOST 17168-82 

Filter 
Nominal 
value 

Deviation of effective bandwidth, % 

GOST 17168-82 
Normal accuracy High accuracy 

1st class 2nd class 

Octave 0.7071 8 10 18.3 5.1 
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third octave 0.2316 8 10 20.1 4.0 

1/12-octave 0.0576 8 10 7.4 4.9 

Table 9.3 Deviation of effective bandwidth 

Table 9.3 shows the deviation of the effective bandwidth from the nominal 

bandwidth. The values given for filters with maximum errors. 

The fast Fourier transform. The method is implemented based on the FFT, 

described above. In this case, the requirements of GOST are not fully met, due to the 

smaller steepness of the filters. 1/24-octave spectrum is calculated through FFT 

only. 

Figure 9.10 shows the dependence of the results from the selected method. 

 
Fig. 9.10. Third-octave logarithmic spectra of the sine with a frequency of 25 Hz, calculated by 

different methods 

In most cases it is recommended to use the FFT method in the calculation of the 

octave spectra. Calculation using FFT runs much faster than filtering and does not 

require a large amount of raw data and provides high accuracy (of the order of -160 

dB) in entire frequency range. Filtration method with high precision filters is useful 

if you need to obtain maximum precision in the high frequencies and the original 

signal has a greater length. The longer the original signal is, the wider the frequency 

range, which ensures high accuracy (of the order of -250 dB). Filters with normal 

accuracy allows to calculate the spectrum of the signal with shorter length, provide 

the same precision as the high-precision filters in high frequencies, and they have a 

flatter frequency response. Filters of usual accuracy allow to obtain the values of the 

spectrum in the low frequency region, the greater the length of the original signal, 

the further in the low frequency area expands the frequency range of the spectrum. 

Central and boundary frequencies 
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The center frequencies are calculated by the following formulas: 

for octave and third octave spectra: fm = G
x/b

 *fr , 

for 1/12- and 1/24-octave spectra: fm = G
 (2x+1) /2b

 *fr , where 

G - octave coefficient (equal to 2 or 1.995, depending on settings), 

fr - reference frequency, 1000 Hz, b – fraction of octave filter (1, 3, 12 or 24, 

respectively), x - number of octaves or fractions of octaves 

The boundary frequencies are calculated by the formulas: 

f1 = G
-1/2b

 *fm , f2 = G
+1/2b

 *fm 

It should be remembered that the range of the analyzed frequencies limited by the 

Nyquist frequency (Fs/2). So for Fs = 1 kHz, we gain range up to 450 Hz (see table 

9.4). 

Octave 1/3-octave Octave 1/3-octave Octave 1/3-octave 

 160000  630  2.5 

125000 125000 500 500 2 2 

 100000  400  1.6 

 80000  315  1.25 

63000 63000 250 250 1 1 

 50000  200  0.8 

 40000  160  0.63 

31500 31500 125 125 0.5 0.5 

 25000  100  0.4 

 20000  80  0.315 

16000 16000 63 63 0.25 0.25 

 12500  50  0.2 

 10000  40  0.16 

8000 8000 31.5 31.5 0.125 0.125 

 6300  50  0.1 

 5000  20  0.08 

4000 4000 16 16 0.063 0.063 

 3150  12.5  0.05 

 2500  10  0.04 

2000 2000 8 8 0.0315 0.0315 

 1600  6.3  0.025 

 1250  5   

1000 1000 4 4   

 800  3.15   

Table 9.4 Center frequencies of octave and third octave spectra 

Other settings: 

FFT portions – the number of portions the spectrum will be averaged by. A 

maximum practicable value is set by default. 
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3D – the spectrums calculated by portions are not averaged but put along the Z axis. 

The number of FFT portions is the resulting „depth‟ by Z axis. See the 3D spectrum 

section below. 

 
Fig.9.11. 3D 1/12-octave spectrum calculation result 

Values – A result type is set: RMS, RMS-to-bandwidth ratio, power-to-bandwidth 

ratio. 

High quality – available only for calculation applying the filtration method; in this 

case the band-pass filters of a higher order are used. 

Octave ratio (G) – a coefficient used for calculating octave boundaries or an octave 

portion. 

Other settings are the same as for Auto-spectrum 

Cross spectrum 

The cross-spectral characteristics of the input processes a(t) and b(t) are determined 

from the complex instantaneous spectra A(f) and B(f) and cross-spectrum G
AB

(f). 

 

 
0

( ) ( ) exp 2 d  
T

A f a t j f t t
; 

 
0

( ) ( ) exp 2 d  
T

B f b t j f t t
 

In discrete form : 
1

0

2 1
( ) ( exp ) ( )





 
       

 

N

n дпф

n опр

kn
A k a j t А k

N F

 ;  1
( ) ( )  дпф

опр

B k B k
F

 

Cross-spectrum is determined on the basis of the instantaneous spectra A(f) and B(f) 

and is given by the expression: 

S
AB

(k)= A*(k)B(k), where “ * “ is the sign of complex conjugation. 

The relationship between single-sided and double-sided characteristics is set by the 

ratio: 
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Similarly, for autospectra G
AA

(f) and G
BB

(f), where S
AA

(k) = A*(k)A(k) and 

S
BB

(k) =B*(k)B(k) . 

Select the characteristic and set the other parameters, referring Autospectrum. 

  
Fig. 9.12. Cross spectrum 

Cross power spectrum density 

PSD. The dimension of the result: unit
2
/Hz. 

1
( ) ( )psdAB ABG k G k

T
   

In the case of use of weighting windows it is necessary to introduce correction 

factors, and the formula would be: 
 G'psd

AB
(k)= Gpsd

AB
(k)/(K

cpgf
) 

 where: K
cpgf

 - the ratio of the coherent signal gain by power; 

  -  ENB. 

Complex spectrum, the module and phase 

Spectrum, calculated as the complex value can be represented in one of two forms: 

 of real and imaginary parts (Real and Imag): 

0

2
Re ( ) Re( ( ))



 
M
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j
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0

2
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
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M
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j
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 module (amplitude) and phase (Mod. and Phase): 

 
Mod ( ) 2 ( ) ,

Im ( )
Fas ( ) ( )
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

AB AB
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Complex spectrum 

  
Fig. 9.13. Cross complex spectrum 

Select characteristics: Real and Imag, or the inverse transformation. Set the 

remaining options, referring Autospectrum. 

Coherence function 

The coherence function is used to determine the degree of linear relationship 

between signals at input and output. Select the characteristics and set the other 

parameters, referring Auto-spectrum. 

 
Fig. 9.14. Coherence function 

Coherence 

COHERENCE. The coherence function ν
2
(k) shows in the frequency domain on a 

scale from 0 to 1 a quantitative measure of linear dependence inherent to individual 

values at the frequency f of two processes (signals) a(t) and b(t). The coherence 

function is determined on the basis of eigen spectra and cross-spectrum of the 

considered signals according to the formula:  

 
2

2
( )

( ) ,
( ) ( )




AB

AA BB

G k
k

G k G k


 

Inherent to separate frequency values f(k) values of the coherence function ν
2
(k) are 

correspond to the squared values of the correlation coefficient. 

Note: the coherence function is based on the undergone the averaging functions, in the case of a single 

isolated assessment is equal to the unit value. 

The coherence function ν
2
(k) values can be negative for the following reasons: 
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1) presence of uncorrelated noise in the signal a(t) and/or b(t); 

2) nonlinear coupling between the signals a(t) and b(t); 

3) leakage due to insufficient resolution and/or using of non-optimal 

weighing functions (a special kind of nonlinearity caused by the analysis 

procedure); 

4) the time delay between the signals a(t) and b(t), commensurate with the 

duration of these signals. 

Applications of the coherence function 

The coherence function is used when checking the validity of other functions and in 

determining influence of noise and/or nonlinearities of these functions.  

Note: small values of the coherence function does not always indicate the invalidity of the functions 

being defined, and in some cases they are a sign of the need to increase the number of cycles of averaging 

to ensure valid results. 

Incoherence 

NOTCOHER. Defined by: 21 ( ) k . 

Coherent output power 

COP. Determined on the basis of the coherence function and displays the part of 

measured spectrum of (output) signal G
BB

(k) which is completely coherent with a 

certain (input) signal represented by the function a(t) and a spectrum G
AA

(k). The 

mathematical expression of the characteristics has the form: 2COP( ) ( ) ( )  BBk k G k .  

Note: at small values of the coherence function COP is valid only in the case when the decrease of 

coherence is due only to superimposed on the output signal noise. 

Incoherent output power 

NOTCOP. Defined by: 2NCOP( ) (1 ( )) ( )   BBk k G k  

If the only factor affecting the degree of coherence is the noise imposed on the 

output then the coherent output power (proportional to ν
2
(k)) displays "signal at 

output", while the non-coherent output power (proportional to 1-ν
2
(k)) displays the 

"noise at output". 

Signal-to-noise ratio 

S/N. Determined on the basis of the coherence function according to the formula: 
2

2

( )
( )

1 ( )




kS k
N k




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Transfer function 

The transfer function shows in the frequency domain the ratio of the magnitudes of 

the output values to the values at the input of the different systems and, therefore, 

completely characterizes the stable, linear, time-invariant physical systems 

(mechanical, acoustic, and electric). 

Based on the results of simultaneous measurements and based on FFT signals 

analysis at the input and output of the physical system it is possible to identify two 

differ from each other complex frequency characteristics of the system, i.e. 

 
1

( )
( )

( )
 AB

AA

S k
H k

S k

 and 
2

( )
( )

( )
 BB

BA

S k
H k

S k

. 

where a(t) – input signal, b(t) – output signal. 

    
Fig. 9.15. Transfer function 

Choose characteristic (Н1 or Н2). Set the other parameters, referring Auto-spectrum. 

Recommendations for use 

1. In the presence of parasitic (non-correlated) noise at the output or several 

independent from each other signals at the input, it is advisable to use the estimate 

H1(k) as the optimal approximations of the frequency characteristics of the 

corresponding system. 

2. In the presence of parasitic (non-correlated) noise at the input use H2(k) as the 

optimal approximations of the frequency characteristics of the corresponding 

system. 

3. In cases of difficulties associated with leakage (due to insufficient resolution 

frequency) in the areas of the resonances preference is given to the evaluation of 

H2(k), approximating the frequency response of the system more accurately than the 

estimate H1(k). 

In the areas of antiresonances of the system under study, which does not exclude the 

presence of noise on the output, normally it is advisable to use the H1(k) estimation 
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while the application of evaluation H2(k)  is generally useful in the areas of the 

resonances, where not excluded difficulties due to input noise and/or leak . 

In situations where spurious (uncorrelated) noise is present on the input and output 

of the system under study, and the leak is not the cause of large systematic errors, 

estimates of |H1(k)| and |H2(k)| can be used respectively for lower and upper limits 

of the interval which contains the true values of the modulus of the frequency 

characteristic |H(k)|. 

Taking the logarithm 

Taking the logarithm is performed by the formula: 

 
lg 10log ( ) 

ref

U
U k

U

 

Here k is the factor taking one of two values (10 or 20) depending on characteristics 

(e.g.,for amplitude spectrum, this ratio is equal to 20, for the power spectrum to 10). 

Set in the "logarithm" field . Uref is a reference value that can be set manually or 

using the maximum value logarithmorum signal. 

 

Fig. 9.16. Taking the logarithm 

Spectrum transformation 

Select conversion type: 1 – no transformation, 
1


– integration, 2

1


– double 

integration, 
2

2 2


– the transition from acceleration spectrum to displacement 

spectrum, 1   - single differentiation, 21   - double differentiation. 
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Fig. 9.17. Spectrum transformation 

Lower frequency and Signal/noise - HPF settings. 

The spectrum values can be multiplied by a correction function. Function is specified 

by pairs of numbers: frequency and the corresponding amplitude multiplication 

factor. To use correction function select Corrector field. 

For enter frequencies and coefficients from the keyboard activate the table cell by 

double-clicking, enter the number and press <Enter>. To insert and delete rows, use 

<Ins> and <Del> keys. In order to save specified characteristics in the file, click Save 

and select the file in the standard save dialog. 

To load functions from disk, click Load, select the menu item From file... and 

specify the file. To load frequency (acoustic) characteristics for the third-octave 

spectrum click the Load and choose the option A, B or C (see [4] and [6]). 

Characteristics are stored in CSV (Common Separated Values) files. You can open 

the file in MS Excel or as a text file. 

Recursive filtering 

Recursive filtering is based on the sequential use of canonical units of the second 

order. 

Y
n
 = B

0
Y

n-2
+B

1
Y

n-1
+A

0
X

n-2
+A

1
X

n-1
+A

2
X

n
, where: Y

n
 is the filtered array, X

n
 - 

the input array, B
0 

, B
1 

, A
0 

, A
1 

, A
2
 - coefficients of the filter, calculated in accordance 

with the specified characteristics. 

The transfer function for a recursive link has the form 

: 
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To avoid transients of long duration processes you are advised to fulfill the 

condition: 

2 100 s

cp

F

F
 

, where Fср – filters cutting frequency, Fs - sampling rate. 

Thus, for example, the filter of the 12th order will have no more than 700 counts of 

the transition process. 

If, for example 
2 50 S

ср

F

F

, it is possible to ensure that the maximum duration of the 

transitional process not more than 350 counts. 

Type of approximation: Butterworth, Chebyshev or elliptic characteristics. 

Filter type: high-pass filter, band-pass or low-pass filter. 

Filter order defines the slope – the rate of decline in frequency response during the 

transition from the passband to the band suppression. The higher the filter order, the 

better formed his bandwidth and therefore the lower the amount of unwanted 

components of the input signal at its output. 

To ensure the best ratio quality-performance, it is recommended to apply the 

following filters: 

 elliptic filter of the sixth order (provides attenuation at twice the cutoff 

frequency of no less than 65 dB); 

 Chebyshev sixth order (provides attenuation at twice the cutoff frequency 

of no less than 60 dB); 

 Butterworths filter of eight order (provides attenuation at twice the cutoff 

frequency of no less than 55 dB). 

All of these filters satisfy to requirements for class 1 filters (filters for accurate 

laboratory and field measurements) in accordance with GOST 17168-82. 

To check the quality of the required characteristics you can obtain amplitude-

frequency and phase-frequency characteristics of synthesized filter in the frequency 

range: 

0 < F < 2Fc    for LP filter; 

Fn/2 < F < 2Fv  for bandpass filter; 

Fc/2 < F < 2Fc for HP filter,  

where Fc - cutoff frequency for the LF, RF filters, Fn, Fv - upper and lower cutoff 

frequencies for a bandpass filter. 

Cutoff frequency - the cutoff frequency of the filter by -3 dB level. The top - to the 

low-pass filter, the lower one for the HPF. For a bandpass filter set both frequencies. 
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Flatness in the passband - maximum amplitude of the unevenness of the filter. 

 
         Fig. 9.18. Recursive filtering 

Sampling frequency. By default the sampling frequency of the input signal is used. 

In the central part of the filter parameters settings window displayed the graphs of 

amplitude-frequency, phase and pulse (Pulse tab) characteristics based on the 

parameters set. Changing the type of filter or approximation is immediately reflected 

in the graphs of characteristics. For updating fraphs after changing the numerical 

characteristics click the Apply button. 

Non-recursive filtering 

Type of approximation - Fourier series. 

Filter type: ФВЧ – high-pass filter, low-pass filter or nothing. 
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Fig. 9.19. Non-recursive filtering 

Weighting window for Fourier transform: Hamming or Hann. 

Filter order defines the slope – the rate of decline in frequency response during the 

transition from the passband to the band suppression. The higher the filter order, the 

better formed his bandwidth and therefore the lower the amount of unwanted 

components of the input signal at its output. 

Cutoff frequency - the cutoff frequency of the filter by -3 dB level. The top - to the 

low-pass filter, the lower one for the HPF. For a bandpass and notch filter set both 

frequencies. 

Sampling frequency. By default the sampling frequency of the input signal is used. 

In the central part of the filter parameters settings window displayed the graphs of 

amplitude-frequency, phase and pulse (Pulse tab) characteristics based on the 

parameters set. Changing the type of filter or approximation is immediately reflected 

in the graphs of characteristics. For updating fraphs after changing the numerical 

characteristics click the Apply button. 

Median filtering 

The median filter suppresses the pulse noise, the duration of which is less than half 

the width of the aperture. 
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Fig. 9.20. 

Specify the number of points – width of the filter aperture (can only take odd 

values), select a filter type. 

Discrete filter 

This filter can work only with signals that have two distinct states, e.g., "0" and "1" 

such as control signals. Designed for cleaning command signals from random noise 

and the characteristic features, such as "contact bounce". Set the upper and lower 

levels manually or select the checkbox "define automatically". The threshold 

determines the range of possible variations within the same level.  

Analog filter 

Used mostly to keep out of the points of impulse noise. Often used for primary 

filtration of strain gauges channels signals. A specified number of consecutive signal 

points is sorted, then selected the mean by ordinal number value (the value of 

N/2+1, where N is the width of the aperture), called the median. If the median 

differs from the original signal value at a given point by more than the threshold 

value, the corresponding point of the resulting signal will be recorded with the 

median value, otherwise the value of the original signal. The filter window is shifted 

by one position towards the end of the signal and the process repeats. For the analog 

filter the threshold specifies the allowable deviation of the signal values from its 

median, (does not replace the values with the median).  

Hilbert Transform 

 
Fig. 9.21. Hilbert Transform 
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To obtain the Hilbert transformant direct and inverse fast Fourier transform (FFT) 

are used. For the input array the direct Fourier transform is used: 

  

 The resulting spectrum is transformed to the: 

  

By inverse Fourier transform of the spectrum Z(k) get the analytical signal: 

, where  is the Hilbert transformant of input signal . 

Set N - the number of FFT points. If the number of FFT portions is greater than 

1, the original signal is divided into consecutive blocks of length N and the 

calculation is repeated specified number of times. For eliminating the constant 

component, check the box Centering. 

Envelope 
Select one of the two methods of the envelope calculating. 

 
Fig. 9.22. Envelope 

The peak detector 

To obtain reliable results, the original signal must be narrowband and centered. The 

algorithm for computing the envelope in digital form: 

1
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where К=RC/t –"RC" is the averaging coefficient that defines 

the "time constant", 

 

t- sampling time 

Hilbert Transform 

The formula for calculating the envelope: 

1

0

1 2
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N
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N N
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для k=1,...,N/2-1; 

для k=0; 

для k=N/2,...,N-1 



Section 9. Signals processing. 

 
123 

 , where  is the Hilbert transformant of input signal 

.  

Envelope calculation settings are similar to the Hilbert transform settings. 
 

Differentiation 

Select one of the two methods of numerical differentiation. 

 

Fig. 9.23.  Differentiation 

Three-point 
The first derivative is calculated by the formula: 

 '

1 1

1
( )

2
   


n n nY Y Y

x

 

Five-point 
The formula for the first derivative: 

'

2 2 1 1

1
[( ) 8 ( )]

12
        


n n n n nY Y Y Y Y

x

 

 

Integration 

Select one of four methods of Cauchy problem numerical solution, i.e., integrating 

the differential equation of the first order: y'=f(x,y) 

  
Fig. 9.24. Integration 

Euler's Method 

Is step-by-step application of the formula of the third order: 

yn+1= yn + 0.5·(3·fn - fn-1)·x 

2 2( ) ( )z n f f n  ( )f n

( )f n
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Hamming method  

Without modification (formula of the fourth order) with the calculation of the first 

three points on the Euler formulas: 

1 3 1 2

4
(2 2 )

3
          pred

n n n n ny y f f f x  

1 2 1 1

1 3
(9 ) ( 2 2 )

8 8
             corr

n n n n n ny y y f f f x  

1 1 1 1

9
( )

121
      corr corr pred

n n n ny y y y  

The first two methods, being the best approximation of the ideal integrator that 

significantly raise (amplify) the signal at low frequencies, and therefore the solution 

of practical problems is hardly applicable. Greatest practical importance are the 

following two methods.  

RC-chain 

The numerical analogue of the RC circuit (low pass filter of the 1st order). Given by 

the formula: yn+1= yn -yn/M+ fn+1·x, where M is the number of averaging points 

for the RC-chain. To determine the number of averaging points you can use the 

following formulas: M=Fs/(2Fb) or M=RC/t, where: Fs - sampling frequency, Fb 

is the cutoff frequency of the equivalent low-pass filter, the RC - constant of the RC-

chain, t is the sampling period. 

Since the bass effect, although much weaker, is in this case, it is necessary to use an 

HF filter. 

Vibro 

This method uses the RC-chain, but first performs high-frequency filtering in a 

given band of frequencies, which allows to adapt the algorithm to the conditions of 

vibrations measurement. Select the HPF                                                           cutoff 

frequency. To suppress the transition process, specify the number of points. 

Another problem is minimizing the error of the method. The greatest contribution 

make the low and high frequencies (see Fig. 9.25). 
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error 

RC-chain 

ideal integrator 

f 
n 

 
Fig. 9.25. The frequency response of an ideal integrator and an RC circuit 

The problem is solved by excluding from the analysis those areas which have the 

greatest errors 

- for low frequencies: if Fср=Fn/6, (where Fср - cut-off frequency; Fn is the lower 

frequency of the analyzed frequency range), the error will be <1,5%;  

- at high frequencies, it makes sense to use the results of integration up to a 

frequency of F=Fs/6where Fs is the sampling frequency.  

The third problem is related to the phase characteristics of the RC circuit that has a 

nonlinear dependence on frequency. In this case, it is necessary to introduce 

corrective phase-frequency function, which is experimentally determined.  

For example, Fs =2000 Hz and Fn =10Hz – Fср1.7 Hz; F333.3 Hz; number of 

averaging points M180 

For eliminating the constant component, check the box Centering. 

Calculation of the definite integral 

Calculation of the definite integral is produced in the double-cursor. Include area 

calculation in the advanced settings of the cursor (see Fig. 6.9). 

To calculate the definite integral within the specified limits the trapezium method is 

used: 

 2
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Normalization 

The signal normalization is performed in cases where it is necessary that the 

resultant values of the signal has changed within the specified limits. 

Set the minimum and maximum - limit values of the result 

 

Fig. 9.26. Normalization 

Usually the normalization is a multiplication of each value of the signal at a certain 

coefficient so that signal values do not exceed given values: 

0

max

 nor

i i

Y
Y Y

Y

 , where: Y0 is the given (required) the maximum value; Ymax – 

the maximum measured value; Yi – the current value of the signal. However, if you 

allow the shift then the signal will be shifted to fill entire range.  

Cross-correlation 

The cross-correlation function expresses the degree of statistical relationship 

between two signals based on their mutual displacement (delay parameter) in the 

time domain. Evaluation of cross-correlation function is calculated by the formula: 

0 0
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1
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
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 where:  {x°(j)}, {y°(j)} – centered realization; 

m – the maximum number of steps (Number of points). 

In practice it is more convenient to use a normalized cross-correlation: 
 xy(k) = Kxy(k)/(xy), 

 where x, y - average quadratic deviation of the relevant processes. 

Based on the Fourier transform and the convolution theorem we prove a relationship 

between a cross-correlation function Kxy(k) and the cross-spectrum Sxy(k): Kxy(k) = F
-

1
{ Sxy(k)}. 

 
Fig. 9.27. Cross-correlation 

The practical application 
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a) Define the time delays 

The cross correlation function Rab() of signals a(t) and b(t), recorded in the spread 

of the points A and B, has a peak whose position corresponds to the time delay , i.e. 

the time occupied by the propagation on the distance between the points A and B. 

Note: it is assumed that the signals are broadband, and the propagation is not dispersive in nature (the 
speed of propagation is not frequency dependent). When the dispersive nature of the propagation of the 

signal you need to either limit the portion of the frequency range, assuming it constant velocity or use the 

cross-spectrum phase to determine the time delay 
0 ( )f : 

0( ) 2 ( )AB f f f    

b) Identification of transfer paths 

In the presence of multipath signal propagation between points A and B the cross 

correlation function Rab() of signals a(t) and b(t) recorded at these points is 

contains the corresponding number of peaks. The peaks associated with individual 

pathways are in the positions the delay values n of which are correspond to the 

values held by transfer into separate tracks in n time. The amplitude of the 

mentioned peaks represent the relative quality of the respective paths. 

Note: it is assumed that the signals are broadband, and the propagation is not dispersive in nature (the 

speed of propagation is not frequency dependent). 

Often it is more appropriate instead of the real-type normalized autocorrelation 

function aa() and normalized cross-correlation functions ab() use envelopes 

(modules) of the corresponding analytical signals. The curve reflecting the module is 

smooth (maximums and minimums, often available in the initial characteristics, do 

not exist), so that is possible identification of peaks (due, for instance, reflections) 

and the correct definition of their amplitudes.  

c) Detection of noise masked signals 

In the case that the signals a(t) and b(t) contains a common signal s(t), masked with 

noise, i.e. if a(t)=s(t)+n(t) and b(t)=s(t)+m(t) and the components n(t) and m(t) are 

uncorrelated with each other, then the cross correlation function Rab(t) only contains 

information about the correlated component s(t) of signals a(t) and b(t) and has the 

form which is inherent to the autocorrelation function Rss(t) of signal s(t), which do 

not contain uncorrelated noise components n(t) and m(t). 

Autocorrelation 

The autocorrelation function is a special case of cross-correlation function. To 

compute the correlation function of the random sequence having the properties of 

stationarity and ergodicity, the following formula is used: 
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where:  {x°(j)} – centered realization; 

  m – the maximum number of steps (Number of points). 

In practice it is more convenient to use a normalized autocorrelation: 

x(k) = Kx(k)/Dx, where  Dx – is the variance. 

Based on the Fourier transform and the convolution theorem we prove a relationship 

between a cross-correlation function Kx(k) and the spectrum Sx(k): Kx(k) = F
-1

{ Sx(k)}. 

The practical application 

a) Detection of echoes (reflections) in the signals 

In the case that the signal a(t) contains the echo with 0 time delay, then the 

autocorrelation function Raa(t) of this signal has a peak =0 near the peak for =0. 

In addition, the value aa(0) displays the intensity of the echo. This applies to 

broadband signals with the width of the frequency band sufficient to ensure a narrow 

and separated from each other peaks of the autocorrelation function.  

b) Detection of periodic signals in the noise 

The autocorrelation function of a periodic signal is always a periodic function. 

Masking noise (noise background) is usually a random signal with the amplitude of 

the autocorrelation function decreases with increasing of time delay and after a 

certain time takes zero value. Therefore, the autocorrelation function can be using to 

detect a periodic signal after a time necessary for the noise disappearance. 

Note: 

1. The amplitude of the normalized autocorrelation function of the broadband random signal (noise) 

decreases rapidly to zero in accordance with the so-called law of uncertainty functions related via the 

Fourier transform. This law establishes a relationship between the bandwidth f of eigen spectrum GAA(f) 

and duration t of  corresponding autocorrelation function Raa(t)  in the form: ft 1. 

2. To detect the periodic signal containing several frequency components, it is often more advisable to use 
the eigen spectrum instead the autocorrelation function. On the basis of eigen spectrum can be defined as 

the frequencies as the amplitudes of the individual components which were masked by noise of periodic 

signal. However, if the amplitudes of these components are small in comparison with the level of the 
masking signal (noise background), it is necessary to perform analysis with increased frequency. 

Arithmetic operations 

To perform the simplest arithmetic operations: 

 check th Operation type,  

 select an operation from the drop-down list, 
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when choosing the operations on values of one signal enter the number in the Constant field
  

   
Fig. 9.28. Arithmetic operations 

Operations with buffers are performed over the pairs of selected signals values o. If 

the time scales of the signals does not coincides, then for each value of the first 

signal the interpolated at the same time value of the second signal is taken (linear 

interpolation). 

More complex operation on the values of signals can be performed by writing the 

expression.  

 check Expression,  

 enter arithmetic expression in the VBS (Visual Basic Script) syntax  or select from the 

drop down list of previously typed expression.  

The expression can contain numbers, symbols, signals, signs of arithmetic 

operations (+,-,*,/,^), parentheses and calls of mathematical functions. To denote the 

input signals are used Latin letters A (the first signal) and B (second signal). In 

addition, you can use the value of the variable I is the index of the next value (0 

corresponds to the beginning of the selected input range). 

The formula will be applied alternately to the values of the first input signal (A). If 

the second signal (B) is involved in expression, then for each first signal value will 

be taking the value of second signal corresponding to the same time. 

Examples of correct expressions:  

ATN(A) 

10*SIN(A) + 3.33*COS(B) 

(0.1*B*B - 0.7*A + 17)/(A+12.345) 

(A-20)^3+(A-7)^2+A-0.15 

List of mathematical functions: 

ABS - norm of number, 

ATN - arc tan, 

COS - cosine, 

EXP - exponent, 

LOG - natural logarithm, 

SIN - sine, 

SQR - square root, 

TAN – tangent 
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Probability density function 

Select the type of assessment: frequency distribution, probability distribution or 

expectancy of hitting. 

Select evaluation method and specify the number of points. 

   
Fig. 9.29. Probability density function 

Kernel density estimate 

Assessment of PDF by the method of Kernel density estimate using the quadratic 

kernel function is given by the formula  

 2
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( ) exp
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m k
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x x
P x

N h h

 
   

  


 

where:  {Xk }- source signal; 

  N – length of source signal;  

h = N
-1/5

;  

    - the standard deviation of the process; 

  M - the number of assessment points. 

Histogram 

The basis for building the histograms is the so-called "statistical series": the entire 

range of values of the random variable X is divided into intervals or "ranks" (the 

number of intervals is specified in number of points field); counts the number of 

values of mi attributable to each i-th rank (if the value is exactly on the border of two 

ranks, then 0.5 is added to the numbers mi of the category), the resulting number is 

divided by the total number of observations n, and thus find the frequency 

corresponding to the i-th rank: p*
i=mi /n. 

The histogram is constructed as follows. On the x-axis is laid the ranks, on each rank 

is constructed a rectangle whose area is equal to the frequency of this rank. To 

construct the histogram we need the frequency of each category divide by its length 

and take the resulting number as the height of the rectangle. With the increase of the 

source data and, accordingly, the number of digits, the histogram will approximate 

to the graph of the density function of the variable X. 
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Note: In practice, it is recommended to have in each rank not less than 5-10 observations. If the number 

of observations in the individual rank is small (1-2), these ranks are combined. 

Centering 

Centering is performed with the purpose of the cutoff constant component of the 

signal:  where  is the mathematical expectation. 

 

Probability characteristics 

For a sequence of samples {xn, n=0,...N-1} the characteristics are calculated 

according to the formulas given below. 

The mathematical expectation  
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Dispersion 

Characterizes the scattering of the random value around its mathematical 

expectation value.  
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Standard deviation 

Characterized dispersion, but is measured in the same units as the random value:

  

x xD
 

Root-mean-square value 

Characterizes the dispersion, but has the dimension of a random variable:  
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Skewness 

Is used to measure the asymmetry of the distribution. If the distribution is 

symmetrical around its mathematical expectation value, then the skewness is equal 

to 0. 
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Amplitude 

Maximum (by module) deviation from the mathematical expectation.  
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max | |х n xA x m   

Double amplitude 

The difference between the maximum and minimum values. 

| max( ) min( ) |x n nP x x   

Kurtosis 

Characterizes the steepness (peakedness or flattoppedness) of the distribution..  
1
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Note: The kurtosis value for normal distribution is equal to 0. Curves that are more peaked as compared 

to the normal distribution curve, have positive kurtosis values. Curves that have more flat tops than the 

normal distribution curve, have negative kurtosis values. 

Estimations of mathematical expectation, dispersion, RMS, skewness, and kurtosis 

are logged. 

 
Fig. 9.30. Probability characteristics 

For graph the estimation of mathematical expectation (MO), standard deviation (SD) 

and root mean square values (RMS) for the visible range of the signal are calculated. 

Turn on the display of ratings on the settings page of the legend. see Fig. 5.15. 
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Resampling 

  
Fig. 9.31. Resampling 

Source Frequency, Source Step, Source begin – sampling parameters of the 

source signal. 

New frequency, new step – sampling parameters of a new signal. 

Approximation type: linear interpolation, 2nd order polynomial, cubic local splines 

or approximation by LPF. 

Keep type of data – the resulting signal has the same format (e.g., two-byte signed 

integer) of the data as the source signal. In such cases at the frequency increase some 

"shelves" can be observed due to limited resolution of the source data format. 

Changing the sampling rate of the signal, we must not forget the theorem Kotelnikov 

– Nyquist – Whittaker – Shannon from which it follows that the signal with a 

sampling frequency Fs cannot have harmonics equal to or above Fs/2, i.e., 

Fmax<Fs/2 

Therefore, when resampling to a lower frequency, you need to perform low-pass 

filtering of the original signal. If this is not done, the higher harmonics of the 

original signal will be in the new signal in the form of noise, distorting all 

subsequent processing. In practice, the value of the cutoff frequency reduces to 

approximately 75-85% of Fmax. 
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Parametric graph 

      
Fig.9.32. Parametric and polar graph 

The algorithm allows creating graphs of dependency of a parameter from another 

one and graphs in polar coordinates. 

Select Parametric result if the signals along X and Y axes bound to the same time 

scale. In this case, the signal along the X axis is taken as the base for the new signal. 

Result signal values along Y axis will have matching time with values of signal 

along Y axis. The sampling rate of source signals may be of different. 

Select Y1(Y2) if the signals bound by value indices (usually these are the signals of 

equal sampling rate). 

To plot a graph in polar coordinates select Polar result and select as sources module 

(amplitude) signal and phase (in degrees or radians) signal. Start counting direction 

and the reference direction is shown on the graph 9.32. Change them if required. 

Select "as projections," to get the two signals of the polar graph projections to axis X 

and Y. 

Instant spectrum 

Using the menu item Windows→Instant spectrum a specialized page for the 

spectrum calculation "on the fly" can be created (Fig. 9.33). This page contains two 

graphs: the source signal is to be added to the first graph, and the signal spectrum is 

shown by the lower graph. The signals can be added to (deleted from) the top graph 

only. 

The spectrum is calculated in the current range and recalculated when the range is 

changed. If this range is less than the portion length specified in the algorithm 

settings, the calculation is not performed and spectrum is not represented. If the 

cursor mode is enabled, the spectrum is calculated by one portion selected by the 
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cursor position (the cursor pointing at the portion center) irrespective of the current 

range. 

 
Fig.9.33. Instant spectrum page 

In order to change the spectrum settings open the page context menu of the instant 

spectrum (click the right mouse button) and select the Algorithm settings item (see 

Fig. 9. 6). 

In the same way it is possible to investigate a probability of the hit, the density of 

probability and DDP for a visible part of a signal (Fig. 9.34). Choose the 

Autospectrum for switching back. 

 
Fig.9.34. The page of a quick calculation DDP 
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Wavelet analysis 

Wavelet - transformation of signals is one of sorts of spectral analysis, such as 

classical Fourier transform. The feature of a wavelet t-transformation is a possibility 

of the analysis of a signal with localization simultaneously on time and on a 

frequency.  

Wavelet s are the generalized name of mathematical functions sets of a definite form 

which are local in time and on a frequency and in which all functions are result from 

one base (generating) by means of its shifts and expansions on time axis..  

Wavelet transform is a method convolution of the original signal and wavlet 

functions. Wavelet function is calculated by the formula:  

 

where fs is the sampling frequency of the original signal, m is the parameter of the 

wavelet, S is the wavelet scale (inversely proportional to frequency): 
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Fig.9.35. Source signal and wavelet transform for m = 6 and m = 12 

 

 
Fig.9.36. "Morlet" wavelet,  m = 6 and m = 12 

The size of the wavelet window values is calculated as: N = 8*S*fs 

The factor 8 is selected from the condition that the value of t/s = (i - N/2)/(S fs) 

varied from -4 to 4. 

To determine the value of W(n,s), the values of the original signal in the range of 

indices (n-N/2, n+N/2) are multiplied to the corresponding values wavetoy function 

of scale S and summed (values outside the range of the signal is zero). For the 

calculation the following values of W(n+1,s) the window is shifted by a 

predetermined number of values (set in settings of the algorithm, the default value is 

1). After passing along the signal the calculation is repeated for the next value of S.  
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Fig.9.37. Wavelet settings 

Type – type of a calculated characteristic (amplitude, amplitude & phase, real & 

imaginary). 

Wavelet function – type of a wavelet function, only the wavelet of the type "Morlet" 

is available in the current version. 

Wavelet parameter - a quantity defining a type of a wavelet function. larger values 

correspond to a larger localization on a frequency, smaller – on time.  

Window offset - offset of a window during the calculation of the next portion. A 

value larger than one allows diminishing a volume of calculations at the expense of 

a smaller resolution on time of the resulting signal. 

Frequency range – a range of frequencies in which  wavelet  is carried out, and a 

step of a change of frequencies. The smaller step the resolution on time is better but 

the volume of calculations is greater. 

 

Recommended reading 
1. Bendat, J., Pearsall, A. Measurement and analysis of random processes. - 

Moscow: Mir, 1974. 

2. Randall, R. B. Frequency analysis. Printed by: K. Larsen and Son, A/O, DK-2600 

Glostrup, Denmark, August 1989. 

3. Herlufsen, H. Two-channel FFT-based analysis, Part 1 and Part 2. Bruel&Kjaer. 

Technical Review, 1984. 

4. Antonew, A. Digital filters: analysis and design, Moscow: Radio i svyaz, 1983. 

5. Randall, R.B. & Hee, J.: "Cepstrum Analysis", B&K Technical Review, No.3, 

1981. 

6. Bradshaw, P. & Randall, R.B. Early Detection and Diagnosis of Machine Faults 

on the Trans Alaska Pipeline, MSA-Session, ASME Conf., Dearborn MI, Sept. 

1983, pp.7-17 
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Section 10. Analysis of dynamic processes and 
vibrations 

WinPOS allows to perform the analysis of non-stationary dynamic processes, 

including the vibrations. The tools from the Vibration analysis menu are used in 

such applications as: 

 Multi-channel processing of dynamic processes,  

 Rotating machines vibration analysis (on stationary regimes),  

 Calculations of parameter in the start/run-down modes,  

 Processing of strain measurement data,  

 Processing of audio signals,  

 Processing of transient pressure and noise.  

 Shock analysis, shock spectra calculation 

 

The input data file obtained by the measurements contains the signals from different 

sensors (accelerometers, linear variable differential transformers, proximity probes, 

microphones, strain sensors, resistance temperature detectors, thermocouples, etc.). 

The vibration analysis algorithms allow to plot selected characteristics of these 

signals as a function of time or study the signals characteristics in association with 

the tachosignals. Such analysis is applied in the vibration inspections of the 

equipment with rotating parts, e.g., turbines. The same characteristics can be 

documented as a vibration report of a product, i.e., as files or special tables (See the 

section Vibration survey below).  

To access the vibration analysis algorithms select the Vibration analysis item of the 

main menu (See Fig. 3.3).  

Calculated characteristics 

 Tacho, 

 Amplitude/RMS/peak-to-peak value and phase of harmonics,  

 Amplitude/RMS/amplitude-phase response,  

 Amplitude/RMS/peak-to-peak value,  

 Mathematical expectation,  

 Low frequency vibration,  

 RMS value in the band,  

 Spectrum characteristics, 

 Shock, shock spectrum, 

 Tracking filter. 
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Calculations 

All the settings window are divided into two parts (Fig. 10.1). The top part contains 

three functional areas – the group of processing options, the window containing the 

selected signals list, and the control group to select a file for processing and specify 

the file to save the results. The lower part of the window contain a graph for the 

results preview. 

 
Fig. 10.1. Settings window on the example of the Campbell diagram  

Calculation. 

1. Select the source signals in the "List of signals" 

Check the signals involved in the calculation. 

The folder selected in the Signals tree already been added to the list. To add 

other folders, click "Add" and "Delete" in the right part of the window.  

2. Specify the tacho 
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The rpm signal (or tacho) shows the change of the rotational speed during the 

test and is required for most algorithms. 

 If you have signal from tachometer, click the right mouse button on its 

name in the list of signals. Select the item "Tacho signal". 

 If you have previously calculated tacho, select the "RPM Signal". 

3. If required, select the time interval 

Move the cursor in the preview window or specify the exact values in the field 

"Range".  

4. Tune the settings and click «Execute» 

For most algorithms, the calculation process of each signal is displayed on the chart 

at the bottom of the window. The General course of the calculation displays a 

progress indicator at the bottom right. To abort the calculation at any time, press 

<Esc>.  

The processing result can be found in the "Results" folder of the Signals tree under 

the name specified in the Result field. Change the folder name if required. Also the 

calculation result for the first signal is automatically added to graph. 

Calculation details 

The selected time range of the signal is divided into an integer number of intervals 

with equal length, defined either by the user or by the tachosignal. Then the user 

desired characteristic is calculated by the array of points corresponding to the 

specified length, and the time function with a resolution given by d

s

N
T

F
 is 

produced, where: Fs – the source signal sampling rate; N – number of points in the 

array. The first calculated point is associated with the start of the range (Tn), the next 

one is associated with T= Tn+ Td, etc. The general formula is: Ti=Tn+Td ·  i. Note, 

after such conversion the resulting signal has the sampling rate of 
s

d
F

F
N

. 

The calculated characteristic can be represented as  ( ) F( X )i iY T , where: i - the 

number of interval starting from zero, Ti - the time matching i interval, Y- calculated 

signal characteristic, [X]i - array of points of i interval. 

At change of time resolution of the signal characteristic the proportional decrease of 

length of the processed intervals should be considered. This effect causes the change 

of the processed signal bandwidth.  

Amplitude and phase frequency characteristics. The power (amplitude, root-

mean square value, or peak-to-peak value) of the selected harmonic element is 

defined in the array of points by the cosine-sine conversion, which corresponds to 
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passing of the resulting signal through narrow-band LPF with automatically 

adjustable central frequency. The bandwidth of the analyzing filter is represented as 

 
sF

f
N

, where: Fs – the source signal sampling rate; N – number of points in the 

array (to be set at the algorithm customization).  

The phase is defined as a difference of arguments of the selected harmonic 

component and imaginary cosine function, the peak of positive semi period of which 

corresponds to the tachosignal mark. Hence, the tachosignal passing over a certain 

threshold is associated with the cosine wave with a zero phase offset.  

Harmonic analysis is performed by the discrete Fourier transform to calculate the 

amplitude and phase at the pre-defined frequency. This method is equal to 

application of the bandpass non-recursive filter with the central frequency being 

multiple of the tachofrequency fi and the filter frequency bandwidth f: 

fi=ifT , where:  i - harmonic number (may be fractional); 

  fT – tacho-frequency; 

  fi - central frequency of the pass band filter; 

pass band filter width: 

f=(Fsk%
 )/100 k

ЭШП , where: Fs  - sampling frequency; 

k
ENB - equivalent noise band (see the Appendix B. 

Processing algorithm application guidelines for 

details); 

k
%

 - adjustment coefficient of the filter pass band (% of 

the pass band filter in respect to the signal sampling 

frequency). 
 

Note: The Fourier discrete transform serve as a basis only. In order to make the algorithm closer to the 
calculated one, the additional research works have been carried out. By the results of such works some 

fine issues about the algorithm (when the standard technique provided an instable practical 

implementation) were considered and improved. 
In order to verify the calculated results in respect to the harmonic analysis algorithms contained in the 

WinPOS package, special Bruel&Kjaer equipment was used. The identity of results was proved by the 

conducted tests.  

 

 

Sequence processing (trends) 

This group of algorithms allows the time representation of the signal instantaneous 

 

If sampling frequencies of the source signals are differ, then the resampling to a greater 
frequency is carried out before the calculation.  This leads to the additional error, 
depending on a difference between frequencies. On the average, the size of an error is 
within the limits of 1 %. 
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characteristics (Fig. 10.2). 

 
Fig. 10.2. Sequence processing (trends) 

Set the Block size (counts or seconds) and choose Operation type:  

 the mean (expectation),  

 RMS or standard deviation (standard deviation or value),  

 amplitude,  

 magnitude (double amplitude), 

 peak factor. 

If the “Equivalent amplitude” option is selected then RMS calculated first, and then 

the result is transformed to amplitude or peak-peak value. The “Offset in Points” 

option used with nonuniform X axis for specifying offset in number of samples, 

instead of time in seconds. 

Band RMS 

The calculation of the RMS in the band shows the time behavior of the signal power 

per a predetermined frequency range. The settings are divided into two pages - the 

settings of the algorithm (Fig. 10.3) and calculation settings Tahoe-features (Fig. 

10.4). 
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Fig. 10.3. Band RMS settings 

Number of FFT points – the number of points on which the spectrum calculated  

Integration – result as vibration acceleration, velocity or displacement. 

Band calculating – boundaries of the band are set or percentage of selected 

harmonics or in Hertz. 

Setting bands – from the bottom up to the top, but not Min and not wider Max if 

specified. In the Upper field may be set to "-1", as an upper bound. In this case the 

range will be made of the maximum frequency value. 

Setting the x-axis Units. – choose the units for the x-axis: seconds, Hertz or rpm. 

Min. step – enable decimation with a given minimal step and the choice of method 

of approximation results: the average or maximum value. 

Configure axes – turning on logarithmic scales. 

Tacho 

Function for calculation of the rpm signal (revs) signal t (Fig. 10.4). 
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Fig. 10.4. RPM calculation (tacho) and frequencies table 

Units of measurement – the dimension count features: Hz frequency, rpm./min – 

rpm. 

Hi-Level and Lo- Level - accordingly positive and negative levels. The consecutive 

transition of a signal through these levels is considered as a front of a signal. Such 

algorithm of the definition of the signal front considerably raises a noise stability of 

the algorithm. 

Values –the units in which are set a levels - absolute or relative (percent of 

maximum amplitude). It is recommended to set the levels in relative units 

(percentage), especially if the amplitude of tacho significantly change with time. In 

this case, absolute values will be calculated for each block separately. 

Edge (Positive or Negative) - defines the tachosignal front, by from which the phase 

is will be calculated. 

Multiplier – the coefficient by which the calculated value of the frequency of the 

tachosignal is multiplied. It is necessary to perform such operation in the cases, 

when the rotation frequency has been measured via some reducer but not on the 

inspected shaft directly. Such operation must be performed in the cases, when the 

rotation frequency has been measured via some reducer but not on the inspected 

shaft directly. Then the rotation frequency of the inspected equipment is equals to 

the product of the reduction coefficient and the measured rotation frequencyspeed of 

the secondary shaft. 

Block size  - calculation may be specified in the counts or in seconds. The block size 

should be chosen so that it have at least several full periods on the entire range of 

frequencies. If you selected too small block, then in some areas, the algorithm will 
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not be able to calculate the frequency tacho. However, you should not choose too 

large a block size as this will be a loss of information due to averaging of a large 

number of values. In other words, a large portion of data provides a more accurate 

frequency measurement by averaging, but lost the ability to track fast frequency 

changes. 

To combat this phenomenon, you can set the number of revolutions, which will 

determine the size of the portions. This can be a single value – the number of 

periods, or table, which gives the possibility to set the portion size as a function of 

frequency. For table settings, click "Change". In the table columns by double-

clicking the mouse to determine the frequency bands and the number of turns on the 

portion of data in each range. 

Max. step - The maximum  permissible difference between two successive 

readingthe maximum tolerable difference of two successive samples. If this value is 

exceeded, a random peak has occurred. This option is used if Smoothing is enabled. 

Filtering - enables a filtering of the source signal throughout width of impulses. In 

some cases, the presence of defects in the rotor leads to the fact that in addition to 

"regular" signal of the rpm sensor on tachosignal is jammed preventing normal 

operation of the processing program. The essential difference of these interferences 

is their much smaller duration. Temporal filtering removes from tachosignal signals, 

the duration of which is less than the established in the Width of the pulse. values (in 

percentage of the calculated maximum pulse speed sensor).  

Smoothing - an additional amplitude filtering of the tachosignal is performed. The 

purpose of such filtering is to exclude random amplitude peaks of the tachosignal. 

Several successive values (frame) are analyzed, and if within such frame the signal 

amplitude is above the pre-set value (tolerable increase rate, or peak – set in the 

Max.step field), the linear interpolation of the frame values is performed. 

Calculation of amplitude-phase-frequency response 

This group of algorithms allows representation of the signal harmonics as a function 

of time of frequency. The settings are divided into two pages – the settings of the 

algorithm (Fig. 10.5) and tacho calculation settings (Fig. 10.4). 
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Fig. 10.5. Calculation of amplitude-phase-frequency response 

Operation – calculated characteristic: 

 amplitude (Amplitude of harmonics), the phase (Phase), amplitude and phase 

(Amplitude/Phase) of the selected harmonics;  

 frequency change – tacho; 

 amplitude from frequency - the effective value (RMS), amplitude, or magnitude of 

the common signal level (for all harmonics), the phase of the frequency; 

Harmonics - an ordinal number of the harmonic. To the right of this field it is 

possible to specify the type of the result: RMS, A – the amplitude, 2*A – the peak-

to-peak value; 

Integration – result as vibration acceleration, velocity or displacement. 

Window - type of a weighting window: Rectangular, Triangular, Hanning, 

Blackman. 

Setting the X-axis: Units of measurement. – the dimension of the calculated 

characteristics on the X-axis: Hz is the frequency, in seconds. – time, rpm - the revs. 

Min. step (only for Hz or rpm.) - defines the step which will change the frequency. If 

multiple values falling in one range, the resulting value will be taken or the average 

or maximum (depending on the mode chosen in the box to the right). Frequency 

range - if selected, the minimum and maximum frequencies of tacho within which 

will be calculated, otherwise full range. 
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Calculation by rpm - allows you to select variations of the algorithm that is used to 

calculate the frequency response. In the general case, it is recommended to set this 

option in the calculations according to the data taken with the rotating units; the 

analysis of vibration processes, the best result can be obtained by removing the 

option. 

Sort – if checkbox is checked, the obtained data are sorted by increase of the 

calculated frequency. The sorting can be required when the frequency of the 

tachosignal changed not monotonously. 

Monotonous phase - allows to the phase to change beyond out of the range of 0-360 

degrees. 

Configure axes - displays the axes X and Y in the resulting graphs in logarithmic 

scale. 

Phase correction - the value from which the phase starts to change. 

 

Define the reference signal if required: click with the right mouse button on its name 

in the list of signals, select the "reference signal". The frequency response of the 

source signal is divided into frequency response of the reference signal, and the 

phase is considered as the phase difference between the reference signal and the 

source. The same signal may be simultaneously reference and tacho. The influence 

of the reference signal to the result of the algorithm is shown in figure 10.6. 

 

Note, if the calculated graph contains negative frequency (time) values than it means a 
failure of the tachosignal, i.e.,.  there was no a crossing through a certain threshold or no 
crossing of a certain threshold took place or the tachosignal dropped to zero. In this case 
the settings of the tachosignal analysis should be verified. 
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Fig. 10.6. Reference signal and сalculation of amplitude-phase-frequency response 

If the reference signal is not set when calculating the phase response the phase is 

measured from the edge of tachosignal (Positive or Negative) (Fig. 10.7). 

 

 
Fig. 10.7. Graphical view of features of calculation of the phase response 

Vibration survey 

This set of algorithms is intended for batch calculation of vibration characteristics 

and generation of the reports according to industrial standards. Select menu 

command Vibration analysis→Vibration survey. A window will open, shown in 

Fig. 10.10. 
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The list of calculated characteristics and their symbols are provided in the table 

below: 

Characteristic Symbol 

Tacho n / f 

Harmonic RMS value e(f) 

Harmonic amplitude a(f) 

Harmonic peak-to-peak value r(f) 

Harmonic phase F(f) 

Harmonic RMS value vs. frequency  es(f) 

Amplitude vs. frequency as(f) 

Peak-to-peak value (Amplitude*2) vs. frequency rs(f) 

RMS value e 

Amplitude a 

Peak-to-peak value r 

Mathematical Expectation (Mean Value) m 

LFV (Low frequency vibration) h / fh 

Band RMS value  f suffix 

Spectrum analysis F / K(f) 

In the Vibration survey mode the above estimations are calculated separately for 

each revolution of the rotating parts with the signal interpolation between the 

samples. The tachosignal is used to divide the whole signal realization into 

revolutions.  

In the energy industry the table representation (Microsoft Excel, XLS format) of 

vibration characteristics is used for the statistic analysis. See Fig. 10.8. In the 

aviation industry, as a rule, the processing results have to be represented in text 

format, e.g., RTF. See Fig. 10.9. 

Consequently, two operation modes of the vibration survey algorithms are provided:  

 Placement of results into the Signals tree (WinPOS mode);  

 Placement of results into the Excel tables (Excel mode).  

To switch in Excel mode click Excel and select table and page of xls file. When 

switching to another mode the calculation parameters settings.  
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Fig. 10.8. Excel table with the vibration parameters 

 

 

 
Fig. 10.9. RTF table with the vibration parameters 
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WinPOS Mode 

 
Fig.10.10. Vibration survey settings window 

In the list on the left all signals of the selected file are shown. Mark channels to be 

processed. To mark all channels use the Select all option. The second column of the 

list contains symbolic names of characteristics calculated for the respective 

channels. The window at the center shows the characteristics prepared for use in the 

calculations. New characteristics are added and the exiting characteristics are 

removed by the Add and Remove buttons located below this list. The characteristics 

calculated for the selected channel are marked by ticks. When the characteristic is 

selected in the list, the options of this characteristic are shown on the right. 

Calculation settings 

Common for all pages (Fig. 10.11) Name field allows you to change the default 

name of assessments. Characetistic - defines calculated characteristic. Number of 

FFT Points - the number of points on which the calculated spectrum. Integration - 

the result: acceleration, velocity or displacement.  Tacho signal - the name of the 

rotation signal.  
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 Fig.10.11. Calculation settings 

Tacho 

Tacho treatment settings described above in paragraph “Tacho”. 

Amplitude and phase of harmonic 

Harmonic - harmonic order (required only for amplitude and a phase of a 

harmonic). X axis - units of the characteristic calculated for X axis (sec/Hz/RPM). 

Passband width - the passband width of the analyzing filter in Hz. This value is set 

by the tacho settings. Block size - the block size for the calculation. This value is set 

by the tacho settings. Frequency step – step of frequency change. If several values 

are found in one range, the average or the maximum resulting value shall be used 

(depending upon the mode selected in the menu on the right). This value is set by the 

tacho settings. Window - type of the weighting window. Sort - data sorting by the X 

axis. Monotonous phase - allows the phase changing beyond the range of 0-360 

degrees. Used for the phase calculations only. 

RMS value, amplitude and peak-to-peek value of source signal as 

function of tachofrequency 

The settings are similar to the harmonic amplitude settings. Only the fields Name, 

Tachosignal, X axis, Integration and Sorting are enabled. 

RMS value, amplitude, peak-to-peak value and Mathematical 
Expectation 

Amplitude and phase of harmonic 

 
Tacho 

 
RMS, Ampl., peak-peak, ME 

 

Band RMS 

 
LFV 

 
Spectral analysis 
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In the drop-down list next to the Name, select the desired type of assessment. Block 

size - the block size for the calculation (in samples or seconds). If the Equivalent 

amplitude option is selected then RMS calculated first, and then the result is 

transformed to amplitude or peak-peak value. 

LFV 

Cutoff frequency - the frequency dividing high and low frequency ranges. 

Band RMS 

Low frequency and High frequency – frequency range limits. 

After calculations complete the result window (Fig. 10.12) is automatically opened. 

Besides, all calculation results are placed as signals into the Signals tree to the folder 

called by the processed file name with addition of the suffix «_VS» 

Fig. 10.12. Results of vibration survey calculations 

Where: 1 – toolbar; 2 – characteristic graphs; 3 – characteristic table (two modes); 4 – list of 
regimes; 5 – list of labels. 

After finishing calculations and opening the result window the first two 

characteristics are displayed in the graphs (2) by default. Further the number of 
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graphs and the represented signals can be modified (by the  button on the 

toolbar) by selection of the active graph and marking the desired signals or 

characteristics with a tick in the characteristic table (3). 

In turn, the characteristic table has two views switching by the  button on the 

toolbar (1). The first view is shown in Fig. 10.11. The first column contains the 

names of the source signals, the second - the calculated characteristics, and the third 

- the characteristic values at the point defined by the cursor position in the active 

graph. In the next columns the characteristic values at the mark points are represent-

ted. The table contains the markers within the selected signal mode range only.  

If the source signals contain signal modes they will be listed in the window (4), 

otherwise, the list has only "Entire signal" line. Under the list of signal modes the 

list of marks (5) is provided. The list contains all marks set in the selected signal 

mode range; the labels outside this range are not shown. At the selection of the label 

the cursor of all graphs shall be moved to the label, and the X axis range of the graph 

is changed when necessary to display the selected label. The labels are added or 

removed by the toolbar  and  buttons. 

The generated report can be saved as a table in an RTF format file.  

The purpose of the result window toolbar buttons is described below.  

 

General view - viewing only the signal graph and processing results. 

Operations with the input data are possible. The graph view cannot be 

modified. 

 

Scrolling, the graph shifting by both axis (X and Y) simultaneously. To make 

the shift press and hold the left mouse button in the graph window, and then 

move the mouse cursor to the desired direction. The signal graph is shifted 

with the cursor. 

 

Zooming by both axis (X and Y) simultaneously. To zoom in the graph move 

the cursor to the start/end of the area to be zoomed. Press and hold the left 

mouse button and move the cursor to the desired direction, to the start/end of 

the area to be zoomed. The rectangular frame of the zoomed area will be 

shown by dotted line in the graph window. At release of the left mouse button 

the interval will be zoomed in the whole viewing window. 

 Zooming by X axis. 

 Zooming by Y axis. 

 Cursor mode (vertical and horizontal lines in the graph window). 

 Return to the previous axis range of the graph axis.  
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 Vertical lines from the signal values to X axis.  

 

Set the scale by the X axis to display all measured points from the maximum to 

the minimum value in the viewing window (normalization by X). 

 

Set the scale by the Y axis to display all measured points from the maximum to 

the minimum value in the viewing window (normalization by Y).  

 Customization. Allows setting the graph representation parameters.  

 Set the number of graphs in the window.  

 Switch the characteristic table views.  

 
Synchronization of cursors. The button is active when the cursor mode is 

enabled and the number of graphs on the page more than one.  

 Set the mark at one or all signals at the cursor position.  

 Remove the mark selected from the list of marks.  

 Save the characteristic table to an RTF format file.  

 
Print graphs.  

The second view of characteristic table is shown below. 

 
Fig. 10.13. Characteristic table 

In this view the source channels are shown in columns, and the characteristics set in 

the Vibration Report settings window are shown in rows. The table cells contain the 

characteristic values calculated by the respective channels, at the position of selected 

label or cursor in the active graph (if this position does not match the selected mark). 

If the particular characteristic has not been calculated by all channels, the respective 

table cells are left empty. 

In order to obtain the final report in RTF format file (an example is shown in Fig. 

10.9), the labels should be set while viewing of the calculation results (see Fig. 

10.12). 

After the table formatting is completed, the report can be saved in an RTF format 

file. Click the  button on the toolbar and specify the filename. Further the report 

file can be processed by Microsoft Word or WordPad, or imported to the user's 

applications. 
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Excel Mode 

Vibration survey allows to calculate the vibration parameters using the pre-set 

templates and to store the results to the Excel file. 

To access this option click Excel button at the right top 

corner of the Vibration Report settings window. Select 

Open table menu item to open an XLS format file. A 

standard open file dialog appears. 

  

After the table is selected, the window in which all pages of the given file are 

enumerated opens (Fig. 10.14). 

Select the page containing the required template and click OK. 

 
Fig. 10.14. Page selection window 

Attention! The selected table is only a template for report generation. All settings 

required for calculations are taken from the .INI file (the name of this file matches 

with the name of selected XLS format file), that must be saved in the same folder 

with the XLS format file. 

After that the settings are read and the characteristic list is populated. If the 

processed file is already opened, the characteristics are automatically linked to the 

channels using the following criterion: if the channel with this name has the 

characteristics list in the settings file, then only the specified characteristics are set to 

this channel. Otherwise, all the characteristics except tacho are linked to the channel. 

In the “Result” field the file name and the page for the calculation results are 

specified. 

If necessary, the user can change any settings before calculations. The list of 

characteristics and their options can be saved in the settings file by selection of the 

«Save settings» items from the above menu.  



WinPOS. User’s Guide 

 
158 

The calculation progress is displayed on the graph in the lower part of the Vibration 

Report settings window. After the calculation is completed, the generated table is 

automatically opened by Microsoft Excel (if installed). 

Sample templates (Excel tables): 

Description of the structure and an example of a Vibration survey settings file is 

given in Appendix A File Formats. 
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Campbell diagram 

The Campbell diagram shows how the change of the characteristic frequency 

components with the change of the rotational speed. The amplitude is displayed by 

color or height of the associated bar or the diameter of the circle. Campbell diagram 

applied to the analysis of dynamic processes, mainly on non-stationary modes. It the 

most useful for the detection of self-excitation oscillation. 

The settings are divided into two pages – the settings of the algorithm (Fig. 10.15) 

and tacho calculation settings (Fig. 10.4). 

 
Fig. 10.15. Campbell diagram calculation window  
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Frequency step - the step of the tachofrequency changing. If several values are 

found in the one range, then the averaged or maximum value is taken as a resulting 

one (depending upon the mode selected in the drop-down list to the right of the 

field). 

Tachofrequency range - the minimum and maximum values of the tachofrequency. 

Block size - the block size (in samples) to perform the calculations. To the right of 

this field displayed the resolution of the spectrum.  

Block offset – specifies the offset of the next block in the counts. 

Values – The type of calculated values - RMS/Amplitude/Peak-to-peak. 

Characteristic – defines the type of the spectrum. Possible values: Amplitude 

spectrum, power spectrum, power density spectrum and the energy density spectrum  

Window – weighting window function for spectrum calculation.  

Integration – vibration acceleration, velocity or displacement as result. 

For each specified signal is the following sequence of actions performed: 

1) The signal is divided into blocks, the size and offset of which was specified in 

settings. 

2) For the next block determined the tacho frequency corresponding to the center of 

the block. If the value is out of specified RPM range, the block is discarded and not 

included in calculations. 

3) The amplitude spectrum is calculated for data block and stored with the 

respective tacho frequency value. Steps 2 and 3 are repeated for all blocks 

4) From the obtained spectra the 3D signal is created, where the spectra are located 

along the Z-axis and the tacho (RPM) – along the X-axis. If several spectra falls into 

one frequency range of tacho, they are averaged; the frequency step and the way of 

averaging are configurable. 

Displaying of results 

When the calculation is finished a dialog box (Fig. 10.16) is opened, where you can 

specify the desired type of graph: three-dimensional graph, the graph top-down or 

classic Campbell diagram. 
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 Fig. 10.16. Graph type selection 

Fig. 10.17 shows the different types of the same graph. 

  Fig. 10.17. Campbell diagram types 

Fig. 10.18 depicts the graph window of the Campbell diagram, top view. The upper 

graph displays a chart directly in the form that was specified in the previous step. If 

necessary, you can change it by right-click on the chart and selecting "Main view" 

from the context menu. 
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 Fig. 10.18. Campbell diagram window 

On the second chart shown the frequency response for the selected harmonic 

(harmonic number displayed in the header). To select the harmonic activate the 

order cursor (the button  on the control panel, select the appropriate item from 

the drop-down menu). Move the cursor using the mouse or the buttons <Up> and 

<Down> on the keyboard. The number of the selected harmonic is also shown 

slightly to the right of the cursor. 



Section 10. Vibration analysis 

 
163 

The following two graphs shows the cross section for RPM (X-axis) and frequency 

(Z-axis), respectively. Display of each section can be switched using the 

"Projection" in the context menu. 

Main view settings 

Settings for 3D-graphics and the top view are described in the 3D-graph chapter. 

The following describes the settings related to classic Cambell diagram. 

Scale - allows you to configure the 

correspondence between the signal value 

and size of its marker on the graph. The 

size is specified in screen pixels,  the 

value of the signal in absolute values or in 

percent. When displayed in the form of 

points these fields are not available and do not affect the 

size of the points. 

Show scale - shows or hides the scale of the graph. 

Dead band - sets the lower display limit values 

Graph view - the way of rendering the values as dots, 

vertical lines, or circles.. 

Y-range - allows you to enable or disable the auto-

detection and set the Y range manually. 

Order lines - sets the frequency of the display order lines and their range 

Classical Campbell diagram can be displayed in three ways - in the form of dots, 

vertical lines, or circles. The height of the lines and the diameter of the circles 

depends on the value of the signal (RMS amplitude or magnitude) at a given point. 

This dependence is set by the Zoom group in the settings. If you select the Value in 

percent, 100% is taken as the maximum value in the signal. 
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 Fig. 10.19. Views of Campbell diagram 

The zoom can be changed by dragging the zoom scale box top 

with the mouse. 

Using the Dead zone parameter you can filter data, the value of 

which in relative units is less than a specified threshold. The 

following picture shows the graphs with different values of dead zone. 

 Fig. 10.20. The influence of the "dead zone" on the representation of the result 
 

The range of the X axis matches that of tachocharacteristic. If the automatic Y range 

detection is enabled, the range is set from zero to the maximum value of the 

spectrum frequency of all signals represented by the diagram. The automatic 

detection of the range by Y can be disabled, and the required values can be set 

manually. Except for the grid by the axes X and Y, the diagram contains an 

additional grid showing the multiple harmonics (orders). The order of the first and 

the last lines as well as the step between the lines can be set. 
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Fig. 10.21. Example of amplitude-frequency characteristic calculation 

The frequency response is calculated using the RMS strip, the width of which is 

specified in the block Boundaries. Depending on the method of calculation of the 

boundaries, the range is calculated or the percentage frequencies of the selected 

harmonics, or the frequency of the first harmonic (tacho frequencies). Fields 

Min./Max value specifies the minimum bandwidth in Hz, if the field contains zero, 

this value is ignored. The graph shows how it will look in the band at the specified 

bounds +/-20% and min/max values of +/-5 Hz.  

The frequency response of one or more harmonics can be saved as signals in the 

tree. Select a range of harmonics and click Save. 

Order analysis 

The order analysis is used to analyze dynamic processes, mainly on non-stationary 

modes such as run-down or run-up. The end result is a three-dimensional signal, 

where on X-axis is  frequency spectrum or a multiplicity of harmonics, Z- axis is  

RPM or time, and Y-axis - amplitude, peak-peak, or RMS. 
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Fig. 10.22. Order analysis settings 

The settings are divided into two groups: the algorithm settings and the 

tachocharacteristic settings.  

Axis X / Axis Z - the size by the axes X and Z. The values in Hertz or the orders can 

be set by the axis X, and the values in seconds, Hertz or rpm can be set by the axis Z 

Frequency step - determines the step to change the frequency of the tacho. If 

multiple values falls into a single range (for example, with non-monotonic tacho 

frequency in the selected time range), then the result will be taken from the first 

resulting spectrum, the average or maximum range (depending on the mode selected 

in the box to the right of this). 

Tachofrequency range - the minimum and maximum values of the 

tachocharacteristic for the calculations. 

Order range - the minimum and the maximum values to be set for the X axis in the 

resulting signal, if the orders are selected by the X axis. 

Step by X axis - the step at which resampling is made while recalculating the 

spectrum frequencies into orders. The less is this value the more precisely the form 

of the resulting spectrum matches that of the source spectrum (the size of the 

resulting signal is increased in this case). 

Block size - the block size (in samples) to perform the calculations. The type of 

values - RMS/Amplitude/Peak-to-Peak Value is selected on the right from this field. 
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Characteristic type – defines the type of the spectrum. Possible values: Amplitude 

spectrum, power spectrum, power density spectrum and the energy density spectrum  

Weighting window – window function for spectrum calculation. 

Logarithm - the logarithm of the result (algorithm of "taking the logarithm"). The 

>> button opens the logarithm settings window. 

 

 Fig. 10.23. Range selection for spectrum calculation 
where: 
1 - Tachocharacteristic;  
2 - Source signal from the tachometer (tachosignal);  
3 - Source signal from the sensor;  
4 - Spectrum of the selected block of sensor signal (3).  

If the settings for the Z-axis indicated the frequency (in Hz or rpm) then on the 

characteristics selected the range according to the frequency specified in the settings 

(Tacho frequency range field); if for Z axis the seconds selected, then the 

subsequent calculation is for the entire frequency range (i.eentire signal). 

 The calculation can only be made between the signals, the sampling frequency of which 
is coincides with the sampling frequency of tacho. 
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For each value of the tacho that falls within this range, it is determined the 

corresponding data block in the source signal. For example, the next value for tacho 

was calculated for block size of 1024 counts, beginning in the 10th second, then 

from the raw signal from the acceleration sensor taking block with 1024 counts, 

starting from the tenth second of record. For this block calculated the spectrum with 

parameters specified in the settings, and stored in the resulting signal, as the next 

section of the Z axis. If in the settings for X-axis selected orders then, frequencies of 

spectrum are divided into tacho frequency, for which this spectrum was obtained. 

If frequency is selected by the axis Z, and several values of tachocharacteristic are 

found in the same range defined by the set frequency step, only one spectrum is 

written to the resulting signal in the given range. This effect occurs if a large 

frequency step is selected, or frequency is changed slowly or monotonously at the 

given range.  

 
Fig. 10.24. 

Fig. 10.24 shows the points of the same range by similar color. The frequency step is 

1 Hz (shown by red vertical line). In the ranges 104.5 - 105.5 Hz (1) and 103.5 - 

104.5 Hz (2) the tachocharacteristic is not monotonous, hence, two values are found 

in these spectrums. Three values are found in the range 102.5 - 103.5 Hz (3) due to 

slow tachocharacteristic changes. 

Fig. 10.19 shows the points of the same range by similar color. The frequency step is 

1 Hz (shown by red vertical line). In the ranges 104.5 - 105.5 Hz (1) and 103.5 - 

104.5 Hz (2) the tachocharacteristic is not monotonous, hence, two values are found 

in these spectrums. Three values are found in the range 102.5 - 103.5 Hz (3) due to 

slow tachocharacteristic changes.  

The method of obtaining the resulting spectrum is specified by the settings (on the 

right to the Frequency step field). The first spectrum calculated for the given range, 

or the spectrum obtained by averaging of several spectrums, or the spectrum 

obtained by selection of maximal values of several spectrums can be taken as a 

resulting one.  
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Fig. 10.25 demonstrates the results of application of different methods to four source 

spectrums shown by the top graph. The second graph shows the first spectrum, the 

third - averaged spectrum, the fourth - the maximum spectrum. 

 
Fig. 10.25. 

After calculation, the result is displayed in the form of three-dimensional graph (Fig. 

10.26).  

 Fig. 10.26. Viewing the order analysis results as 3D graph 
 

Shock spectrum 

The aim of the tests for resistance to impact is analysis of the measurements results 

obtained during recording of signals from vibration sensors located on the test 

object. The shock spectrum is calculated to determine the number of responses of 

the investigated components and subassemblies, which in the mathematical model 
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are presented in the form of oscillatory systems (oscillators), each of which has a 

natural frequency fn determined by the characteristics of the Mn and Cn (Fig. 10.27). 

Shock spectrum allows to determine the frequency of the oscillators (nodes and 

elements) that will experience the greatest load when installed on the test unit. 

 
Fig. 10.27. Model of the oscillating system 

Calculation of the shock spectrum based on the analysis of the time realization of the 

signal coming from accelerometer. When calculating, the force acting upon a 

number of oscillators with natural frequency fn can be expressed using the 

acceleration signal. The response of each oscillator (with frequency ωn) is 

independent of the other oscillators. According to Newton's second law, the motion 

of each oscillator can be represented in the form of the differential equation:  

, where  x – the movement of the oscillator (the desired 

value). 

The maximum value is sown as the point on the graph of the shock spectrum (Xmax, 

ωn), y – moving of support on which is fixed the oscillating system (the signal from 

accelerometer). The equation can be rewritten in the form: 

, where  z = x – y;  ωn
2
=k/m – oscillator natural 

frequency rad/s);  2ξωn=c/m, where ξ – the damping ratio, which is also often 

presented as Q =1/2 ξ. 

The last equation has no analytical solution for random effects Y(t). 

Below is the formula that allows to solve the equations numerically, presenting the 

input stimulus in the form of finite differences. Here ∆t is the time interval with 

which it is registered, the sequence Y(t), defined by the sampling frequency of the 

ADC. 

, 

where  
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For this equation it is possible to build the response of an oscillator with a specified 

damping ratio and natural frequency X(t) on the input stimulus, Y(t). 

   
Fig. 10.28. Source influence and example of the reaction to it 

The shock spectrum algorithm performs the following calculation: 

1) The user defines the damping ratio ξ. 

2) The range of analyzed frequencies and the step frequency (determines the amount 

of calculation algorithm and, accordingly, the time of his execution). The number of 

points of the shock spectrum is the frequency range divided by the step frequency. 

3) or each oscillator with frequency ωn calculated response X(t). 

4) The maximum value Xmax (see Fig. 10.28) shown as a point on the y-axis of the 

shock spectrum, on x-axis assumes a value of fn (natural frequency of the oscillator).  

 
Fig. 10.29. Settings of shocks search and shock spectra calculation 
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Group of Impact searh settings allows you to automatically determine the portions 

of the signals to be processed. Search impact is as follows: the signal is divided into 

portions, equal to 1% of the signal. At each portion is calculated the RMS signal. 

The RMS signal calculated by the first portion is assumed as a threshold value. 

When this value is exceeded in the number of times equal to the ratio of signal 

/noise, the detector of the presence of the shock is triggered. To the left of the trigger 

point is shown a time specified in the Left space line (if the mode is set to Auto, 

then the left will displayed time equal to 2% duration of the shock pulse). The 

duration of a shock pulse specified in the Duration line. If you select Auto mode, 

and the signal contains multiple shocks, the algorithm will identify them all and 

calculate the spectrum for each pulse (Fig. 10.30). 

 

Fig. 10.30. Result of processing of signal contains multiple shock pulses. 

The Setting of the spectrum group determines the processed amount of data. The 

number of shock points equal to the difference between the spectrum start frequency 

and end frequency divided by the step frequency, with a uniform step.  

For logarithmic step instead of step frequency the number of points per decade is 

specified. The damping ratio ξ is set as a percentage. The default value is 0.05, 

which corresponds to 5%. If you have selected the "Q" option, instead of damping 

then the quality factor (Q=1/2 ξ) will be specified. 

The Options group allows you to filter the original signal with a bandpass filter. 

Oversampling mode enables the use of the calculation of the shock spectrum with 

increased sampling frequency of the original signal. Since the algorithm uses the 

method of finite differences, the accuracy of the calculation depends on the sampling 

rate. According to the experimentally derived ratio the sampling frequency of the 

signal should be 20 times greater than the frequency of the source exposure. With 

further increase of the sampling frequency calculation results do not change.  
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Tracking filter 

Used to filter signal with cutoff frequencies specified as function of tacho frequency. 

The settings are divided into two groups: the algorithm settings (Fig. 10.31) and 

settings of the tacho (Fig. 10.4).  

 

Fig. 10.31. Settings of tracking filter. 
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Section 11. WinPOS scripting features 

WinPOS scripts  

WinPOS provides the user with the interfaces for creation of own scripts, plug-ins or 

applications, operating with the data and algorithms of WinPOS almost in any 

modern programming environment.  

Borland Delphi is the best solution for writing own effective processing algorithms, 

processing of large amount of data, creation of applications based upon WinPOS but 

requiring additional customization or being able to generate specialized reports. 

Borland C++ Builder, Microsoft Visual C++, Visual Basic or FoxPro can also be 

used.  

However, Visual Basic Script is more suitable for writing small WinPOS scripts or 

simple algorithms. VBScript is included into the Microsoft Windows delivery 

package, requires no separate compiler, and a convenient environment for editing 

and debugging of scripts is included into WinPOS.  

 
Fig. 11.1. Script editor 

The script editor is a 

text editor with syntax 

highlighting and a 

standard toolset that 

can be accessed by 

menu, toolbar and hot 

keys/ 

The script editor 

provides the user with 

all necessary tools for 

the script execution 

while debugging: 

breakpoints and step 

by step execution, 

viewing of local 

variables and the call 

stack, calculation of 

expressions. 

A detailed description of the script editor, interfaces, methods of program 

documenting and samples are provided in the Programmer's Guide.  

The script execution could be started in several ways:  

 From the script editor - Debug→Run/Break (<Ctrl+F10>),  
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 Select Script→Run script… in the WinPOS main window or select one of 

previously executed scripts from the same menu.  

 From the command line (“winpos.exe myscript.wps”).  

A typical example of the first program by VBScript is given below:  

 

 

The line «Hello, world!» will be printed in the Script editor panel.  

Start from the command line  

The file names - USML(.usm), MERA(.mera) or script files(.wps) can be specified 

(separated by a space) as the WinPOS command line parameters. In this case the 

data files are placed to the signal tree, and the script is executed. The data file 

(USML or MERA) can be placed to the graph page by the -s key.  

WinPos.exe [-h] [[-s] [usmlfile1.usm]..[-s] 

 [-q]..[usmlfileN.usm]] [[wpsfile1.wps]..[wpsfileM.wps]]  

List of command line keys  

-s Open all files after the ”-s” key in graphs  

-q Cancel the ”-s” key effect  

-h Information on the command line keys and parameters 

Examples  

 WinPos.exe -h  

   - WinPOS Help is opened  
 

 WinPos.exe test.mera u123_45.usm start.mera 

   - 3 files are added to the signal tree  
 

 WinPos.exe test.usm u123_45.usm -s start.mera error.usm -q finish.usm 

   - 5 files are added to the signal tree,  start.usm and error.usm files are opened in the graphs  
 

 WinPos.exe myscript.wps  

   - the myscript.wps script is executed  
 

 WinPos.exe test.mera myscript.wps  

   - the test..mera file is opened and the script myscript.wps is executed  

sub main 

  DebugPrint “Hello, world!” 

end sub 
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Appendix A. File formats 

1. MERA file structure 

The data in the MERA format stored in the same directory and distributed across 

multiple files (with extensions that define type of data).  

The list of files according to the data type is given below:  

Test name.mera - text data an parameter list 
Parameter name1.dat - parameter binary data 
Parameter name1.x - binary data on x axis (at unequal step) 
Parameter name1.prt - shift and time of portion start without registry interrupt 
Parameter name1.lbl - marks, modes, in association with time 
Parameter name1.stat - information on the signal status 
Name of settings.lvl - file containing settings list 
Name calibration.tx - linked calibration files 

1. File .mera (text) 

Standard ini-file syntax: [section], field=field value, ”;” – comment. Any field can 

be skipped, and then the default value is used. The fields of [MERA] are the file 

heading (example of field listing): 

[MERA] - file signature 
Test=TestName - test name 
Prod=ObjectName - product name 
Date=03.02.01 - test date 
Time=12:34:45.789 - test time 
LinkAll=FALSE - the flag considering all files *.dat of this catalog as paramneters (at 

LinkAll=TRUE). All parameter data fields are filled by default values. 
If this flag is missing, commented or LinkAll=FALSE, the parameters 
of the file .mera only are used.  

Each parameter has a section [parameter name] in the file .mera (example of field 

listing):  

 [{16-1}-M2408] - parameter name 
Char=DR - performance name («DR», «AFR», «spectrum»,…) 
Comment=Test1 - comment 
StartTime=01:02:03.045 - start time of parameter writing, by default: Time(from 

heading) + Start(seconds) 
XUnits=s - X axis units, by default: “s“ 
YUnits=V - Y axis units  
Start=0.0 - start time (initial value of X) , by default: 0 
Step=3.125e-005 - sampling, by default: 1 
Freq=32000 - frequency, by default: 1 
k0=0 - linear conversion coefficients, if not specified:  k0=0,  k1=1 
k1=0.038 
PolyTX=0 y=k1*(x-k0) if PolyTX=0, y=k1*x+k0 if PolyTX=1 
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XFormat=R4 - data format by X, by default: I2 (see below) 
YFormat=R8 - data format by Y, by default: I2 (see below) 
maxY=11172 - maximum value of Y 
minY=-14358 - minimum value of Y 
TX0=calibration.tx - calibration files (must be found in the same catalog) 

 If k1 and k0 are set, the linear conversion is made first.  
If Calibration1=, Calibration2=,…, CalibrationN=, use sequence calibration 

Lvl=settings.lvl - settings file (must be in the same catalog). 
For 3D signals only:  
ZSize=0 - Z axis size: number of sections (for 3D parameters) 
ZStart=0 - Z start value (for 3D parameters) 
ZStep=1 - step by Z axis (for 3D parameters) 
ZUnits=s - Z axis units (for 3D parameters) 
ZFormat=I2 - data format by Z, by default: I2 (see below) 

Possible field values YFormat, XFormat and ZFormat. The line constants analog 

to VARTYPE should be used (Version 1). Example: YFormat=R8 

Values. 
Version 1 

Values. 
Version 2 

Description 

I1 byte - one byte integer with sign 
UI1 - - one byte integer without sign 
I2 int - two byte integer with sign 
UI2 - - two byte integer without sign 
I4 int32 - four byte integer with sign 
I8 - - eight byte integer with sign 
R4 single - four byte integer with floating point (single precision) 
R8 double - eight byte integer with floating point (double precision) 

2. File .dat (binary) 

It contains the parameter binary data. Data format is defined by the field XFormat 

(see above) of the file .mera 

3. File .x (binary) 

It contains the X axis parameter binary data. Data format is defined by the field 

XFormat (see above) of the file .mera 

At equal signal X scale this file is absent!  

4. File .prt (text) 

It contains the information on shifting and the time of portion start when writing and 

3D processing.  

Each line contains the information on one interval in the following formats: 

Field number Format Description 

1 number Initial time value of the next interval. 

2 number Shift in the file.dat, in indexes. 
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The fields are separated by spaces, the line is finished by the enter line and line 

return symbols. 

This mode cannot be used with unequal X axis!  
 

5. File .lbl (text) 

It contains the information on modes and marks with association to the signal time 

scale.  

Each line contains the information on one mark in the following formats:  

Field 
number 

Format Description 

1 number Shift by the abscissa, in XUnits. 

2 key word, 
symbol line 

Key word «MODE» – attribute of new mode start. If skipped, a 
simple mark is set by the line. 

3 symbol line Name or mode or mark 

The fields are separated by space symbols, the line is finished by the line feed and 

return symbols.  

Example: 

105.533 MODE Mode1  

112.178 M1 

145.300 M2 

6. File .lvl (text) 

Contains the information on settings. As well as a calibration file, can be connected 

(in a file .mera) to several parameters simultaneously. 

Each line contains the information on one setting in the following formats:  

Field 
number 

Format Description 

1 symbol “L“ or 
“H“ 

Attribute of high (“H“) or low (“L“) setting. The signal values 
above the high or below the low setting are considered beyond 
the setting. 

2 number setting level in YUnits. 

3 hexadecimal 
constant 

RGB color of setting 

4 symbol line text message of setting (if any) 

The fields are separated by space symbols, the line is finished by the line feed and 

return symbols.  

Example: 
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H 5.500 0xFF0000 emergency temperature raise 

H 4.500 0xFFFF00 temperature above normal value 

L -6.500 0xFFFF00 temperature below normal value 

L -7.500 0xFF0000 emergency temperature fall 

7. File .stat (binary) 

Contains the information on changing the signal status in association with the shift. 

Contains the pair sequence of binary words: 

Field number Format Description 

1 binary word, 32 bits Shift in file .dat, in bytes. 

2 binary word, 32 bits Signal status code 

The values of separate status code bits are explained in the file .mera (section 

[MERA]) in format:  

st1=beyond the scale 
st2=unreliable 

The digit here corresponds the bit number of the double status word (1..32). 

8. File .tx (text) 

Contains polynomial coefficients or interpolation nodes (line written numbers). Has 

two formats: 

x0 y0 
x1 y1 
… 

Each line of file contains a pair of numbers separated by space symbol, to set the 
portion linear conversion.  

  
k0 
k1 
k2 
… 

Each line of file contains one number, definition of polynomial coefficients.  
Number of coefficients matches the polynomial degree, i.e. 
k0, k1 – linear conversion, k0,…k7 –7th degree polynomial, etc. 

The fields are separated by space symbols; the line is finished by the line feed and 

return symbols.  

1. The data file of USML type is characterized by the following structure:  

Data file heading Table of parameter passport Information 

32 bytes 58  <number of parameters> Size not limited 

2. The file heading is characterized by the following structure:  

USML Product 
name 

Test name Test date 
ss/mm/yy 

Number of 
parameters 

(performances) 

Reserve field 

4b 8 bytes 8 bytes 8 bytes 2 bytes 2 bytes 

3. The structure of the parameter passport in the table of passport:  
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Parameter  Performance Size Discrete K0 K1 Massive 
size 

F
o
rm

a
t Tb Te 

R
E
S
E
R
V
E
 

12b 12 bytes 8b 4b 4b 4b 4b 1b 4b 4b 1b 

4. The information is structured as follows:  

Value massive 
of the 1st 
parameter 

Massive 
end 
attribute  
(FFFF) 

Value massive 
of the 2nd  
parameter 

Massive 
end 
attribute  
 (FFFF) 

 . . .  Value 
massive of 
the last 
parameter 

Massive 
end 
attribute  
 (FFFF) 

5. General notes 

5.1. Each separate file may contain either direct parameter data entry, or the 

parameter characteristics. Direct records and characteristic should not be stored in 

one file.  

5.2. One file may contain performance of different parameters.  

5.3. The number of parameters (performances) in one file should not be more than 

65536. 

6. USML file heading  

6.1. "USML" letters must be found in the first 4-byte field. 

6.2. The fields "product name", "test name", and "test date" contain te symbol lines 8 

byte each.  

7. Parameter passport table  

7.1. The field "characteristic name" contains a symbolic name of performance or the 

line "DR", in case the file contains direct entry of the parameter data.  

7.2. Sapling step, scaling coefficients K0 and K1, and the time of start and end of the 

data in the massive are set by the floating point format.  

7.3. The scaling coefficients are considered as follows:  

y = K1 · ( x – K0 ), where х - value of parameter or characteristic in the massive, y - 

transformed value of х. If K1=0.0, the scaling is not used.  

7.4. Massive length is an integer without sign.  

7.5. The value format field takes 1 byte and may contain the following data: 

Format Length Format C type Pascal type 

1 1 byte integer unsigned char byte 

2 2 bytes integer short integer 

3 4 bytes integer long longint 
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4 4 bytes with floating point float single 

8 8 bytes with floating point double double 

7.6. The value of reserve byte equal to three means the signal writing with unequal 

step, i.e., by Y,X pairs, and the format of each value of the pair is defined by the 

format field. The first half of value massive is taken by the values of Y, the second – 

by the values of X.  

8. Arrays of the parameter (performance) values are arranged in the order of their 

passports in the passport table. The number of bytes of each value is defined by the 

passport field "value format".  

3. File structure of Vibration survey calculation settings 

The settings file has INI format and can contain several sections, one for each Excel 

page. The section name is written in square brackets and this name must match the 

name of respective page. After the section name the parameters are listed as follows: 

<name_parameter>=<value> 

Tolerable parameters:  

num_chars Number of estimations 

channel_cell Table cell coordinates corresponding the name of the 1st channel. 

Values: number_column, number_line 

channel_orient List of channels in the table.  

Values: HORZ – horizontal; VERT – vertical. 

num_named_channels Number of pre-set channels 

channel1_name Name of the 1st preset channel; 

channel1_chars List of estimation numbers calculated by the present channel 

…  

channel[n]_name Name of preset channel 

channel[n]_chars List of estimation numbers calculated by the present channel 

charact1_options Options of the 1st estimation. Note! This parameter should not be 

used manually. To change this parameter use the vibration report 

settings window and save the result by the menu item «Save 

settings». 

charact1_cell Table cell coordinates the corresponding name of the 1st channel. if 

this field is empty the estimation is not put into the report. 

Values: number_column, number_line  

…  

charact[n]_options Options of the estimation. Note! This parameter should not be used 

manually. To change this parameter use the vibration report settings 

window and save the result by the menu item «Save settings». 
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charact[n]_cell Table cell coordinates the corresponding name of the 1st channel. If 

this field is empty the estimation is not put into the report. 

Values: number_column, number_line 
 

Sample settings file (parameter names are shown by bold font): 
-------------------- start of file ------------------------ 

[Template1] 

num_chars=4 

channel_cell=4,9 

channel_orient=horz 

num_named_channels=1 

channel1_name=TAXO_1 

channel1_chars=4 
 

charact1_options=type=6,name=e1,username=0,srcTaho=-

1,tRez=0,tAxesX=0,tRezMag=0,tTransf=1,tWin=3,rGarm=1.000,deltaF=1.0

00000,nPointsSM=1000,fSortRez=1,fMonFase=1,LevelLo=0.000000,LevelHi

=1.000000,level_dF=1.000000,dPNTwide=0.500000,coefTaho=1.000000,fFr

ont=0,fAbsOtn=0,fFiltrTaho=1,fFiltrTahoSrc=0,nPNTAvr=5 

charact1_cell=4,10 
 

… [ some settings skipped ] … 
 

charact4_options=type=0,name=f1,username=0,srcTaho=,tRez=24,tAxesX=

1,tRezMag=0,tTransf=0,tWin=3,rGarm=1.000,deltaF=1.000000,nPointsSM=

1000,fSortRez=1,fMonFase=1,LevelLo=0.000000,LevelHi=1.000000,level_

dF=1.000000,dPNTwide=0.500000,coefTaho=1.000000,fFront=0,fAbsOtn=0,

fFiltrTaho=1,fFiltrTahoSrc=0,nPNTAvr=5 

charact4_cell= 

------------------- end of file ------------------------- 
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Appendix D. Troubleshooting 

Problem Cause Solution 

WinPOS gives a 

message that the 

electronic key is not 
installed. WinPOS 

cannot be started. 

Mismatching of the key and  

installed WinPOS copy. 

E.g., the key «Professional» 
allows starting of 

professional and lower 

versions of WinPOS. 
WinPOS Expert does not 

operate with this key. 

Install WinPOS, matching the key marking. If 

marking is damaged run the program 

chknskw.exe from the subdirectory Active of the 
WinPOS installation folder. Usually this folder 

is found «c:\Program Files\MERA\WinPOS». 

The number in the field Mask means: 
001Fh – Expert, 000Fh – Professional, 

0003h – Standard, 0001h – View. 

Incorrect installation of 
WinPOS or the system 

configuration disables USB 

driver installation (LPT). 

Check the following. 

1. In CMOS Setup: USB (or LPT) ports enabled. 

2. In NT/2000/XP the installation is made with 

Administrator rights. 

3. USB-key is connected after installation of the 

program and drivers (If Windows founds an 

unknown USB-unit – remove this unit). 

Try to reinstall WinPOS considering the above 

recommendations and following the prompts of 

the installation program. 

If the problem remains unresolved, run the 

program instdrv.exe from the folder Active. 

Press Configure driver and check setting of 
Yes in the field Use this port? Press the button 

Reinstall driver. 

Noticeable defects of 

the graph printout: 
wide black “frame” on 

the right and below, 

chaotic color strips or 
points, wrong printing 

of text, etc.  

Found at some types of 

Windows 2000 graphic 
adapters. This is caused by 

incorrect operation of 

OpenGL drivers from the 
standard Windows package. 

1. Preferable. 

Update drivers from the manufacturer's webpage 
or install a universal package for your adapter 

(Detonator for NVIDIA, Catalyst for ATI 

Radeon, etc) * 

2. Universal. 

If the video adapter drivers cannot be updated 

for some reason, disable graphic acceleration in 
WinPOS settings. 

Set EnableHAL=false in the file winpos.ini.  

The line extends 

beyond the graph field. 

Incorrect operation of 

OpenGL drivers of the 

Windows standard package. 

If the problems remains after updating the video 

adapter* drivers set in the winpos.ini file:  

SafeClip=true 

Empty page instead of 

graph printout.  

Insufficient memory for the 

printer to print the graph 

(half-tone). 

Try to reduce resolution in the printer settings 

from 1200dpi to 600dpi or from 600dpi to 

300dpi. 
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Problem Cause Solution 

In Windows XP if  

WinPOS is started the 

tooltips of the taskbar 
buttons contains 

incorrect text.   

According to the Microsoft 

Support Service the given 

problem emerges in 
Windows XP when any 

application with the 

OpenGL hardware 
acceleration is used.  

The error is corrected in the Windows XP 

Service Pack 2. You can find the instructions as 

to updating and auxiliary information at the 
address: 

http://support.microsoft.com/kb/814135 

 

* - You can find a universal drivers package for NVIDIA in the Drivers folder of the 

WinPOS installation disk. 

 

In case you have questions and find no answer in the present User's Guide, or 

detected errors of WinPOS operation, we recommend you to address the technical 

support service.  

WinPOS technical support contacts  

E-mail: winpos@nppmera.ru 

Phone: +7(495)783-71-59 

Upgrade software 

www.winpos.ru or  

www.nppmera.ru  

Menu Supporting, command Download, WinPOS section. 

http://support.microsoft.com/kb/814135
http://www.winpos.ru/
file:///D:/Documents%20and%20Settings/User/Application%20Data/Microsoft/Word/www.nppmera.ru
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Glossary 

Algorithm  

A mathematical description of the sequence of operations to convert one signal into 

another.  

Folder  

The software object created for convenience of storage and searching of the signals 

of similar type. The file of MERA and USML format can be regarded as a folder 

containing signals registered in the course of one test.  

Graph  

The domain limited by the coordinate axis, containing the plotted signal lines. One 

graph can contain several lines.  

Index  

The number of value, offset in the signal value massive. The first signal change is 

associated with zero index.  

Line  

A flat curve graphically representing changing of one signal parameter in respect to 

another one. As a rule, the line shows a change of registered or calculated parameter 

as a function of time.  

Operator  

The algorithm with the customization set.  

Page  

The software object uniting several graphs.  

Signal  

The information (data massive containing service information) registered in the 

course of test in one physical channel or obtained by the source signal processing.  

Tachosignal  

Tachosignal is the signal from the RPM sensor mounted on a rotating part of 

machine. 
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Tachocharacteristic 

The tachocharacteristic is the frequency characteristic of the tachosignal. It shows 

the rotation frequency expressed in Hertz (Hz) or RPM change over the time. The 

reduced designation of the tachocharacteristic – "tacho" – is also used in the 

WinPOS. 

Tachofrequency 

The tachofrequency is the calculated value of the tachocharacteristic in a given 

moment. 

Tree  

A hierarchy data storage structure used by WinPOS for systematization of access to 

the source data and results, algorithms, graphs, etc. In Windows the tree is displayed 

by a standard element.  

Work session 

The WinPOS state: the signals loaded and received during processing, the plotted 

graphs. The session can be saved on a disk and later is restored. 


